-
P N

CodeWarrior
Development Studio for
Microcontrollers V10.x

HC(S)08/RS08 Build
Tools Utilities Manual

<,

Z“ freescale



y
A

Freescale, the Freescale logo, CodeWarrior, ColdFire, ColdFire+, Kinetis, Processor Expert, and Qorivva are trade-
marks of Freescale Semiconductor, Inc., Reg. U.S. Pat. & Tm. Off. All other product or service names are the property
of their respective owners. The Power Architecture and Power.org word marks and the Power and Power.org logos and
related marks are trademarks and service marks licensed by Power.org. ARM is the registered trademark of ARM Lim-
ited.

© 2010-2014 Freescale Semiconductor, Inc. All rights reserved.

Information in this document is provided solely to enable system and software implementers to use Freescale Semicon-
ductor products. There are no express or implied copyright licenses granted hereunder to design or fabricate any inte-
grated circuits or integrated circuits based on the information in this document.

Freescale Semiconductor reserves the right to make changes without further notice to any products herein. Freescale
Semiconductor makes no warranty, representation or guarantee regarding the suitability of its products for any partic-
ular purpose, nor does Freescale Semiconductor assume any liability arising out of the application or use of any product
or circuit, and specifically disclaims any and all liability, including without limitation consequential or incidental dam-
ages. “Typical” parameters that may be provided in Freescale Semiconductor data sheets and/or specifications can and
do vary in different applications and actual performance may vary over time. All operating parameters, including “Typ-
icals”, must be validated for each customer application by customer's technical experts. Freescale Semiconductor does
not convey any license under its patent rights nor the rights of others. Freescale Semiconductor products are not de-
signed, intended, or authorized for use as components in systems intended for surgical implant into the body, or other
applications intended to support or sustain life, or for any other application in which the failure of the Freescale Semi-
conductor product could create a situation where personal injury or death may occur. Should Buyer purchase or use
Freescale Semiconductor products for any such unintended or unauthorized application, Buyer shall indemnify and hold
Freescale Semiconductor and its officers, employees, subsidiaries, affiliates, and distributors harmless against all
claims, costs, damages, and expenses, and reasonable attorney fees arising out of, directly or indirectly, any claim of
personal injury or death associated with such unintended or unauthorized use, even if such claim alleges that Freescale
Semiconductor was negligent regarding the design or manufacture of the part.

How to Contact Us

Corporate Headquarters Freescale Semiconductor, Inc.
6501 William Cannon Drive West
Austin, TX 78735

U.S.A.

World Wide Web http://www.freescale.com/codewarrior

Technical Support http://www.freescale.com/support



http://www.freescale.com/codewarrior
http://www.freescale.com/support

Table of Contents

Introduction

| SmartLinker

Purposeof Linker . .. ...... ... . . i
Product Features . ......... .. .. .. . . ..
Section CONteNts . ... .oovv vttt

Starting the SmartLinker Utility . .........................

1 SmartLinker User Interface

SmartLinker Main Window . ............................
Window Title. . ........ ..
Content Ar€a. . ..o vvvte ettt
Main Window Tool Bar. . ............................
Main Window Status Bar ........ ... .. .. ... .. ...
Main Window MenuBar. ............................
SmartLinker Configuration. . .........................
Option Settings Window . .. ....... ...,
Message Settings Window . ............ ...,
About Dialog Box . ........ ... ... .
Retrieving Information about an Error Message. ..........

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

Specifying the Input File . . ... ... ... . 56
Using the Command Line in the Toolbarto Link .. ................... 57
UsingFile>Link. .. ... ... 57
UseDragand Drop . ...... ... 57
Message/Error Feedback . . ...... ... . . 58

2 SmartLinker Files 61
Input Files . . ... 61
Parameter File . ... ... ... . 61
Object File . . ... 61
Output Files. . .. ..o e 61
Absolute Files . . ... ... 62
S-Record Files . . ... 62
Map Files. . ..o 62
Error Listing File . . . ... ... 64

3 Linking Issues 67
Object AlloCation .. ...ttt 67
The SEGMENTS Block (ELF) ... ... o 67
The SECTIONS Block (Freescale + ELF) .......................... 73
PLACEMENT Block. ... .oooo e 76
Initializing Vector Table ... ........ ... i 80
VECTOR Command .. ....... ..ottt 80
Smart Linking (ELF). . . ... ... 81
Mandatory Linkingof anObject. . .......... ... . i, 81
Mandatory Linking of all Objects Defined in Object File............... 82
Switching OFF Smart Linking for the Application. ................... 82
Smart Linking (Freescale + ELF) . .. ....... ... . i, 83
Mandatory Linking from an Object. . .......... .. ... .. ..., 83
Mandatory Linking from all Objects Defined inaFile ................ 83
Binary Files Building an Application (ELF).............. .. .. .. ....... 84
NAMES BlocK. . ..o 84
ENTRIES Block . ... ..o e 84
Binary Files Building an Application (Freescale)........................ 85
NAMES BlocK. . ..o 85

4 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

Allocating Variables in OVERLAYS ....... ... .. .. . .. . . . ... 86
Overlapping Locals. . ... ..o e 87
Algorithm . .. ... o e 87
Name Mangling for Overlapping Locals ............ ... ... ... ..... 89
Name Mangling in ELF Object File Format......................... 90
Defining a Function with Overlapping Parameters in Assembler. .. ...... 91
DEPENDENCY TREE SectioninMap File. . ....................... 96
Optimizing the Overlap Size. . ....... ... . i, 97
Recursion Checks . ... ... 98
Linker-Defined Objects. . ... ..o v i e e 99
Stack Consumption Computation. . .. .........vuvntnt e ennnnan.. 102
STACK_CONSUMPTION Block. . ... ... 102
Checksum Computation . .. ......vutt ittt et 110
prm File-Controlled Checksum Computation. .. .................... 111
Automatic Linker-Controlled Checksum Computation . .............. 111
Partial Fields . . .. ... .o 113
Runtime Support. .. ... e 113
Linking an Assembly Application .............. .. ... .. .. .. .. ...... 115
prmFile. . ... 115
Warning MesSages. « . ..o vv ettt e 115
Smart Linking . . ... ... 116
LINK_INFO (ELF). . ..o e e 118

4 SmartLinker Parameter File 119
Parameter File Syntax. .. ... 119
Mandatory SmartLinker Commands. .. ............ ... ..., 121
The INCLUDE Directive . . .. ....oouinit it 122
5 ELF Sections 123
Segments and SECtiONS . . .. .. ..ottt e 123
SECHIONS . . o\ttt e 123
Predefined Sections. . .......... i 123
Examples of Using Sections . ... ..........oiunitinnenenn.. 126
Example 1. ... .. 126
Example 2 .. ..o 126
Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 5



Table of Contents

6 Segments 129
Segments and SECtiONS . .. ... ... 129

SEEMENL. . . . ottt e 129

Predefined Segments . .. ........ .. 130

7 Program Startup 133
Startup Descriptor (ELF). . ... ... .. 133
User-Defined Startup Structure (ELF) ......... ... ... . . . it 137
User-Defined Startup Routines (ELF). ........... ... ... ... ... ...... 138

Startup Descriptor (Freescale). .. .......... ... ... . .. 138
User-Defined Startup Routines (Freescale). .. ............ ... ... ...... 140

Example of Startup Code in ANSI-C ....... ... ... ... ... .. 140

Startup Code and Effect of Pragmas .. ......... ... ... ... ... ...... 145

8 The Map File 147
Map File Contents. . .. ..ottt e 147

9 ROM Libraries 149
Creatinga ROM Library .. ... ... . o i i 149

ROM Libraries and Overlapping Locals . .. ........................ 150

Using ROM LiIbraries . . ......ouuuitn it ee e 150

Suppressing Initialization . ............. ... . .. i 150

10 Initializing the Vector Table 157
Using SmartLinkerprm File . . . ... ... ... . o 157

Using a Relocatable Section in the Assembly Source File................ 159

Using an Absolute Section in the Assembly Source File ................. 161

Il Burner Utility

Introduction. . . ... ..o 165
Product Highlights. . .. ... ... 165
Starting the Burner Utility. . . ...... ... . i 166

6 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

11 Interactive Burner GUI 167
Burner Default Configuration Window. .. ............. ... .. .. ...... 167

Burner Dialog BoX . ... ..ot 168
Input/Output Tab. . . ... ... 168

Content Tab .. ... ... e 171

CommandFile Tab .. ........ . i 173

12 Batch Burner Language 175
Batch Burner User Interface . .. ......... ... ... i 175

Syntax of Burner Command Files ............. ... ... ... ... ... ... 176

Command File Comments. . .. ..., 177

Batch Burner with Makefile . ........... ... ... ... . i 177

Command File Examples ........... ... ... .. .. .. ... 178

lll Libmaker Utility

Introduction. . . ... . 181
UserInterface . .. ...t 181
Starting the Libmaker Utility. . ......... . ... ... 182
Interactive Mode . . .. .. ..ot 182

13 Libmaker Interface 183
Startup Command Line Options. ... ..., 183
Command Line Interface .. ......... ... .. .. . . i, 184
Libmaker Commands . ..............c. i, 184
Managing Libraries. . .. ... ... 184
Libmaker Graphic User Interface . .. ....... ... ... ... .. ... ... ..... 187
Libmaker Default Configuration Window. . ........................ 187
Default Configuration Window Status Bar......................... 190
Configuration Window . . ... i 194
Libmaker Option Settings Window. ... .......... .. ... ..., 202
Libmaker Message Settings Window .. ........................... 203
About Libmaker Dialog BoxX. . ........ .. ... .. i 205

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 7



Table of Contents

IV Decoder Utility

Introduction. . . . ..ottt 207
Product Highlights. . .. ... ... 207
UserInterface .. ........oiiiti i et 207
14 Input and Output Files 209
Input Files . ... ..o 209
Absolute Files . . ... ... 209
Object File . . ... oo 209
S-Record Files . . ...t i e 210
Intel Hex Files . . ... ... 210
Output Files. . .. ..o 210
15 Decoder Controls 213
LiSt MenuS. . .. oottt e e 213
File Menu. . ... ..o e 213
Decoder Menu . . ..ottt e 215
View MeNU. . . . ..o e 215
HelpMenu. .. ... 216
Graphical User Interface . .. ........ ... .. . i, 216
Decoder Main Window . .. ...t e 217
Decoder Configuration Dialog Box. .......... ... ... ... .. .. ... 219
Decoder Option Settings . . . ..ot vt vttt it et i 224
About Decoder Dialog BoX . .. ... .ot 227
Specifying the Input File. . . ..... .. ... . .. .. . 227
Message and Error Feedback . .......... ... ... ... ... .. . ... 228
Using Information from the Main Window. . ....................... 228
Using a User-Defined Editor. . . ....... ... .. ... .. .. ... .. ...... 228

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

V Maker Utility

16 Maker Controls 231
Graphical User Interface. .. .......... . .. 231
Maker Main Window. . .. ... i 231
Main Window COmMPONeNntS. . ... ...vuvtntt ettt 232
Maker Main Window MenuBar. ........... ... ... ... ... .. .... 232
Maker Main Window Toolbar. ........ ... .. ... ... . ... 236
Maker Configuration Window. . . ......... .. .. ... .. ... 237
Maker Option Settings Dialog Box. . ............ ... . .. .. 242
Maker Message Settings Dialog Box ............ ... ... .. ... ... 243
About Maker Dialog Box .. ......... ... 245
Specifyingthe Input File. . . ......... ... ... i 245
Message and Error Feedback ........... ... ... .. ... ... . . ... 246
Using Information from the Main Window. .. ...................... 247
Using a User-Defined Editor. . . ......... ... ... . i, 247
17 Using Maker 249
Making Modula—2 Applications. ... ...« 249
Making C Applications. . ... oo vttt ettt 249
Using Makefiles . ...... ... 250
User-Defined Macros (Static Macros) . ... ........ouuieiuieineeennn. 252
Definition. . ... ... 252
Reference. ... ..o e 252
Redefinition. .. ... .. 252
Macro SubSHIUtion . . .......o.it it 252
Macros and Comments . . . ........utut ittt 253
Concatenation . . .. ...ttt e 253
Command-Line Macros. . .. ..ot 254
Dynamic Macros. . ... ..ot 254
Inference Rules .. ... ... .. i 255
Multiple Inference Rules. .. ....... ... ... i 257
Directives and Special Targets . ............ i 258
Built-In Commands. . .......... i 258

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 9



Table of Contents

Command Line ........... .ttt 261

Implementation Restrictions .. .......... .. ... .. 261

18 Building Libraries 263
Maker Directory Structure ... ..........c..ouiuininntnnenenenenn... 263

Configuring WinEdit forthe Maker . ........... ... .. ... .. .. ...... 264

Configuring default.env forthe Maker . ........... ... ... ... ... ..... 265

Building Libraries with Defined Memory Model Options . . .............. 266

Building Libraries with Objects Added . ........... ... .. ... ......... 266

Structured Makefiles for Libraries ............ ... ... .. ... . . ... 268

VI Appendices

A Environment Variables 273
Current DIreCtory . . .. oottt e e e 274
Tool-Specific Search Information. .............. ... ... ... ... ...... 274
Compiler .. ... 275
Debugger . . oo 275
Libmaker . .. ..o 275
MaKer. . .o e 276
SmartLinker. . .. ... 276
Global Initialization File (MCUTOOLS.INI) (PConly). ................. 277
[Installation] SeCtion . . . ... vttt e 277
Path ... 277
GIOUD . ettt e 278
[Options] SECtioN. . . .t v vttt e e 278
DefaultDir .. ... 278

[ToOI] SECtION . . .ot e e e e e 278
SaveONnEXit .. ..ot e 279
SaAVEAPPEATANCE . . v vttt ettt e e e 279
SaveEditor .. ... 279
SaVEOPLIONS .o\ vttt e 280
RecentProject0, RecentProjectl,etc. .......................... 280
TIpFilePos . . ... 281

10 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

ShowTipOfDay . . .....ooi e 281
TipTimeStamp . ..... ... 281
[Editor] SECtion. . ... oottt e e e 282
Editor_ Name . ........... .. e e 282
Editor_Exe ......... . 283
Editor_Opts . ..ot 283
Local Configuration File (Usually projectini) . ........................ 284
[Editor] SECtion. . .. ..ottt e e e 285
Editor_ Name . ............ . e 286
Editor_ Exe .. ... 286
Editor_Opts . ..ot e 287
[TOOI] SECHION . . . o\ttt e e e e e e e 287
RecentCommandLineX, X=Integer .................cocvuvu.... 288
CurrentCommandLine ............... ... ... . ... i, 289
StatusbarEnabled .............. ... .. ... .. ... 289
ToolbarEnabled . .......... ... ... ... . . .. . . 289
WindowPos .. ... 290
WindowFont . ........ . . .. . 290
TipFilePos . . ..o 291
ShowTipOfDay . . ..ot e e 291
OPLIONS . ettt e e e 291
EditorType ..o 292
EditorCommandLine ................ ... ... ... i, 292
EditorDDEClientName . . ...............0 ittt 293
EditorDDETopicName . ............cuiuiiinnirinennnnnn.. 293
EditorDDEServiceName .................oiiuiirianeanean.. 293
Burner Dialog Entries in [BURNER] .. ....... ... ... ... ... .. ... 294
BurnerUndefByte ......... .. ... .. .. .. .. . 294
BurnerSwapByte . . ... ... L 294
BurnerOrigin . .. ... ... 295
BurnerDestination ... ........... ... 295
BurnerLength .. ... ... .. .. .. . . . L 295
BurnerFormat . ........ ... .. ... . . . 296
BurnerDataBus . ......... ... .. .. .. 296
BurnerOutputType . ........ ... .. 297
BurnerDataBits . ......... ... . ... . 297
BurnerParity . ......... ... 298
BurnerByteCommands .......... ... .. ... .. .. .. . . ... 298
BurnerBaudRate .......... ... . . . ... . . 299

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 11



Table of Contents

BurnerOutputFile ......... ... ... .. .. 299
BurnerHeaderFile ........... ... ... ... . . i 299
BurnerInputFile .. ... ... . .. . 300
Configuration File Example ............ ... ... ... ... . . .. 300
Paths . ... 302
Line ContinuUation . . .. ...ttt ettt ettt e 302
Environment Variable Details . . ......... ... .. ... ... i ... 303
ABSPATH: Absolute Path ........... ... . ... ... . . . .. 304
COMP: Modula-2 Compiler . ..........coitiriininnnn.. 305
COPYRIGHT: Copyright Entry in Absolute File .. .................. 305
DEFAULTDIR: Default Current Directory ........................ 306
ENVIRONMENT: Environment File Specification .................. 307
ERRORFILE: Error File Name Specification ...................... 308
FLAGS: Options for Modula-2 Compiler ......................... 311
GENPATH: Define Paths to Search for Input Files .................. 311
INCLUDETIME: Creation Time in ObjectFile . .................... 312
LINK: Linker for Modula-2 . ........ ... .. .t 313
LINKOPTIONS: Default SmartLinker Options . .................... 313
OBJPATH: ObjectFilePath ............. ... . ... ... ... ... ... 314
RESETVECTOR: Reset Vector Location ......................... 315
SRECORD: S Record File Format ............................... 315
TEXTFAMILY: Text Font Family .............. ... ... ... ...... 316
TEXTKIND: Text Font Character Set ............... ... .. .. ..., 317
TEXTPATH: TextPath ......... ... .. i, 318
TEXTSIZE: Text Font Size ........... .ot 318
TEXTSTYLE: Text Font Style .. ..., 319
TMP: Temporary Directory . .............oiiuinnenininennenen.. 320
USERNAME: User Name in ObjectFile .......................... 320

B Tool Options 323
Option Details . . .. ..ot 324
Special Modifiers. . . ... ..o 325
Examples. . . ... e 325
-A: Print Full Listing (Decoder) ............ .. ... oo, 326

-A: Warning for Missing .DEF File (Maker) .................... 329

-Add: Additional Object/Library File .......................... 329
-Alloc: Allocation Over Segment Boundaries (ELF) .............. 330
-ArgFile: Specify a file from which additional command line options will
beread .. ... ... . 332

12 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

-AsROMLIib: Link as ROM Library ........................... 332
-B: Generate S-Record file (SmartLinker) ...................... 333
-C: Write Disassembly Listing with Source Code (Decoder) ....... 334
-C: Ignore Case (Maker) . ..........oiiuiininininnann.. 335
CAllocUnusedOverlap: Allocate Not Referenced Overlap Variables (Free-
SCAle) ... 336
-Ci: Link Case Insensitive . . . ...ttt 337
-CheckAcrossAddrSp... ELF/DWAREF: Check if objects overlap in the ab-
solute file (even if different address spaces) .................. 337
-Cmd: Libmaker Commands ............ .. ... . .. .. . ...... 338
-Cocc: Optimize Common Code (ELF) ........................ 340
-ConstDist: ELF/DWAREF: Enable automatic content placement. . . . . 340
-ConstDistSeg: ELF/DWAREF: Specify constant distribution segment name
341
-CRam: Allocate Non-specified Constant Segments in RAM (ELF) . . 342
-D: Display Dialog Box (Burner) ............. .. ... ... .... 342
-D: Decode DWAREF Sections (Decoder) ....................... 343
-D: Definea Macro (Maker) . ... .. 345
-DataDist: ELF/DWARF: Enable automatic data placement . ....... 346
-DataDistFile: ELF/DWAREF: Specify data distibution file name ... .346
-DataDistInfo: ELF/DWARF: Generate data optimizer information file . .
347

-DataDistSeg: ELF/DWAREF: Specify data distribution segment name 347
-Dconf[={a}]" Configure which parts of DWARF information to decode .

348
-DefaultEpage: ELF/DWAREF: Define the default value of the PPAGE reg-
] P 348
-DefaultPpage: ELF/DWAREF: Define the default value of the PPAGE reg-
] P 349
-DefaultRpage: ELF/DWAREF: Define the default value of the RPAGE reg-
] P 349
-Disp: Display Mode (Maker) ................. oo, 350
-Dist: Enable Distribution Optimization (ELF) (SmartLinker) ...... 350
-DistFile: Specify Distribution File Name (ELF) (SmartLinker) . .. .. 351
-DistInfo: Generate Distribution Information File (ELF) (SmartLinker) . .
351
-DistOpti: Choose Optimizing Method (ELF) (SmartLinker) ....... 352
-DistSeg: Specify Distribution Segment Name (ELF) (SmartLinker) .353
-E: Specify the Name of the Startup Function ................... 353
-E: Decode ELF sections (Decoder) ........................... 354

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 13



Table of Contents

-E: Unknown Macros as Empty Strings (Maker) ................. 356
-Ed: Dump ELF Sections in LST File (Decoder) ................. 357
-Env: Set Environment Variable .. ............................ 357
-F: Execute Command File .................................. 358
-F: ObjectFile Format . . ......... ... ... .. i, 359
-FA, -FE, -FH -F6: Object File Format (SmartLinker) ............. 360
-H: Prints the List of All Avaialble Options (Short Help) .......... 360
-I: Ignore Exit Codes (Maker) . ..., 362
-L: AddaPathtoSearchPath ................................ 362
-L: Produce Inline Assembly File (Decoder) .................... 363
-L: List Modules (MaKer) . ..........c.uiiuiiiii .. 364
-LibFile: Specify Library File Name .......................... 365
-LibOptions: Specify Library Option File Generation ............. 365
-Lic: License Information ............ ... ... . ... 366
-LicA: License Information about Every Feature in Directory . ...... 366
-LicBorrow: Borrow License Feature .......................... 367
-LicWait: Wait for Floating License from Floating License Server . . .368
-M: Generate Map File (SmartLinker) ......................... 368
-M: Produce Make File Maker) .............. ..o iiinn... 369
-Mar: Freescale Archive Commands (Libmaker) ................. 369
-Map[RAMIFlashlEx..]: Define mapping for memory space 0x4000-
OXT7EEF .o 370
-MKAIL: Make Always (Maker) .............ccouiiiiinenenen.. 371
-N: Display Notify BoX .. ... i 372
-NoBeep: NoBeepin Caseof anError . ........................ 372
-NoCapture: Do Not Redirect stdout of Called Processes (Maker) ...373
-NoEnv: Do Not Use Environment ............................ 374
-NoPath: Strip Path Info (Libmaker) . .......................... 374
-NoSectCompat: Never Check Section Qualifier Compatibilty ...... 375
-NoSym: No Symbols in Disassembled Listing (Decoder) ......... 375
-Ns: Configure S-Records (Burner) ........................... 377
-O: Define Absolute File Name (SmartLinker) .................. 378
-O: Specify the Name of the Output File (Decoder) ............... 378
-O: Compile Only (MaKer) ..........covuininiiinnnnnennn.. 379
-OCopy: Optimize Copy Down (ELF) (SmartLinker) ............. 380
-Options: Enable Option File Generation ....................... 380
-OptionFile: Specify Data Optimizer Options File Name .......... 381
-P2LibFile: Specify Library File Name ........................ 381
-Proc: Set Processor (Decoder) .............. ... ... v, 382
-Prod: Specify Project File at Startup (PC) (Nod,nom) ........... 382

14 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

-ReadLibFile: Enable Option to Read libFile.txtiP2 ............. 383
-S: Do Not Generate DWARF Information (ELF) (SmartLinker) ... .383
-S: ELF/DWARE: Strip symbolic information ................... 384
-S: Silent Mode (Maker) . ............ i 384
-SFixups: Generate FixupsinabsFile ......................... 385
-StackConsumption: ELF/DWAREF: Enable Stack Consumption . . . . . 386
-StartUpInfo: Emit Startup Information to Library Info File ........ 386
-StatF: Specify Name of Statistic File (SmartLinker) ............. 387
-T: Show Cycle Count for Each Instruction (Decoder) ............ 387
-V: Prints Version Information ............... .. ... .. ... .... 389
-View: Application Standard Occurrence (PC) .................. 389
-W: Display Window (Burner) ............ ... ... ... 390
-W1: No Information Messages ............couvivrinenunnn.. 391
-W2: No Information and Warning Messages ................... 391
-WErrFile: Create “err.log” Error File ......................... 392
-Wmsg8x3: Cut File Names in Microsoft Format to 8.3 (PC) ....... 393
-WmsgCE: RGB Color for Error Messages . .................... 393
-WmsgCF: RGB Color for Fatal Messages ..................... 394
-WmsgCI: RGB Color for Information Messages ................ 395
-WmsgCU: RGB Color for User Messages ...............c...... 395
-WmsgCW: RGB Color for Warning Messages .. ................ 396
-WmsgFb (-WmsgFbi, -WmsgFbm): Set Message File Format for Batch
Mode . ... e 397
-WmsgFi: Set Message Format for Interactive Mode ............. 398
-WmsgFob: Message Format for BatchMode ................... 400
-WmsgFoi: Message Format for Interactive Mode . ............... 401
-WmsgFonf: Message Format for No File Information ............ 403
-WmsgFonp: Message Format for No Position Information ........ 404
-WmsgNe: Number of Error Messages .. ...................... 406
-WmsgNi: Number of Information Messages ................... 407
-WmsgNu: Disable User Messages ............ccovvvuiennnn.n.. 407
-WmsgNw: Number of Warning Messages ..................... 408
-WmsgSd: Setting a Message to Disable ....................... 409
-WmsgSe: Setting a Messageto Error . ........... .. .. .. .. .... 410
-WmsgSi: Setting a Message to Information .................... 410
-WmsgVrb: Verbose Mode (Maker) ............ ... ... ...... 411
-WmsgSw: Setting a Message to Warning . ..................... 412
-WOutFile: Create Error Listing File .......................... 412
-WStdout: Write to Standard Output ............. .. ... .. ...... 413
-X: Write Disassembled Listing Only (Decoder) ................. 414

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 15



Table of Contents

-Y: Write Disassembled Listing with Source And All Comments (Decoder)

414
C Messages 417
Types of Generated Messages . . . ... .ovitn et 417
Message Details. .. ... .. 417
Linker Message List .. ... ...t 418
L1: Unknown "<message>"occurred . ... ..........coinitiininn.. 418
L2: Message overflow, skipping <kind> messages .................. 419
L50: Input file '<file>'not found ......... ... ... ... ... ... ... ... 419
L51: Cannot open statistic log file <file> .......................... 419
L52: Error in command line<emd> .. ..... ... .. .. .. o i 420
L53: Message <Id> is not used by this version. The mapping of this message
ISIgNOTed. . ..o 420
L54: Option <OPLioN> ... ..ttt e 421
L56: Option value overridden for option <OptionName .............. 421
L64: Line Continuation occurred in <FileName> ................... 421
L65: Environment macro expansion message " for <variablename> . . . .. 422
L66: Search path <Name> does not exist . .. ...........c..ouuennn.. 423
L1000: <command name>="">notfound ........... ... ... ... .... 423
L1001: <command name>=""> multiply defined . ................... 424
L1003: Only a single SEGMENTS or SECTIONS block is allowed . . . .. 424
L1004: <Token>expected ............cuiuiiiininininennenenen. 425
L1005: Fill pattern will be truncated (>0xFF) ...................... 426
L1006: <Token>notallowed ......... ... ... .. .. iiiiiaon... 426
L1007: <character> not allowed in file name (restriction) ............. 427
L1008: Only single object allowed at absolute address ............... 428
L1009: Segment Name <segment name>="">unknown .............. 429
L1010: Section Name <section name>="">unknown ................ 431
L1011: Incompatible segment qualifier: <qualifierl> in previous segment and
<qualifier> in <segment name>=""> ............ ... ... ... ..., 433
L1012: Segment is not aligned on a <bytes>boundary ............... 435
L1013: Section is not aligned on a <bytes>boundary ................ 436
L1015: No binary input file specified . ........... .. ... .. ... .. ... 436
L1016: File <filename> found twice .............. ... .. .. ........ 437
L1017: Section <Object/Section> in module <ModuleName> is incompatible
with previous usages of this section ........................... 438
L1018: Checksumerror .......... ... .. ...ttt 439

L1019: Checksum error: starting address Ox<Address> not aligned with

16

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

checksum size <Address> ............... i 439
L1020: Checksum error: size of checksum area Ox<Address> to Ox<Address>
res aligned with the checksum size <Address> .................. 440
L1021: Checksum error: Memory Overlap of Ox<Address> - Ox<Address>
and OX<AdAress> .. ......oiuiuin 440
L.1022: Checksum error: Start Address Ox<Address> is greater than End Ad-
dress OX<AAAIess> . ........ouiiiin i 440
L1023: Object <object> spans multiple pages . ..................... 441
L1037: **#** Linking of <Linkparameterfile> failed **** .. .. ... .. .. 441
L.1038: Success. Executable file written to <absfile> ................ 441
L1052: User requested STOP . . v v o e vt e e eee s 442
L1100: Segments <segment]l name>=""> and <segment2 name>=""> overlap
442
L1102: Out of allocation space in segment <segment name>=""> at address
<first address=""free>=""> ... ... .. .. .. ... . . i 444

L1103: <section name>=""> not specified in the PLACEMENT block . .445

L1104: Absolute object <Object name>=""> overlaps with segment <Seg-
ment name>=""> . . ... .. ... 446

L1105: Absolute object <object name>=""> overlaps with another absolutely

allocated objector withavector ............ ... . ... 449
L1106: <Object name>="">notfound ........................... 450
L1107: <Object name>="">notfound ........................... 451
L1108: Initializing of Vector <Name> failed because of <Reason> ... .. 453

L1109: <Segment name>=""> appears twice in SEGMENTS block ....453

L1110: <Segment name>=""> appears twice in PLACEMENT block . ..454

L1111: <Section name>=""> appears twice in PLACEMENT block .. ..455

L1112: The <Section name>=""> section has segment type <Type> (illegal)
456

L1113: The <Section name>=

"

> section has segment type <Segment quali-

fier>="">(illegal) ......... ... 458
L1114: The <Section name>=""> section has segment type <Segment quali-
fier>=""> (initialization problem) . ............................ 460
L1115: Function <Function name>="">notfound .................. 462
L1116: Function <Function name>="">notfound .................. 463
L1117: <Object name>=""> allocated at absolute address <Address> over-
laps with sections placed in segment <Segment name>=""> ........ 463
L1118: Vector allocated at absolute address <Address> overlaps with another
vector or an absolutely allocated object ........................ 465

L1119: Vector allocated at absolute address <Address> overlaps with sections
placed in segment <Segment name>="">........... .. .. ... ..... 466

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 17



Table of Contents

L1120: Vector allocated at absolute address <Address> placed in segment

<Segment name>="">, which has not READ_ONLY qualifier ...... 468
L1121: Out of allocation space at address <Address> for .copy section . .469
L1122: Section .copy must be the last section in the section list ........ 470
L1123: Invalid range defined for segment <Segment name>="">. End address

must be bigger than start address ........... ... .. ... .. .. ... 471
L1124: '+ or '-' should directly follow the filename ................. 472
L1125: In small memory model, code and data must be located on bank 0.

(StartAddr EndAddr) . . ... 474
L1127: Placement located outside 16 bit area in small memory model in area

StartAddr .. EndAddr ......... ... .. 475

L1128: Cutting value <ItemName> from <FullValue> to <WrittenValue> . . .
476

L1130: Section .checksum must be the last section in the section list . .. .477
L1200: Both STACKTOP and STACKSIZE defined ................. 478
L1201: Nostackdefined . ......... .. ... . i, 479
L1202: .stack cannot be allocated on more than one segment .......... 480
L1203: STACKSIZE command defines a size of <Size> but .stack specifies a

stacksize of <Size> . ... ... .. 481

L1204: STACKTOP command defines an initial value of <stack top>=""> but
.stack specifies an initial value of <Initial value>=""> ............. 484
L1205: STACKTOP command incompatible with .stack being part of a list of

SECHIOMS « . vt vttt et e et e e 486
L1206: .stack overlaps with a segment which appear in the PLACEMENT

BloCK . 487
L1208: Failed to calculate checksum ................ ... .. ... ... 489
L1207: STACKSIZE command ismissing . . .................ovu... 490
L1301: Cannot open file <File name>=""> ........................ 491
L1302: File <File name>="">notfound .......................... 492
L1303: <File name>="">isnotavalid ELFfile ................. ... 492
L1305: <File name>=""> is not an ELF format object file (ELF object file ex-

PeCted) . ot e 492
L1400: Incompatible processor: <Processor name>=""> in previous files and

"nn

>incurrentfile ......... ... .. ... . ..... 493
"" name>="">in

<Processor name>=
L1401: Incompatible memory model: <Memory model=

previous files and <Memory model="" name>=""> in current file ...493
L1403: Unknown processor <Processor constant>="">............... 494
L1404: Unknown memory model <Memory model="" constant>=""> . . .494
L1406: Unknown target . ...........c.ouieninonninenenennenenn. 494
L1407: Unknown address space for <Object> <Address>............. 495

18

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

L.1408: Conversion of address for <Object> overflowed <Address> ... .495
L1501: <Symbol name>=""> cannot be moved in section <Section
name>=""> (invalid qualifier <Segment qualifier>="">) ........... 495
L1502: <Object name>=""> cannot be moved from section <Source sec-
tion=""name>=""> to section <Destination section="" name>=""> . .496
L1503: <Object name>=""> (from file <File name>="">) cannot be moved
from section <Source section="" name>=""> to section <Destination sec-
tion=""name>=""> ... ... ... ... ... 497
L1504: <Object name>=""> (from section <Section name>="">) cannot be

nn "nn

"nn

moved from section <Source section="" name>=""> to section <Destina-
tion section=""name>=""> ... . ... .. .. .. .. . i 499
L1600: main function detected in ROM library ..................... 500
L1601: startup function detected in ROM library ................... 500
L1620: Bad digit in binary number .............. .. ... .. .. ... .. .. 500
L1621: Bad digitin octal number .............. ... ... .. .. .. ..., 501
L1622: Bad digitin decimal number ............. .. .. .. .. ... .. .. 501
L1623: Numbertoo big . ...ttt 501
L1624: Ident too long. Cut after 255 characters . .. .................. 501
L1625: Commentnotclosed .......... ... ... ... 502
L1626: Unexpectedendof file . ........... ... .. . 502
L1627: PRESTART command not supported, ignored ............... 502
L1629: START_DATA command not supported yet ................. 503
L1631: HAS_BANKED_DATA not needed for ELF Object File Format . 503
L1632: Filename too long . ...ttt 503
L1633: Illegal Filename ... .........o.iuininti e 504
L1634: Tllegal Prestart . ...... ..ottt 504
L1635: Bad input number for RESERVE field ..................... 504
L1636: ROOT sub entry expected for STACK_CONSUMPTION ...... 505
L1637: END entry expected . . .. ..ot vttt 505
L1638: Invalid Identifiers .. .......... .. . i 505
L1639: Bad input number for RECURSION_FACTOR field .......... 505
L1640: Bad input number for CONSUMPTION field . ............... 506
L1642: Bad input number (stacksize) for FUNCTION_PAIR field ..... 506
L1643: Bad input number (stacksize) for INTERRUPT_FUNCTION field . .
506
L1650: The encoding of <Object> in the special section .overlap was not rec-
ognized. The object is not overlapped ......................... 506
L1651: The function <Function> of the overlap object <Object> was not
found. The objectis not overlapped ............. ... ... ... .... 507
L1653: The object <Object> was not overlapped allocate .. ........... 507

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 19



Table of Contents

L1654: <Object> was not marked as root for overlapping . ............ 508
L1655: Overlapping <Object> depends oniitself .................... 508
L1656: Overlapping <Object> depends on multiple roots . ............ 508
L1700: File <File name>=""> should contain DWAREF information . . ... 509
L1701: Start up data structure is empty . .............c.ouiunen.n.. 510
L1702: Startup data structure field <name> is unknown .............. 510
L1800: Readerrorin<File> . ........ ... ... ... ... ... ... .. ... 511
L1803: Out of memory in <Function name>=""> ................... 511

" "nn

L1818: Symbol <Symbol number>=""> - <Symbol name>=""> duplicated in

<First file="" name>=""> and <Second file="" name>=""> ........ 511
L1820: Weak symbol <Symbol name>=""> duplicated in <First file=""
name>=""> and <Second file=""name>="">.................... 512

L1821: Symbol <id1> conflicts with <id2> in file <File> (same code) . ..512
L1822: Symbol <Symbol name>=""> in file <File name>=""> is undefined .

"nn

512
L 1823: External object <Symbol name>=""> in <File name>=""> created by
default .. ... . 513
L1824: Invalid mark type for<Ident> ........... .. ... .. .. ... ... 513
L1826: Can't read file. <Filename> is a not an ELF library containing ELF
objects (ELF objectsexpected) . .........cooviniiniinnnnn .. 513
L1827: Symbol <Ident> has different size in <Filename> (<Size> bytes) and
<Filename> (<SiZe>DbYtes) .. .o oo vttt i 514
L1828: Library: Symbol <Ident> has different size in <Filename> (<Size>
bytes) and <Filename> (<Size>bytes) ......................... 514
L1829: Cannot resolve label 'Ident' ............. .. .. ... .. ... ... 515

L1830: The label <labelname> cannot be resolved because of a recursion. . .
515

L1831: Could not allocate memory for <Section> section............. 516

L1903: Unexpected Symbol in Linkparameter file .................. 516

L1906: Fixup out of buffer (<Obj> referenced at offset <Address>) . .. .. 517

L1907: Fixup overflow in <Object>, type <objType> at offset <Address> . . .
517

L1908: Fixup error in <Object>, type <objType> at offset <Address> ...518

L1910: Invalid section attribute for program header ................. 518
L1912: Object <obj> overlaps with another (last addr: <addr>, object address:
<objadr> ... 518
L1914: Invalid object: <Object> . .. ...t 519
L1916: Section name <Section> is too long. Name is cut to 90 characters
length . ..o 519

L1919: Duplicate definition of <Object> in library file(s) <Filel1> and/or

20

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

<File2>discarded ......... .. .. .. 519
L.1921: Marking: too many nested procedure calls .................. 520
L.1922: File <filename> has DWARF data of different version, DWARF data

may not be generated . ......... ... 520
L.1923: File <filename> has no DWARF debug info ................. 520
L.1924: Objects <Object]> and <Object2>overlap .................. 521
L1925: Address conversion error in fixup evaluation in <Ident>, to <Offset>

fixup type <Type>, at offset <Offset> ......................... 521
L1926: Alias nesting too deep for <Object> object. Maximum depth allowed

IS<NUM>. L 521

L1930: Unknown fixup type in <ident>, type <type>, at offset <offset> .522
L1931: Fixup to not allocated object <Ident> in <Ident> typr <Type>, at oft-

set OXOffset > .. ... 522
TL1933: ELF: <details> . .. ...t 523
L1934: ELF: <details> .. ... ... i 523
L1936: ELF output: <details> . ......... ... .ot 523
L1937: LINK_INFO: <details> . ..., 523
L1951: Function <Function> is allocated inside of <Object> with offset <Off-

set>. Debugging may be affected ............... ... ... .. .... 524
L1952: Ident <name> too long. Cut after <size> characters ........... 524
L1970: Modifying code in function <function> at address <address> for

ECALL ..o 524
L1971: <Pattern> in function <function> at address <address> may be

ECALL Pattern .. .....oott et e 525
L1972: <Pattern> in function <function> at address <address> looks like ille-

Al ECALL . ... 525
L1980: <Feature> not supported .. ..........coovuiriiininnenenn. 526
L1981: No copydown created for initialized object <Name>. Initialization

data lost. . ..ot e 526
L2000: Segment <Segmentname> (for variables) should not be allocated in a

READ_ONLY-SECHON . o oo vt e e e 526
L2001: In link parameter file: segment <Segmentname> must always be

PIESEIIL . o vttt e et e e e e e e e e 528
L2002: Library file <Library> (in module <Module>) incorrect: "cause" 528
L2003: Object file <Objfile> (<Cause>) incorrect .................. 529
L2009: Out of allocation space in segment <segmentname> at address <ad-

AreSS> ot 529
L2008: Error in link parameterfile ................ .. ... ... .... 529
L2010: File not found: <Filename> .............. .. .. ... ... .... 529

L2011: File <filename> is not a valid HIWARE object file, absolute file or li-

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 21



Table of Contents

Drary .o 530
L2014: User requested StOP . . .. oottt e e 530
L2015: Different type sizes in <ref_objfile> and <cur_objfile> ........ 531

L2051: Restriction: library file <Library> (in module <Module>): <Cause> .
531

L2052: RESTRICTION: in object file <Objectfile>: <Cause> ......... 531
L2053: Module <Modulename> imported (needed for module-initializa-
tion?), but not present in list of objectfiles ...................... 532
L.2054: The symbolfiles of module <Modulename> (used from <User1> and
<User2>) have differentkeys ........... ... ... ... .. ... ..... 532
L2055: Function <functionname> (see link parameter file) not found ...532
L2056: Vector address <address> must fit wordsize ................. 533
L2057: Tllegal file format (Reference to unknown object) in <objfile> .. .533
L2058: <objnum> referenced objects in <file> ..................... 533
L2059: Errorinmap of <absfile> . ......... ... ... . ... ... 533
L2060: Too many (<objnum>) objects in library <library> ............ 534

L2061: <filename> followed by '-'/'+', but not a library or program module . .
534
L2062: <object> found twice with different size (in '<module1>'-><objsize1>

and in '<module2>'-><objsize2>) . ....... . . i 534
L2063: <symbol> twice exported (module <modulel> and module
<mOdUle2>) . .. e 535
L2064: Required system object <objectname>notfound ............. 535
L2065: No module exports with name <objectname> ................ 536
L2066: Variable '_startupData' not found, linker prepares no startup ....536
L2067: Variable '_startupData' found, but not exported . .............. 537
L2068: <objname> (in ENTRIES link parameter file) not found ....... 537
L2069: The segment 'COPY' must not cross sections ................ 537
L2070: The segment STRINGS crosses the page boundary ........... 537
L2071: Fixup Error: Reference to non linked object (<objname>) ...... 538
L.2072: 8 bit branch (from address <address>) out of range (-128 <= &It;off-
SEt> <= 127 538
L2073: 11 bit branch out of range (-2048 <= &lt;offset> <=2047)...... 539
L2074: 16 bit branch out of range (-32768 <= &lt;offset> <= 32767) . .. .540
L2075: 8 bit index out of range (<index> for <objname>) ............ 540
L2076: Jump crossing page boundary ............ .. .. .. .. .. ... 541
L2077: 16-bit index out of range (<index> for <objname>) ........... 542
L2078: 5 bit offset out of range (-16 <= &lt;offset><=15) ........... 542
L2079: 9 bit offset out of range (-256 <= &lt;offset> <=255) in <object> with
offset <offset>to <object> ........ .. ... ... i 543

22

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

L2080: 10 bit offset out of range (0 <= &lt;offset> <=1023) .......... 544
L2081: Illegal allocation of BIT segment ('<objname>":0x<ad-
dress>..0x<endaddress> =&gt; 0x20..0x3F, 0x400..0x43F) ........ 545
L.2082: 4 bit offset out of range (-7 <= &lt;offset><=15) ............ 545
L.2083: 11 bit offset out of range (-2048 <= &lt;offset> <=2047) ...... 546
L2084: Can't solve reference to object <name> . .................... 546
L2085: Can't solve reference to internal object ..................... 547
L2086: Cannot switch to segment <segName>. (Offset to big) ......... 547
L2087: Object file position error in <objname> .................... 547
L2088: Procedure <funcname> not correctly defined ................ 547
L2089: Internal: Code size of <objname> incorrect (<data> <objsize>) . . 548
L2090: Internal: Failed to write procedures for <modulename> ........ 548
L2091: Data allocated in ROM can't exceed 32KByte ............... 548
L2092: Allocation of object <objname> failed ..................... 549
L.2093: Variable <varname> (objectfile <objfile>) appears in module
<modulel> and in module <module2> ............. ... ... .. .. 549
L.2094: Object <varname> (objectfile <objfile>) appears in module
<modulel> and in module <module2> ............... .. ... .. .. 549
L2096: Overlap variable <Name> not allocated .................... 550
L2097: Additional overlap variable <Name> allocated ............... 550
L2098: The label <labelname> cannot be resolved because of a recursion. . .
550
L2103: Linking succeeded. Executable is written to <absfile> ......... 551
L2104: Linking failed . . ... ... .. 551
L2150: Illegal fixup offset (low bits) in <object> with offset <offset> to <ob-
51> 551
L2151: Fixup out of range (<low> <= &lt;offset> <= &lt;high>) in <object>
with offset <offset>to <object> ............ ... ... ... 552
L2201: Listing file could not be opened .......................... 552
L.2202: File for output s could notbe opened ...................... 553
L.2203: Listing of link process to <listfile> ........................ 553
L2204: Segment <segment> is not allocated to any section ........... 553
L2205: ROM libraries cannot have a function main (<main>) ......... 553
L2206: ROM libraries cannot have an INIT function (<init>) . ......... 554
L2207: <main>notfound ......... ... . ... ... i 554
L2208: No copydown created for initialized object <Name>. Initialization
data lost. . ..ot e 554
L2251: Link parameter file <prmfile>notfound .................... 555
L.2252: Tllegal syntax in link parameter file: <syntaxerror> ........... 555
L.2253: <definition> not present in link parameter file ............... 555

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 23



Table of Contents

L2254 <definition> is multiply defined in link parameter file ......... 556
L2257: Both stacktop and stacksize defined ....................... 556
L.2258: No stack definition allowed in ROM libraries ................ 557
L.2259: No main function allowed in ROM libraries ................. 557
L2300: Segment <segmentname> not found in any objectfile . ......... 557
L2301: Segment <segmentname> must always be present ............ 557
L2303: Segment <seg1> has to be allocated into <seg2> ............. 558

L.2304: <segmentname> appears twice in the <deflist> definition list . . . .558
L2305: In link parameter file: The segment <segment> has the section type

<type>(illegal) ........ i 558
L2306: Section <&lt;seglstart>,<seglend>&gt; and Section
<&lt;seg2start>,<seg2end>&gt;overlap . .. ... . .. 559
L2307: SSTACK cannot be allocated on more than one section ........ 559
L.2308: Size of Stack (STACKSIZE = Ox<stacksize>) exceeds size of segment
SSTACK (=0X<Segmentsize>) ... ........vuenenrenenennennn.. 559
L2309: STACKTOP-command specifies Ox<stacktop> which is not in
SSTACK (Ox<stackstart>..0x<stackend>) ...................... 559
L2310: The STACKTOP definition is incompatible with SSTACK being part
ofalistofsegments . .............ouiniiiniiinenininenen.. 560
L2311: STACKTOP or STACKSIZE missed ....................... 560
L2312: Stack not initialized .......... ... .. .. . . i 560

L2313: All <segtype>_BASED segments must fit in a range of 64 kBytes . . .
560
L2314: A <segtype>_BASED segment must not have an address less than

<Address™ . ... 561
L2315: A <segtype>_BASED segment must not have an address bigger than
<Address™ . ... 561
L2316: All SHORT <segtype>_BASED segments must fit in a range of
<range> Bytes (<startadr> - <endadr> &gt; 256 Bytes) . ........... 561
L2317: All non far segments have to be allocated on one single page . .. .561
L2318: Cannot split _OVERLAP .......... ... ... i, 562
L2400: Memory model mismatch: <modell> (previous files) and model
<model2> in module <objfile> ............. ... ... ... ... 562
L2401: Target CPU mismatch: <cpul> (previous files) and <cpu2> in module
<objfile> ... 562
L2402: Incompatible flags or compiler options: <flags> .............. 563
L2403: Incompatible flags or compiler options: <flags> .............. 563
L.2404: Unknown processor: <processor> in module <modulename> . ..563
L.2405: Illegal address range in link parameter file. In the <model> memory
model data must fitintoonepage ............c.ciiiiii.... 564

24

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

L2406: More than one data page is used. Segment <segname> is in page O . .
564

L2407: More than one data page is used in <memorymodel> memory model.
The data page is defined by the placement of the stack ............ 564

L.2408: Illegal address range in link parameter file. In <memorymodel> mem-
ory model the code page must be pagezero ..................... 565

L.2409: Multiple links are illegal: <object]>(module <modulel>) links to
<link1>(module <toModule1>) and to <link2>(module <toModule2>) ..

565
L2410: Unresolved external <object> (imported from <module>) . ..... 565
L2412: Dependency '<object>' description: " ........ ... .. .. ... .. .. 565
L.2413: Align STACKSIZE from <oldSize> to <newSize> . ........... 566
L.2414: Stacksize not aligned. Is <oldsize>, expected to be aligned to <ex-
peCtedsize™ .. ... 566
L2415: Tllegal dependency of '<object>' .......... .. ... ... ... .... 567
L2416: Illegal file name '<Filename>' . ........................... 567
L2417: Object <objname> refers to non existing segment number <segnum-
DT> L e 567
L.2418: Object <objname> allocated in segment <segname> is not allocated
according to the segment attribute <attrname> .................. 568
L4000: Could not open object file (<objFile>) in NAMES list ......... 569
L4001: Link parameter file <PRMFile>notfound .................. 569
L4002: Unable to determine object file format for <PRMFile>. NAMES sec-
tion missing? Use -F option to specify format. .................. 570

L4003: Linking <PRMFile> as HIWARE format link parameter file ....570
L4004: Linking <PRMFile> as ELF/DWAREF format link parameter file . 571

L4005: Tllegal file format of object file (<objFile>) ................. 571
L4006: Failed to create temporary file . ............ ... ... ... .... 571
L4007: Include file nesting to deep in link parameter file ............. 572
L4008: Include file <includefile> not found ....................... 572
L4009: Command <Command> overwritten by option <Option> ...... 572
L4010: Burner file creationerror " . ....... .. .. .. . i 573
L4011: Failed to generate distribution file because of <reason> ........ 573
L4012: Failed to generate distribution file because of distribution segment
<segment> not found or not alone in placement ................. 573
L4013: Function <function> is not in the distribution segment . ........ 574
L4014: The processor <processor> is not supported by the linker optimizer .
574

L4015: Section <section> has no IBCC_NEAR or IBCC_FAR flag . . . .. 575
L4016: No section in the segment <segment> has an IBCC_NEAR flag .576

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 25



Table of Contents

L4017: Failed to generate distribution file because there are no functions in

the distribution segment <segment> ..................c......... 576
L4018: The sections in the distribution segment have not enough memory for
all functions . . ... 577
L4019: Function <function name>=""> has a near flag and cannot be distrib-
UEed . .o 577
L4020: Not enough memory in the non banked sections of the distribution
SEZMENt <SEEMENES . . o vt vt ettt e ettt e et e e 578
L4021: Incompatible derivative: <Deriv0> in previous files and <Derivl> in
currentfile . ... ... L 578
L4022: HexFile not found: <Filename> .. ............ ... ........ 579
L4023: Hexfile error " in file '<Filename>' ........................ 579
L4024: No information available for segment '<name>". .............. 579
L4025: This limited version allows only <num> <limitKind> ......... 580
L4026: Incompatible compile-time options: different HCS12XE memory
mappings found in objectfiles ........... ... ... ... . ... 580
L4027: Incompatible compile-time options: different HCS12XE memory
mappings found in objectfiles ........... ... ... .. .. ... 581

L4028: Section '<SectionName>' has no DATA_NEAR or DATA_FAR flag .
581

L4029: No objects in the distribution segment '<Segment>' ........... 581
L4030: Failed to generate data distribution file because of distribution seg-
ment '<SegmentName>' not found or not alone in placement. . ... ... 582

L4032: No section in the segment <SegmentName> has a DATA_NEAR flag
582
L4033: Not enough memory in the section of the distribution segment <Seg-

ment> for object <ObjectName> . .............. ... .. ..., 582
L4101: Preprocessor failure because of '<Reason>'. ................. 583
L4102: Computation of total memory size per memory type (e.g.

_SEG_TOTAL_RW) unavailable in Hiware format ............... 583
L4104: Library file '<FileName>' should be recompiled with option <Rea-

SOTI> . ottt et et e e e e 584
L4105: Library file <Filename>notfound ......................... 584
L4106: Startup file '<FileName>' should be recompiled with option <Rea-

SOMI> . ottt et e e e e e 584
L4107: Linker implicitly allocates objects of '<section>' after section '<sec-

18103 1 584

L4108: Section '<SectionName>' is assigned to multiple segments or pages .
585
L4109: Link from function <ObjectName> to <> is disables as it initiates in-

26

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

direCt TECUISIVILY . .« oottt ettt et 585
L4110: Maximum stack consumption computed for root <ObjectName> is
<,> and this exceeds the stack size in input PRM file. ............. 586
L4111: No input in PRM file for STACK_CONSUMPTION .......... 586
L4112: Function <ObjectName> specifid under STACK_CONSUMPTION
entry of pRM fileisnotfound ............ ... ... .. .. ... .. .. 586
L4113: Stack size information for function <ObjectName> is not available
Default stack size of this function is considered as zero ........... 587
L4114: Stack consumption option [<Command>] is diabled. Maximum stack
usage for the application will not be computed. .................. 587
L4115: The nesting depth of the call graph exceeds <Reason>. Maximum
stack usage for the application will not be computed. ............. 587
L4116: The indirect recursion depth exceeds <Reason>. Maximum stack
usage display might be incorrect. .......... ... ... .. ... ...... 588
L4117: Duplicate entry "ROOT <RootName>" in PRM file. .......... 588

L4118: Redundant Stack Consumption directives <DirectiveName> and <Di-
rectiveName> specified for function <FunctionName> in PRM file. .588

Burner Message List. ... ... e 589
B1: Unknown Message Occurred . . ..., 589
B2: Message Overflow, Skipping <kind> Messages ................. 589
B50: Input file ‘<file>’ notfound . .......... ... ... .. ... .. ... 590
B51: Cannot Open Statistic Log File<file>...................... .. 590
B52: Error in Command Line '<emd> . ......... ... .. ... .. .. .. 590
B53: Message <Id> is not used by this version. The mapping of this message

ISIgNOTEd. .o\t te 590
B54: Option <Option> <Description> . ............. .. ... ....... 591
B56: Option value overriden for option <OptionName>. Old value '<Old-

Value>'. New value '<NewValue> ............................ 591
B64: Line Continuation Occurred in <FileName>................... 592
B65: Environment Macro Expansion Error '<description>' for <variable-

DAMIES . .ttt ettt e e e e e e 593
B66: Search Path <Name> Does Not Exist ........................ 593
B1000: Could Not Open '<FileType>''<File> ...................... 593
B1001: Error in Input File Format .. ........... ... .. ... .. .... 594
B1002: Selected Communication Portis Busy ..................... 594
B1003: Timeout or Failure for the Selected Communication .......... 594
B1004: Error in Macro ‘<macro>’ at Position <pos>: ‘<msg>" ........ 595
B1005: Error in Command Line at Position <pos>: ‘<msg>" .......... 595
B1006: ‘<mSE>" . .o 595

Libmaker Message List. .. ... i 596

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 27



Table of Contents

LMI1: Unknown Message Occurred ...............cooiuiiuneen .. 596
LM2: Message Overflow, Skipping <kind> Messages . ............... 596
LMS50: Input File ‘<file>’ NotFound . ........... ... .. ... ....... 597
LMS51: Cannot Open Statistic Log File <file> ...................... 597
LMS52: Error in Command Line<cmd> .. ......................... 597
LMS53: Message <Id> is not used by this version. The mapping of this mes-
sageisignored .. ... ... 598
LM54: Option <cmd> :<Description> . ............c.cotvivninen.. 598
LM56: Option value overriden for option <OptionName>. Old value '<Old-
Value>'. New value '<NewValue>'. ............................ 599
LM64: Line Continuation Occurred in <FileName> ................. 599
LM65: Environment Macro Expansion Message '<description>' for <vari-
ablename> . ... ... 600
LMG66: Search Path <Name> Does Not Exist .. ..................... 601
Decoder Message List. ... ovo vttt 601
D1: Unknown Message Occurred . .. ..o, 601
D2: Message Overflow, Skipping <kind> Messages ................. 601
D50: Input File ‘<file>” NotFound .............................. 602
D51: Cannot Open Statistic Log File <file> . ....................... 602
D52: Error in Command Line<ecmd> ....... ... .. ... .. .. ...... 602
D53: Message <Id> is not used by this version. The mapping of this message
ISIENOTEd . . oot e 603
D54: Option <cmd> <description> ........... ..., 603
D56: Option value overriden for option <OptionName>. Old value '<Old-
Value>'. New value '<NewValue>'. ........... .. ... .. ....... 604
D64: Line Continuation Occurred in <FileName> . .................. 604
D65: Environment Macro Expansion Message '<description>' for <variable-
DAMIES . .ottt ettt et e e e e e 605
D66: Search Path <Name> Does Not Exist ................ .. ... ... 605
D1000: Bad Hex Input File <Description> ........................ 605
D1001: Because Current Processor is Unknown, No Disassembly is Gener-
ated. USe -PrOC. .o vv ittt e e e e 606
D1002: Memory allocation failed. Possible reasons: corrupt input file or not
enough memory available ......... ... .. ... .. . . ... 606
D1003: An invalid checksum has been found ...................... 607
D1004: File IO Error for file <Filename> ......................... 607
Makefile MeSSAZES . .. .o v it 607
MI: Unknown Message Occurred .............. ... .. ..o, 608
M2: Message Overflow, Skipping <kind> Messages ................. 608
M50: Input File ‘<file>’ Not Found ............. .. .. ... .. ... ... 608

28 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

MS51: Cannot Open Statistic Log File <file> ....................... 609
M52: Error in command line<cmd> .. ... ... ... . . o 609
M53: Message <Id> is not used by this version. The mapping of this message
Isignored. .. ... 609
M54: Option <OPHION> . ..ottt e 610
M56: Option value overriden for option <OptionName>. Old value '<Old-
Value>'. New value '<NewValue>'. . ........................... 610
M64: Line Continuation Occurred in <FileName> .................. 611
M65: Environment Macro Expansion Error '<description>' for <variable-
DAMIES . .ttt et et e e e e 612
M66: Search Path <Name> Does Not Exist . ....................... 612
M5000: User Requested StOp . . . oo v v v it 613
M5001: Error inCommand Line . ........... ... .. ... .. ... .... 613
M5002: Can't Return to <makefile> at End of Include File . ........... 613
M5003: Tllegal Dependency . ..........ouuniniiinieninnnenenan. 614
M5004: Tllegal Macro Reference ............ ... ... ... 614
M5005: Macro Substitution Too Complex ......................... 615
M5006: Macro Reference Not Closed . ........... .. .. ... ... .... 615
M5007: Unknown Macro: <macroname> . ................oeueunen. 615
M5008: Macro Definition or Command Line TooLong .............. 616
M5009: Illegal Include Directive ............co.vuiiiiinennenenn. 616
MS5010: Ilegal Line .. ......vn i et 616
M5011: Illegal Suffix for InferenceRule . ....................... .. 617
M5012: Include File Not Found: <includefile> ..................... 617
M5013: Include File Too Long: <includefile> . ..................... 618
M5014: Circular Macro Substitution in <macroname> .. ............. 618
M5015: Colon (:) Expected ....... ..o, 618
M5016: Filename After INCLUDE Expected ...................... 619
M5017: Circular Include, File <includefile> ....................... 619
M5018: Entry Doesn't Startat Column O . ......................... 619
M5019: No Makefile Found . ......... ... ... .. ... . ... 620
M5020: Fatal Error During Initialization . ......................... 620
M5021: Nothing to Make: No Target Found ....................... 620
M5022: Don't Know How to Make <target> ....................... 621
M5023: Circular Dependencies Between <target1> and <target2> . ... .. 621
M5024: Tllegal Option . ...ttt 622
M5027: Making Target <target> ..............ociiriinenennen... 622
M5028: Command Line Too Long: <commandline> ................ 622
M5029: Illegal Target Name: <targetname> ....................... 623
Exec Process Messages. . ... vvu vttt 623

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 29



Table of Contents

M5100: Command Line Too Long forExec ....................... 623
M5101: Two File Names Expected ........... .. .. ... .. ... ..... 623
M5102: Input File NotFound . .. ........ .. ... ... it 624
M5103: Output File Not Opened . .......... ..., 624
M5104: Error While Copying . .. ... cov i 624
M5105: Renaming Failed . ......... ... .. . ... . 625
MS5106: File Name Expected . .......... ..., 625
M5107: File Does Not EXist ... ..o ooven i 626
MS5108: Called Application Detectedan Error . ............. .. ... ... 626
M5109: Echo <commandline> .. ........ ... ... .. .. ..., 626
M5110: Called Application Caused a System Error .. ................ 627
MS5111: Change Directory (cd) Failed ............................ 627
M5112: Called Application: <error> ..............cveuirvunenen.. 627
M5113: Called Application: <warning> .. ..........coeuiuvunenen.. 628
M5114: Called Application: <information> ........................ 628
MS5115: Called Application: <fatal>............... ... ... .. ...... 629
M5116: Could Not Delete File .. ... ... 630
M5117: PathWas NotFound . ........ .. .. . .. .. . . . .. 630
MS5118: Could Not Create Process: <diagnostic> ................... 630
M5119: Exec <commandline> .......... .. ... ... ... 631
M5120: Running Version with Limited Number of Execution Calls. Number
of Allowed Execution Calls Exceeded ......................... 631
M5121: The Files <file1> and <file2> Are Not Identical ............. 631
M5122: The Files <file1> and <file2> Are Identical ................. 632
M5153: Processing Make Files Under Win32s Is Not Supported by the Maker
632
Modula-2 Maker MesSages . . . .. vvene ettt e 632
M5700: Environment Variable COMP NotSet ..................... 632
M5701: Environment Variable LINK Not Set ...................... 633
M5702: Neither Source Nor Symbol File Found: <source file> ........ 633
M5703: Circular Imports in Definition Modules .................... 633
M5704: Can't Recompile <source file> (No Source Found) ........... 634
MS5705: No Make File Generated (Top Module Not Found) ........... 634
M5706: Couldn't Open the Listing File <listfile> ................... 634
M5708: Couldn't Open the Makefile ............................. 635
M5761: Wrote Makefile <makefile> ................ ... .. ... ... 635
M5763: Compilation Sequence . .............c.ouiuiinininnenen.. 635
D Tool Commands 637
SmartLinker Commands . . .......... .. i 637

30

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Table of Contents

AUTO_LOAD: Load Imported Modules (Freescale, M2) ............. 637
CHECKSUM: Checksum Computation (ELF) ..................... 638
CHECKKEYS: Check Module Keys (Freescale, M2) ................ 641
DATA: Specify the RAM Start (Freescale) ........................ 642
DEPENDENCY: Dependency Control ........................... 642
ENTRIES: List of Objects to Link with Application . ................ 646
HEXFILE: Link Hex File with Application ........................ 648
INIT: Specify Application Init Point .. .......... ... .. ... ... .... 649
LINK: Specify Name of Output File .............. ... ... ... .... 649
MAIN: Name of Application Root Function ....................... 651
MAPFILE: Configure Map File Content . ......................... 651
NAMES: List Files Building the Application ...................... 654
OVERLAP_GROUP: Application Uses Overlapping (ELF) ........... 655
PLACEMENT: Place Sections into Segments . ..................... 657
PRESTART: Application Prestart Code (Freescale) ................. 659
SECTIONS: Define Memory Map (Freescale) ..................... 659
SEGMENTS: Define Memory Map (ELF) ........................ 662
STACKSIZE: Define Stack Size ........... .. .. . . . ciii... 669
STACKTOP: Define Stack Pointer Initial Value .................... 671
START: Specify the ROM Start (Freescale) . ....................... 672
VECTOR: Initialize Vector Table ............ .. .. .. .. .. .. .. ... 673
Batch Burner Commands . ............. ... it 674
baudRate: Baudrate for Serial Communication ..................... 675
busWidth: DataBus Width . . ......... ... .. . . ... . .. 676
CLOSE: Close Open File or Communication Port .................. 677
dataBit: Number of Data Bits ........... .. ... .. .. . . 677
destination: Destination Offset .. ........... .. .. ... .. .. .. ..... 678
DO: For Loop Statement List . .. ..., 679
ECHO: Echo String onto Output Window . ........................ 679
ELSE: Else Part of If Condition . ......... .. .. ... ... ..., 680
END: For LoopEndor If End .......... ... ... ... . .. 681
FOR: FOr Loop . ..ottt e e e e e 682
format: Output Format . ........ ... ... . . i, 683
header: Header File for PROM Burner ........................... 683
IF:IfCondition . .. ...t 684
len: Lengthtobe Copied .......... .. ..., 685
OPENCOM: Open Output Communication Port .. .................. 686
OPENFILE: Open OutputFile .. ....... ... ... .. ... . ... 686
origin: EEPROM Start Address . ......... .. .. .. ..., 687
parity: Set Communication Parity ............ .. ... .. ... .. ... .. 688

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 31



Table of Contents

SENDBYTE: Transfer Bytes ................ ... 688

SENDWORD: Transfer Word ........... ... ..., 689

SLINELEN: SRecord Line Length . . . ...... ... .. .. .. ... ... ... 690

SRECORD: S-Record Type . ........ ... .. ... 691

swapByte: Swap Bytes . ....... ... 692

THEN: Statementlist for If Condition ............................ 693

TO: For Loop End Condition ........... ..., 694

undefByte: Fill Byte for Binary Files . ........... .. .. ... .. .. ... 694

PAUSE: Wait until Key Pressed . .......... ... ... .. .. 695

E EBNF Notation 697
Introductionto EBNF . ... ... . o 697
EBNFExample ... ..o e e e e 697

EBNF Syntax. . ... ... . 698

EXtensions . . ... ..ot e 698

Index 701
32 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Introduction

CodeWarrior IDE Utilities

The HCO8/RS08/S12Z Build Tools Utilities Manual describes the following five
CodeWarrior IDE utilities:

¢ SmartLinker
* Burner

¢ Libmaker

¢ Decoder

* Maker

SmartLinker

The CodeWarrior IDE SmartLinker utility merges various object files of an application
into one absolute file (or . ABS file) that can be converted to an S-Record or an Intel® Hex
file, using the Burner utility or loading the file into the target using the Downloader/
Debugger.

This utility is a smart linker as it links only those objects that are actually used by your
application. The SmartLinker generates either Freescale or ELF absolute files.

Burner

The CodeWarrior IDE Burner utility converts an .ABS file into a file that can be handled
by an EPROM burner.

Libmaker

The CodeWarrior IDE Libmaker utility creates and maintains object file libraries.

Decoder

The CodeWarrior IDE ELF/Freescale Decoder utility disassembles object files, absolute
files and libraries in the Freescale object file format or ELF/DW ARF format, along with
S-Record files.
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Maker

The CodeWarrior IDE Maker utility implements the UNIX make command with a
Graphical User Interface (GUI). In addition, you can use Maker to build Modula-2
applications as well as maintain C/C++ projects.

Starting CodeWarrior Utilities

You can start all of the utilities described in this book from executable files located in the
prog folder of your CodeWarrior IDE installation. The executable files are:

¢ linker.exe: SmartLinker

* burner.exe: Burner

¢ libmaker.exe: Libmaker
¢ decoder.exe: Decoder
* maker.exe: Maker

A standard full installation of the HCO8/RS08 CodeWarrior IDE places the executable
files in the location:

<CWilnstallDir>\MCU\prog

For S127 derivatives, the executable files are located at:
<CWilnstallDir>\MCU\S121lisa_Tools

where <CWinstallDir> is the directory where the CodeWarrior software is installed.

To start any CodeWarrior Utility, double-click on the appropriate executable( . exe) file.
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SmartLinker

This chapter describes the SmartLinker utility. The linker merges the various object files
of an application into one absolute file (or . ABS file). The file is called absolute file
because it contains absolute, not relocatable code. You can convert this . ABS file to an S-
Record or an Intel® Hex file using the Burner program or load the . ABS file into the
target using the Downloader/Debugger.

The Linker is a smart linker. It links only those objects that are actually used by your
application.

This linker is able to generate either Freescale or ELF absolute files. For compatibility
purposes, the Freescale input syntax is also supported when ELF absolute files are
generated.

Purpose of Linker

Linking is the process of assigning memory to all global objects (functions, global data,
strings, and initialization data) needed for a given application and combining these objects
into a format suitable for downloading into a target system or an emulator.

The linker is a smart linker. It links only those objects that are actually used by the
application. The unused functions and variables do not occupy any memory in the target
system. Other optimizations that reduce memory requirements include storing initialized
parts of global variables in compact forms, and reserving memory only once for equal
strings.

Product Features

The most important features supported by the SmartLinker are:

¢ Complete control over the placement of objects in memory: You can allocate
different groups of functions or variables to different memory areas (Segmentation;
see the Segments and Sections chapters).

* Linking to objects already allocated in a previous link session (ROM libraries).
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NOTE  The code for application startup is a separate file written in inline assembly and
can be easily adapted to your particular needs. In this manual, the startup file is
called startup. However, this is a generic file name that has to be replaced
by the real target startup file name. See the README . TXT file in the
appropriate subdirectory of the installation LIB directory for more details
about memory models and associated startup codes.

* Mixed-language linking: You can mix Modula-2, assembly, and C object files, even
in the same application.

¢ Vector initialization.

Section Contents

This section consists of the following chapters:

¢ SmartLinker User Interface — Describes the features of the SmartLinker user
interface

* SmartLinker Files — Describes the input and output files used by the SmartLinker
¢ Linking Issues — Discusses linking features and issues

¢ SmartlLinker Parameter File — Describes the requirements of the SmartLinker
parameter file

¢ ELF Sections — Describes the use of sections and segments for ELF and provides
examples using sections to control allocation of variables and functions

* Segments — Describes the use of sections and segments for Freescale

¢ Program Startup — Describes advanced material on using startup routines

* The Map File — Describes the contents of the map file produced by the link process
* ROM Libraries —Describes creating and using ROM libraries

» Initializing the Vector Table — Describes initializing the vector table

Starting the SmartLinker Utility

All utilities described in this book may be started from executable files located in the
prog folder of your CodeWarrior IDE installation. The executable files are:

¢ linker.exe: The SmartLinker Utility
* burner.exe: The Burner Utility

¢ libmaker.exe: The Libmaker Utility
¢ decoder.exe: The Decoder Utility
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* maker .exe: Maker: The Make Tool

With a standard full installation of the HCO8/RS08 CodeWarrior IDE, the executable files
are located at:

<CWilnstallDir>\MCU\prog

For S127 derivatives, the executable files are located at:
<CWinstallDir>\MCU\S121lisa_Tools

where <CWInstallDir> is the directory where CodeWarrior software is installed.

To start the SmartLinker Utility, double-click on 1inker. exe.
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SmartLinker User Interface

The SmartLinker runs under Win32. You can start the linker from the prog folder located
in the CodeWarrior installation folder.

NOTE  For S12Z architectures, you can start the linker from the s121isa_tools
folder located in the CodeWarrior installation folder.

SmartLinker Main Window

The SmartLinker Main window provides a window title, a menu bar, a toolbar, a content
area, and a status bar, as shown in the following figure.

Figure 1.1 SmartLinker Main Window

Window Title ' SmartLinke

/ File Smartlinker View Help
Menu Bar D3 7 M [ropm ~l|& Fa=1-

-~
/ fibo.pro
Toolbar r

Commend Line: ‘Cibo.pm °
Ciihiwars\fibo.prm: IKFORMATION L4004: Linking C:\hivare\fibo.prm as ELF/DWARF
Reading Parameters
Linking C:\hiware\fibe.pra
Read Binary Input Files
Reading £ile 'C:\hiware\fibo.o'
| PTeading file 'C:\hiware\scartup.a’
Reading file 'C:‘hiware\ansi.lib'
Content Area Harking Rererenced Objects
Moving Objects Across Sections
Reserving Memory for Starcup Data
Allocating Objecta
Preparing Startup Data
Generating Code
Generating Symhol table
Generating DWARF data wersion 2.0
INFORMATION L10O38: Success. Executable Clle written to Ciyhiware\Libo.abs
Generating HAP file 'C:vhiware\fibo.map®
Snartlhinger: *** 0 erroc(s), 0 warningis), 2 information message(s| **%
Snarelinker: *** Procecaosing ok ***

< >
Status Bar ——fReady 10:37:22
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SmartLinker Main Window

Window Title

The window title displays the project name. If currently no project is loaded, Default
Configuration appears in the title. An asterisk ( * ) after the configuration name indicates
that some values have changed. The asterisk ( * ) appears as soon as an option, the editor
configuration or the window appearance changes.

Content Area

The Content Area is used as a text container where logging information about the link
session is displayed. This logging information consists of:

¢ The name of the prm file which is being linked.

* The complete name (including full path specification) of the files building the
application.

¢ The list of the errors, warnings and information messages generated.

When you drop a file name into the SmartLinker window content area, the corresponding
file loads as configuration if the file has the extension . ini. Otherwise, the file links with
the current option settings (see Specifying the Input File).

All text in the SmartLinker window content area can have context information. The
context information consists of two items:

* A file name including a position inside of a file
* A message number

File context information is available for all output lines where a file name is displayed.
There are two ways to open the file specified in the file context information in the editor
specified in the editor configuration:

» If a file context is available for a line, double-click on a line containing file context
information.

» Right-click at the desired line and select Open file from the context menu.

NOTE If a file cannot be opened although a context menu entry is present, the editor
configuration information is not correct (see the section Editor Settings Tab).

Most messages appear with associated message numbers. There are three ways to open the
corresponding entry in the help file:

* Select one line of the message and press F1.

* Press Shift+F1 and then click on the desired message text.

40
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NOTE  If the selected line or message text does not have a message number, using
either F1 or Shift+F1 displays the main help page.

* Right-click the message text and select Help on from the context menu. This entry is
only available if a message number is available.

NOTE  The Help on option is available only when a message number is available.

Messages are colored according to their kind. Errors are red, Fatal Errors are dark red,
Warnings are blue, and Information Messages are green.

Main Window Tool Bar

The following figure shows the SmartLinker main window toolbar buttons.

Figure 1.2 SmartLinker Main Window Toolbar

EE =H 7 T fibo p] I = T ﬁ
Context Help Command Line Link
Online Heln Stop Lmking
Save Current Confieuration Option Settings
Load a Confipuration MWessage Settings
New Confguration Clear Linker
Window

You can use the SmartLinker toolbar buttons to perform various functions in the
SmartLinker utility as listed below:

¢ New — Use this button to open a new configuration.

* Load — Use this button to load an existing configuration.

¢ Save — Use this button to save the current configuration for the linker.
* Help — Use this button to open the online help file.

¢ Context Help — Use this button to open the context help. Pressing this button
changes the cursor form and adds a question mark beside the arrow. Clicking any
item calls the help for that item. Use the context help to get specific help on menus,
toolbar buttons, or on the window area.

¢ Command Line — The Command Line history contains the list of the last
commands executed. Once a command line has been selected or entered in this
combo box, click the Link button to execute this command. You can select the
command line in the toolbar by pressing the F2 key.
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SmartLinker Main Window

¢ Link — Use this button to execute the command selected in the Command Line.

¢ Stop — Use this button to abort the current link session. If no link session is running,
this button is disabled (gray).

¢ Options — Use this button to open the SmartLinker Option Settings dialog box.

* Messages — Use this button to open the SmartLinker Message Settings dialog
box.

¢ Clear — Use this button to clear the SmartLinker window content area.

Main Window Status Bar

The following figure shows the SmartLinker main window status bar.

Figure 1.3 SmartLinker Main Window Status Bar

Processing ok 15:41:50
Message Area Current Time

When pointing to a button in the toolbar or a menu entry, the message area displays the
function of the button or menu entry.

Main Window Menu Bar

The following table lists the menus that are available in the menu bar:

Table 1.1 SmartLinker Main Window Menus

Menu Description
File Menu Contains entries to manage SmartLinker configuration files.
SmartLinker Menu Contains entries to set SmartLinker options.
View Menu Contains entries to customize the SmartLinker window output.
Help A standard Windows Help menu.

File Menu

With the File menu, you can save or load the SmartLinker configuration files. A
SmartLinker configuration file contains the following information:

* SmartLinker option settings specified in the SmartLinker dialog boxes.
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* Message settings which specify which messages to display and which to treat as

C€ITorsS.

¢ List of the last command line executed and the current command line.

* Window position, size and font.

* Tips of the Day settings, including the enable at startup setting and the current entry.

Configuration files are text files, which have the standard extension . ini. You can define
as many configuration files as required for your project, and switch between the different
configuration files using the File > Load Configuration and File > Save Configuration
menu entry or the corresponding toolbar buttons. The following table describes the File

menu items.

Table 1.2 File Menu Items Description

Menu ltem

Description

Link

Opens Select File to Link dialog box, displaying the list of all the
.prm files in the project directory. Select the input file using the
features from the Select File to Link dailog box. The selected
file links as soon as you close the Select File to Link dailog box
by clicking Open.

New/Default
Configuration

Resets the SmartLinker option settings to the default values. The
SmartLinker options activate by default.

Load Configuration

Opens Loading configuration dailog box, displaying the list of
all the . ini files in the project directory. Select the configuration
file using the features from the Loading configuration dailog
box. Loads the configuration data stored in the selected file and
uses it in a further link session.

Save Configuration

Saves the current settings in the configuration file specified on
the title bar.

Save Configuration
As

Opens Saving Configuration as dailog box, displaying the list of
all the . ini files in the project directory. Specify the name or
location of the configuration file using the features from the
Saving Configuration as dailog box. Saves the current settings
in the specified file as soon as you close the Saving
Configuration as dailog box by clicking Save.

Configuration

Opens the Configuration dialog box to specify the editor used
for error feedback, which parts to save with a configuration, and
environment variable settings.
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Table 1.2 File Menu Items Description (continued)

Menu Item Description
1 Recent project list. Access this list to reopen a recently opened
project.i project.
ni
e 2
project.i
ni
Exit Closes the SmartLinker.

SmartLinker Menu

The SmartLinker menu allows you to customize the SmartLinker. You can graphically
set or reset SmartLinker options or define the optimization level you want to reach. The
following table describes the SmartLinker menu items.

Table 1.3 SmartLinker Menu ltem Description

Menu Item | Description

Options Allows you to define the options which must be activated when linking
an input file (see Option Settings Window).

Messages Opens a dialog box in which you can map the different error, warning or
information messages to another message class (see Message Settings
Window).

Stop Linking | Stops the currently running linking process. This entry is only enabled
(black) when a link process currently takes place. Otherwise, it is gray.

View Menu

The View menu allows you to customize the linker window. You can specify whether to
display or hide the status bar and the toolbar. You can also define the font used in the
window or clear the window. The following table describes the View menu items.
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Table 1.4 View Menu ltem Description

Menu ltem Description

Toolbar Displays or hides the toolbar in the SmartLinker window.

Statusbar Displays or hides the status bar in the SmartLinker window.

Log Allows you to customize the output in the SmartLinker window
content area. The following options are available when Log is
selected:

¢ Change Font — Opens a standard font selection dialog
box. Applies the options selected in the Font dialog box to
the SmartLinker window content area.

¢ Clear Log — Allows you to clear the SmartLinker window
content area.

SmartLinker Configuration

You can open the Configuration dialog box by selecting the File > Configuration from
the menu bar. The SmartLinker Configuration dialog box has three tabs, listed as below:

» Editor Settings Tab

¢ Save Configuration Tab

¢ Environment Tab

Editor Settings Tab

The Configuration dialog box Editor Settings tab, as shown in Figure 1.4, has option
buttons that let you select an editor type for SmartLinker, or for all tools. Depending on
the type of editor selected, the Editor Settings tab content changes.

Global Editor Option
Figure 1.4 shows the Global Editor option selected in the Editor Settings tab.

All tools and projects on one computer share the Global Editor. It is stored in the global
initialization file MCUTOOLS . INT in the [Editor] section of the file. Some Modifiers
(editor options) can be specified in the editor command line. Once these options are
stored, the behavior of the other tools that use the same entry changes the next time you
start the tool.
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Figure 1.4 Editor Settings Tab — Global Editor
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Local Editor Option

Figure 1.5 shows the Editor Settings tab with the Local Editor (Shared by all Tools)
option selected.

All tools using the same project file share the Local Editor. You can specify some
Modifiers in the editor command line.

You can edit the Local Editor configuration with the linker. When these entries are stored,
the behavior of the other tools using the same entry also changes the next time you start
the tool.
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Figure 1.5 Editor Settings Tab — Local Editor
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Editor started with Command Line Option

The following figure shows the Editor Settings tab with the Editor started with
Command Line option selected.
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Figure 1.6 Editor Settings Tab — Editor started with Command Line
Configuration ﬁ|
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Selecting this editor type associates a separate editor with the SmartLinker for error
feedback. The editor configured in the Shell is not used for error feedback.

Enter the command that you want to use to start the editor. The format for the editor
command depends on the syntax required to start the editor. You can specify some
Modifiers in the editor command line to refer to a line number of the named file.

Example
For Winedit 32-bit versions, use (with an adapted path to the winedit . exe file):
C:\WinEdit32\WinEdit.exe %$f /#:%1

Forwrite.exe, use (with an adapted path to the write. exe file, note that write does
not support line numbers):

C:\Winnt\System32\Write.exe %f

Editor Communication with DDE Option

The following figure shows the Configuration window Editor Settings tab with the
Editor Communication with DDE option selected.
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Figure 1.7 Editor Settings — Editor Communication with DDE

Configuration §|

Editor Settings ]Save Corfiguration | Environmert |
(™ Global Editor (Shared by all Tools and all Projects)
" Local Editor (Shared by all Tools)
" Editor started with Command Line
{* Editor Communication with DDE
™ CodeWamior (with COM)

Service Name |rnsdev

Topic Name |sy5tern

Client Command |[°pe"[lm]

Use %f for the filename, %l for the line and %c forthe
column.

oK | cancdl | Hep

You must enter the Service Name and Topic Name as well as the Client Command to be
used for a DDE connection to the editor. All entries can have modifiers for file name and
line number as explained in the Modifiers section below.

Example

For Microsoft Developer Studio use the following setting:
Service Name: "msdev"

Topic Name: "system"

ClientCommand: "[open(%$f)]"

Modifiers

Include some modifiers in the configurations to tell the editor which file to open and at
which line.

¢ The % £ modifier refers to the name of the file (including path) where the error was
detected.

* The %1 modifier refers to the line number where the message was detected.

NOTE  Only use the $1 modifier with an editor which can be started with a line
number as a parameter. This is not the case for WinEdit version 3.1 or lower or
for Notepad. When you work with such an editor, you can start it with the file
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name as a parameter and then select the menu entry Go to to jump to the line
where the message was detected. In that case, the editor command looks like:
C: \WINAPPS\WINEDIT\Winedit.EXE $%£f. Check your editor
documentation to determine which command line to use to start the editor.

Save Configuration Tab

The following figure shows the Save Configuration tab of the Configuration Window,
which contains all of the options for the Save operation.

Figure 1.8 Save Configuration Tab

Configuration
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QK | Cancel Help

In the Save Configuration tab, use the four checkboxes to choose which items to save to
a project file when you save the configuration.

¢ Options: This item relates to the option and message settings. Setting this checkbox
stores the current option and message settings in the project file when the
configuration is saved. By disabling this checkbox, changes to the option and
message settings are not saved and the previous settings remain valid.

* Editor Configuration: This item relates to the editor settings. Setting this checkbox
stores the current editor settings in the project file when the configuration is saved.
By disabling this checkbox, the previous settings remain valid.
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e Appearance: This item relates to many parts such as the window position (only
loaded at startup time) and the command line content and history. Setting this
checkbox stores these settings in the project file when the current configuration is
saved. By disabling this checkbox, the previous settings remain valid.

¢ Environment Variables: This item relates to the environment variable settings on
the Environment tab. Setting this checkbox stores the specified settings in the project
file when the current configuration is saved. By disabling this checkbox, the previous
settings remain valid.

NOTE  Disabling specific options, prevents some parts of a configuration file from
being written. For example, when the editor has been configured, the save
Editor mark can be removed. Then future save commands no longer modify the
options.

* Save on Exit: Setting this option makes the linker write the configuration on exit. No
dialog box appears to confirm this operation. If this option is not set, the linker does
not write the configuration at exit, even if options or other parts of the configuration
have changed. No confirmation appears in any case when closing the linker.

NOTE  Most settings are stored only in the project configuration file. The only
exceptions are: The recently used configuration list and All settings in this
dialog.

NOTE  The linker configurations coexist in the same file as the project configuration
of the shell. When the shell configures an editor, the linker can read this
content out of the project file, if present. The project configuration file of the
shell is named project. ini. This file name is therefore suggested (but not
mandatory) for the linker.

Environment Tab

The Environment tab of the Configuration window, shown in the following figure,
contains all of the options for configuring environment variables.

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 51



4
A

SmartLinker User Interface
SmartLinker Main Window

Figure 1.9 Environment Tab
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You can define the environment variables for the SmartLinker in the Environment tab.

Click the Add button to add new entries, the Change button to change an existing entry,
and the Up and Down button to change the order of the entries.

Option Settings Window

The five tabs of the Options Settings window, shown in the following figure, allow you to
set or reset SmartLinker options.
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Figure 1.10 Option Settings Window
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In addition to the Optimizations tab, a tab is provided for each of the four option groups.
The following table describes these four tabs.

Table 1.5 Option Settings Group Description

Group

Description

Optimizations

Lists options related to the optimization.

Output

Lists options related to the output files generation (what kind of files to
generate).

Input

Lists options related to the input files.

Host

Lists host-specific options.

Messages

Lists options controlling the generation of error messages.

Set a SmartLinker option by checking its checkbox. To obtain a more detailed explanation
about a specific option, select the option and then press the key F/ or the help button. To
select an option, click once on the option text. The option text is then highlighted.
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When the window is opened, no options are selected. Pressing the F/ key or the help
button shows the help for this window.

Message Settings Window

The SmartLinker Message Settings dialog box, shown in Figure 1.11, allows you to map
messages to a different message class.

Depending on the message class, messages are shown in different colors in the main
output area.

Each message has its own leading character (‘L’ for SmartLinker message) followed by a
4- or 5-digit number. This number allows an easy search for the message in both the
manual and on-line help.

A tab is available for each error message class: Disabled, Information, Error, Warning and
Fatal. To move a message from one class to another, highlight the message in the list box
on the left side, then click the button on the right that corresponds to the new message
class.

Figure 1.11 Message Settings Window
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The following table describes the message classes available in the SmartLinker Message
Settings dialog box.

d
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Table 1.6 Message Class Description

Message Class | Description Color

Disabled Lists all disabled messages. SmartLinker does not None
display these messages.

Information Lists all information messages. Information Green
messages inform about action taken by the
SmartLinker.

Warning Lists all warning messages. When such a message | Blue
is generated, linking of the input file continues and
an absolute file is generated.

Error Lists all error messages. When an error messageis | Red
generated, linking of the input file continues but no
absolute file is generated.

Fatal Lists all fatal error messages. When a fatal Dark Red
message is generated, linking of the input file stops
immediately. Fatal messages cannot be changed.
They are only listed to call context help.

Changing the Message Class

You can configure your own mapping of messages in the different classes using one of the
buttons located on the right side of the dialog box. Each button refers to a message class.
To change the class associated with a message, select the message in the list box and then
click the button associated with the class to which you want to move the message.

Example
To define the warning message L.1201: No stack defined as an error message:
¢ Click the Warning tab to display the list of all warning messages.
¢ Click on the string L1201: No stack defined in the list box to select the message.

* Click Error to define this message as an error message.

NOTE  Messages cannot be moved from or to the fatal error class.

NOTE  The Move to buttons are active only when all selected messages can be moved.
Selecting a message which cannot be moved to a specific group disables
(grays) the corresponding Move to button.
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To validate the modifications you have made in the error message mapping, close the
Message Settings dialog box with the OK button. If you close it using the Cancel button,
the previous message mapping remains valid.

To reset messages to their default, select the messages and click the Default button. To
reset all messages to the default, click the Reset All button.

About Dialog Box

Open the About SmartLinker dialog box by selecting the Help > About from the menu
bar.

The About SmartLinker dialog box contains extensive information. The main linker
version appears separately on top of the dialog box and the current directory and the
versions of subparts of the linker are shown.

In addition, the About SmartLinker dialog box contains all information needed to create

a permanent license. You can copy and paste the contents of the About SmartLinker
dialog box using standard Windows® commands.

Click OK to close the dialog box.

During a linking session, the versions of linker subparts cannot be requested. They are
displayed only when the linker currently is not processing.

Retrieving Information about an Error
Message

You can access information about each message displayed in the list box. Select the
message in the list box and then click Help button or the F/ key. An information box
opens, which contains a more detailed description of the error message as well as a small
example of code producing it. If you select several messages, help for the first is shown.
Pressing the F'1 key or the Help button when no message is selected shows the help for the
first message in the list box.

Specifying the Input File
There are different ways to specify the input file to link. During linking of a source file,

the options are set according to the dialog box configuration settings and the options
specified on the command line.

Before starting to link a file, make sure you have associated a working directory with your
linker. You can use the following methods to link an input file:

¢ Using the Command Line in the Toolbar to Link

¢ Using File > Link
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¢ Use Drag and Drop

Using the Command Line in the Toolbar to
Link

You can link the input files using the SmartLinker command line in the toolbar for,
Linking a New File and Linking a Previously Linked File.

Linking a New File

Enter the file name and additional SmartLinker options in the SmartLinker command
line in the toolbar. The specified file links as soon as you select the Link button in the
toolbar or press the Enter key.

Linking a Previously Linked File

To link a previously linked file in the SmartLinker command line:

1. Open the drop down menu in the SmartLinker command line to display the
previously executed commands.

2. Select a command by clicking on it.

3. Selected command appears in the SmartLinker command line.
4. Click the Link button in the toolbar to link specified file.

The specified file is linked.

Using File > Link
You can link an input file using File > Link, as stated below:

1. Select File > Link from the main window menu bar to display Select File to Link, a
standard open file dailog box with the list of all the prm files in the project directory.

2. Browse to get the name of the file you want to link.

3. Select the desired file.

4. Click Open in the Select File to Link dialog box to link the selected file.
The selected file is linked.

Use Drag and Drop

You can drag a file name from an external software (for example the File Manager/
Explorer) and drop it into the SmartLinker window. The dropped file links as soon as you
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release the mouse button in the SmartLinker window. If a file being dragged is a * . ini
file, it is considered a configuration file and loads immediately but does not link.

NOTE  To link a prm file with the extension * . in1i use one of the other methods. Do
not use drag and drop.

Message/Error Feedback

After linking there are several ways to check where different errors or warnings have been
detected. The following listing shows the default format of the error message.

Listing 1.1 Default Format of the Error Message

>>in <FileName>, line <line number>, col <column number>, pos
<absolute position in file>

<Portion of code generating the problem>

<message class><message number>: <Message string>

The following listing shows an example of error message.

Listing 1.2 Example Error Message

>> in "placemen\tstpla8.prm", line 23, col 0, pos 668
fpm_data_sec INTO MY_RAM2;

END

A

ERROR L1110: MY_RAM2 appears twice in PLACEMENT block

See also SmartLinker options for different message formats.

Use SmartLinker Window Information

Once you link a file, the SmartLinker window content area displays the list of all the errors
or warnings detected.

Use your usual editor to open the source file and correct the errors.

Using User-Defined Editor

You must first configure the editor for Error Feedback in the Editor Settings tab in the
Configuration dialog box. Error feedback performance varies, depending on whether you
can start the editor with a line number.
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Line Number Specified on Command Line

You can start an editor like WinEdit, V95 or higher, or Codewright with a line number in
the command line. When these editors are configured correctly, you can activate them
automatically by double clicking on an error message. The configured editor starts, the file
where the error occurred opens automatically, and places the cursor on the line where the
error was detected.

Line Number Cannot Be Specified on Command Line

An editor like WinEdit V3.1 or lower, Notepad, or Wordpad cannot be started with a line
number in the command line. When these editors are configured correctly, you can open
them automatically by double clicking on an error message. The configured editor starts
and the file where the error occurs opens automatically. To scroll to the position where the
error was detected:

1. Open the assembler again.

2. Click the line on which the message was generated. This highlights the line on the
screen.

3. Copy the line in the clipboard by pressing Ctrl + C.

4. Open the editor again.

5. Select Search > Find, the standard Find dialog box appears.

6. Copy the content of the clipboard in the Edit box by pressing Ctrl + V.
7. Click Forward to jump to the position where the error was detected.

The line with the error is highlighted in the editor.
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SmartLinker Files

This chapter describes the input and output files used by the SmartLinker.

¢ Input Files
* Output Files

Input Files

This section describes the input files used by the SmartLinker.

Parameter File

The linker takes any file as input; it does not require the file name to have a special
extension. However, we suggest that all your parameter file names have extension . prm.
The SmartLinker searches for the parameter file first in the project directory and then in
the directories enumerated in GENPATH (see GENPATH: Define Paths to Search for Input

Files). The parameter file must be a strict ASCII text file.

Object File

The link parameter file entry NAMES specifies the list of files to be linked. Specify
additional object files with the —~Add option (see -Add: Additional Object/Library File).

The linker looks for the object files first in the project directory, then in the directories
enumerated in OBJPATH (see OBJPATH: Object File Path) and finally in the directories
enumerated in GENPATH (see GENPATH: Define Paths to Search for Input Files). The
binary files must be valid Freescale, ELF\DWAREF 1.1 or 2.0 objects, absolute, or library
files.

Output Files

This section describes the output files used by the SmartLinker.
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Absolute Files

After a successful linking session, the SmartLinker generates an absolute file containing
the target code as well as some debugging information. The SmartLinker writes this file to
the directory given in the environment variable ABSPATH (see ABSPATH: Absolute
Path). If ABSPATH contains more than one path, SmartLinker writes the absolute file in
the first directory given; if ABSPATH is not set at all, SmartLinker writes the absolute file
in the directory in which the parameter file was found. Absolute files always get the
extension . abs.

S-Record Files

After a successful linking session, and if the -B option is present (see -B: Generate S-
Record file (Smartlinker)), the SmartLinker generates an S-Record file, which can be
burnt into an EPROM. This file contains information stored in all the READ_ONLY
sections in the application. The extension for the generated S-Record file depends on the
setting from the SRECORD variable (see SRECORD: S Record File Format).

¢ If SRECORD = S1, the S Record file gets the extension .s1.
e If SRECORD = S2, the S Record file gets the extension . s2.
¢ If SRECORD = S3, the S Record file gets the extension . s3.
* If SRECORD is not set, the S Record file gets the extension . sx.

The SmartLinker writes this file to the directory given in the ABSPATH environment
variable (see ABSPATH: Absolute Path). If ABSPATH contains more than one path, the
SmartLinker writes the S-record file in the first directory given; if ABSPATH is not set at
all, the SmartLinker writes the S-record file in the directory in which the parameter file
was found.

Map Files

After a successful linking session, the SmartLinker generates a map file containing
information about the link process. The SmartLinker writes this file to the directory given
in the TEXTPATH environment variable (see TEXTPATH: Text Path). If TEXTPATH
contains more than one path, SmartLinker writes the map file in the first directory given; if
TEXTPATH is not set at all, SmartLinker writes the map file in the directory in which the
parameter file was found. Map files always get the extension .map.

Dependency Information

The linker provides useful dependency information in the generated map file. The
dependency information shows which objects are used by other objects (functions,
variables, etc.).

62
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The dependency information in the linker map file is based on fixups/relocations. That is
if an object references another object by a relocation, the linker adds this object to the
dependency list.

Listing 2.1 Dependency Information Example

int hrs;
void tim(void) {
hrs = 0;

}

In timin the above example, the compiler has generated a fixup/relocation to the object
hrs, so the linker knows that t im uses hrs. For the next example, t im references tim
itself, because in tim there is a fixup to t im as well:

Listing 2.2 Dependency Information Example2

void tim(void) {
tim() ;

}

Now the compiler might perform a common code optimization, in which the compiler
collects common code into a function to reduce the code size.

NOTE  You can switch off this compiler common code optimization.

Listing 2.3 Dependency Information Example3

void tim(void) {
if (hrs == 3) hrs = 0;

if (hrs == 3) hrs = 0;

The compiler may optimize this to:

Listing 2.4 Dependency Information Example4

int tim(void) {
bsr tim:Label:

tim_Label:
if (hrs == 3) hrs = 0;
return;
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Here the compiler generates a local branch inside t im to a local subroutine. This produces
a relocation/fixup into tim, that is, for the linker, t im references itself.

Error Listing File

If the SmartLinker detects any errors, it creates an error listing file instead of an absolute
file. The SmartLinker generates this file into the directory in which the source file was
found (see ERRORFILE: Error File Name Specification).

If the SmartLinker window is open, it displays the full path of all binary files read. In case
of error, the position and file name where the error occurs appears in the SmartLinker
window.

If you started the SmartLinker from WinEdit (with $ £ given on the SmartLinker
command line) or Codewright (with $b%e given on the SmartLinker command line),
SmartLinker does not generate this error file. Instead it writes the error messages in a
special format into a file called EDOUT, using the Microsoft format by default. Use
WinEdit’s Next Error or Codewright’s Find Next Error command to see both error
positions and the error messages.

Interactive Mode (SmartLinker Window Open)

If ERRORFILE is set, the SmartLinker creates a message file named as specified in this
environment variable. If ERRORFILE is not set, the SmartLinker generates a default file
named ERR . TXT in the current directory.

Batch Mode (SmartLinker Window Not Open)

If ERRORFILE is set, the SmartLinker creates a message file named as specified in this
environment variable. If ERRORFILE is not set, the SmartLinker generates a default file
named EDOUT in the current directory.
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Figure 2.1 Error File Creation
prm | 1. current dir ‘g 1. current dir
2. GENPATH “|ib” 2. OBJPATH
“abg” | 3. GENPATH
SmartLinker
ERRORFILE
ERR.TXT
abs | 1. /SL\BSPAT'!;' . | map | 1- TEXTPATH
.sx | 2. Source file pat 2. Source file path or
EDOUT
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Object Allocation

This chapter describes the whole object allocation PLACEMENT Block.

The SEGMENTS Block (ELF)

The SEGMENTS Block is optional. It increases the readability of the linker input file and

allows you to assign meaningful names to contiguous memory areas on the target board.

Memory within such an area shares common attributes:
* Segment Qualifier
* Segment Alignment
* Segment Fill Pattern
You can define two types of segments:
* Physical Segments
* Virtual Segments

Physical Segments

Physical segments are closely related to hardware memory areas.

For example, there may be one READ_ONLY segment for each bank of the target board
ROM area and another segment covering the whole target board RAM area.

For a simple memory model, you can define a segment for the RAM area and another

segment for the ROM area.

Listing 3.1 Physical Segments Example

LINK test.abs
NAMES test.o startup.o END

SEGMENTS
RAM_AREA = READ_WRITE 0x00000 TO OxO07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
END

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual

67



3
4

y
A
Linking Issues
Object Allocation
PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END

STACKSIZE 0x50

For banked memory model you can define a segment for the RAM area, another for the
non-banked ROM area and one for each target processor bank.

Listing 3.2 Physical Segments Example 2

LINK test.abs
NAMES test.o startup.o END

SEGMENTS
RAM_ AREA = READ_WRITE 0x00000 TO Ox07FFF;
NON_BANKED_AREA = READ_ONLY 0x0C000 TO OxOFFFF;
BANKO_AREA = READ_ONLY 0x08000 TO OxOBFFF;
BANK1_AREA = READ_ONLY 0x18000 TO Ox1BFFF;
BANK2_AREA = READ_ONLY 0x28000 TO Ox2BFFF;
END
PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
_PRESTART, STARTUP,
ROM_VAR,
NON_BANKED, COPY INTO NON_BANKED_ AREA;
DEFAULT_ROM INTO BANKO AREA, BANK1 AREA,
BANK2_AREA;
END

STACKSIZE 0x50

Virtual Segments

You can split a physical segment into several virtual segments, allowing a better
structuring of object allocation and allowing you to use some processor-specific
properties.

Considering a small memory model, you can define a segment for the direct page area,
another one for the rest of the RAM area, and another one for the ROM area.

Listing 3.3 Virtual Segment Example

LINK test.abs
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NAMES test.o startup.o END

SEGMENTS
DIRECT_RAM
RAM_AREA
ROM_AREA

END

PLACEMENT
myRegister
DEFAULT_RAM
DEFAULT_ROM

END

STACKSIZE 0x50

READ_WRITE 0x00000 TO 0xOOOFF;
READ_WRITE 0x00100 TO OxQ7FFF;
READ_ONLY 0x08000 TO OxOFFFF;

INTO DIRECT_RAM;
INTO RAM_AREA;
INTO ROM_AREA;

Segment Qualifier

Different qualifiers are available for segments. The following table describes the available

qualifiers:

Table 3.1 Qualifiers and Descriptions

Qualifier

Description

READ_ONLY

Qualifies a segment that allow only read access. Initializes objects
within the segment at application loading time.

READ_WRITE

Qualifies a segment that allows both read and write accesses.
Initializes objects within such a segment at application startup.

NO_INIT

Qualifies a segment that allows both read and write accesses.
Obijects within such a segment remain unchanged during application
startup. This qualifier may be used for segments referring to a battery-
backed RAM. Sections placed in a NO_INIT segment should not
contain any initialized variables (variable defined as int ¢ = 8).

PAGED

Qualifies a segment that allows both read and write accesses.
Obijects within such a segment remain unchanged during application
startup. Additionally, objects located in two PAGED segments may
overlap. This qualifier is used for memory areas that require some
user-defined page-switching mechanism. Sections placed in a
PAGED segment should not contain any initialized variables (variable
defined as int ¢ = 8).
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NOTE

NOTE

NOTE

For debugging purposes you may want to load code into RAM areas. Because
this code should be loaded at load time, qualify such areas as READ_ONLY. For
the linker, READ_ ONLY means that such objects are initialized at program load
time. The linker does not know (and does not care) if at runtime the target code
writes to a READ_ ONLY area.

Anything located in a READ_WRITE segment is initialized at application
startup time. Locate the application code which does this initialization and any
initialization data (init, zero out, copy down) in a READ_ONLY section. Do not
locate the application code and the initialization data in a READ_WRITE
section. The program loader can, at program loading time, write the content of
READ_ONLY sections into a RAM area.

If an application does not use any startup code to initialize READ_WRITE
sections, then no such sections should be present in the prm file. Instead use
NO_INIT sections.

Segment Alignment

The default alignment rule depends on the processor and memory model used. You can
define your own alignment rule for a segment. The alignment rule defined for a segment
block overrides the default alignment rules associated with the processor and memory

model.

The alignment rule has the following format (see Table 3.2 for format information):

[defaultAlignment] {“[“ObjSizeRange”:”alignment”]”}
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Table 3.2 Segment Alignment Format

Format Type

Definition

defaultAlignment

Alignment value for all objects which do not match the conditions of
any range defined afterward.

ObjSizeRange

Defines a certain condition. The condition follows the form:

* size: Applies to objects whose size is equal to size.
* < size: Applies to objects whose size is less than size.

* > size: Applies to objects whose size is greater than
size.

* <= size: Applies to objects whose size is less than or
equal to size.

* >= size: Applies to objects whose size is greater than or
equal to size

* From sizel to size2: Applies to objects whose size is
greater than or equal to sizel and less than or equal to
size2.

alignment

Defines the alignment value for objects matching the condition
defined in the current alignment block (enclosed in square bracket).

Listing 3.4 Segment Alignment Example

LINK test.abs

NAMES test.o startup.o END

SEGMENTS
DIRECT_RAM = READ_WRITE 0x00000 TO 0xO0O0OFF
ALIGN 2 [< 2: 1];
RAM_AREA = READ_WRITE 0x00100 TO 0x07FFF
ALIGN [1:1] [2..3:2] [>=4:47;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
END
PLACEMENT
myRegister INTO DIRECT_RAM;

DEFAULT_RAM
DEFAULT_ROM
END

STACKSIZE 0x50

INTO RAM AREA;
INTO ROM_AREA;

The example above:
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¢ Aligns objects in the DIRECT_RAM segment whose size is 1 byte on byte
boundaries; aligns all other objects on 2-byte boundaries.

* Aligns objects in the RAM_AREA segment whose size is 1 byte on byte boundaries;
aligns objects whose size is equal to 2 or 3 bytes on 2-byte boundaries; aligns all
other objects on 4-byte boundaries.

¢ Default alignment rules apply in the ROM_AREA segment.

Segment Fill Pattern

The default fill pattern for code and data segment is the null character. You can choose to
define your own fill pattern for a segment. The fill pattern definition in the segment block
overrides the default fill pattern.

NOTE  The fill pattern is used to fill up a segment to the segment end boundary.

Listing 3.5 Segment Fill Pattern Example

LINK test.abs
NAMES test.o startup.o END

SEGMENTS
DIRECT RAM = READ WRITE 0x00000 TO 0x000FF
FILL OxAA;
RAM _AREA = READ WRITE 0x00100 TO O0x07FFF
FILL 0x22;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
END
PLACEMENT
myRegister INTO DIRECT RAM;
DEFAULT_ RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END

STACKSIZE 0x50

The example above:
* Initializes alignment bytes between objects in DIRECT_RAM segment with 0xAA.
* Initializes alignment bytes between objects in RAM_AREA segment with 0x22.

« Initializes alignment bytes between objects in ROM_AREA segment with 0x00.
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The SECTIONS Block (Freescale + ELF)

The segments block is optional but increases the readability of the linker input file. It
allows you to assign meaningful names to contiguous memory areas on the target board.
Memory within such an area share the Segment Qualifier attribute:

Two types of segments can be defined:

¢ Physical Segments
¢ Virtual Segments

Physical Segments

Physical segments are closely related to hardware memory areas. For example, there may
be one READ_ONLY segment for each bank of the target board ROM area and another one
covering the whole target board RAM area.

For a simple memory model you can define a segment for the RAM area and another one
for the ROM area.

Listing 3.6 Physical Segments Example1

LINK test.abs
NAMES test.o startup.o END

SECTIONS
RAM_AREA = READ_WRITE 0x00000 TO OxQ07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;

PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END

STACKSIZE 0x50

For banked memory model you can define a segment for the RAM area, another for the
non-banked ROM area and one for each target processor bank.

Listing 3.7 Physical Segments Example2

LINK test.abs
NAMES test.o startup.o END

SECTIONS
RAM_AREA READ_WRITE 0x00000 TO OxO7FFF;
NON_BANKED_AREA = READ_ONLY 0x0C000 TO OxOFFFF;
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BANKO_AREA = READ_ONLY 0x08000 TO OxOBFFF;
BANK1_AREA READ_ONLY 0x18000 TO Ox1BFFF;
BANK2_AREA READ_ONLY 0x28000 TO Ox2BFFF;

PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
_PRESTART, STARTUP,
ROM_VAR,
NON_BANKED, COPY INTO NON_BANKED_AREA;
DEFAULT_ROM INTO BANKO_AREA, BANK1_AREA,
BANK2_AREA;
END

STACKSIZE 0x50

Virtual Segments

A physical segment may be split into several virtual segments, allowing better structuring
of object allocation and also allowing the user to take advantage of some processor-
specific properties.

Considering a small memory model, you can define a segment for the direct page area,
another for the rest of the RAM area and another for the ROM area.

Listing 3.8 Virtual Segment Example

LINK test.abs
NAMES test.o startup.o END

SECTIONS
DIRECT_RAM = READ_WRITE 0x00000 TO Ox00OFF;

RAM_AREA = READ _WRITE 0x00100 TO O0x07FFF;
ROM_AREA = READ ONLY 0x08000 TO OxOFFFF;
PLACEMENT
myRegister INTO DIRECT RAM;
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END

STACKSIZE 0x50

Segment Qualifier

The following table describes the available segment qualifiers.
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Table 3.3 Qualifiers and Descriptions

Qualifier Meaning

READ_ONLY Qualifies a segment that allows only read accesses. Initializes objects

within such a segment at application loading time.

CODE ELF Qualifies a code segment in a Harvard architecture in the ELF object
only)

file format. For cores with Von Neumann Architecture (combined code
and data address space), or for the Freescale object file format, use
READ_ONLY instead.

READ_WRITE Qualifies a segment that allows read and write accesses. Initializes

objects within such a segment at application startup.

NO_INIT

Qualifies a segment that allows read and write accesses. Objects
within such a segment remain unchanged during application startup.
This qualifier may be used for segments referring to a battery-backed
RAM. Sections placed in a NO_INIT segment should not contain any
initialized variables (variable defined as int ¢ = 8).

PAGED

Qualifies a segment that allows read and write accesses. Objects
within such a segment remain unchanged during application startup.
Additionally, objects located in two PAGED segments may overlap.
This qualifier is used for memory areas, where some user-defined
page-switching mechanism is required. Sections placed in a PAGED
segment should not contain any initialized variables (variable defined
as int c = 8).

NOTE

NOTE

For debugging purposes, you may want to load code into RAM areas. Because
this code is loaded at load time, qualify such areas as READ_ONLY. For the
linker, READ_ONLY means that such objects are initialized at program load
time. The linker does not know (and does not care) if at runtime the target code
writes to a READ_ONLY area.

Anything located in a READ_ WRITE segment is initialized at application
startup time. Locate the application code which does this initialization and any
initialization data (init, zero out, copy down) in a READ_ONLY section. Do not
locate the application code and the initialization data in a READ_WRITE
section. The program loader can, at program loading time, write the content of
READ_ONLY sections into a RAM area.
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NOTE  If an application does not use any startup code to initialize READ_WRITE
sections, then no such sections should be present in the prm file. Instead use
NO_INIT sections.

PLACEMENT Block

The PLACEMENT block allows the user to physically place each section from the
application in a specific memory area (segment). The sections specified in a PLACEMENT
block may be linker-predefined sections or user sections specified in one of the source file
building the application.

Organize data into sections:
 Increases application structuring
¢ Groups common-purpose data together

» Takes advantage of target processor-specific addressing mode

Specifying a List of Sections

When you specify several sections on a PLACEMENT statement, the linker allocates the
sections in the order you specify.

Listing 3.9 Sequence Enumeration Example

LINK test.abs
NAMES test.o startup.o END

SECTIONS
RAM_AREA = READ_WRITE 0x00100 TO O0x002FF;
STK_AREA = READ_WRITE 0x00300 TO O0xO003FF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
PLACEMENT
DEFAULT_RAM, dataSecl,
dataSec?2 INTO RAM_AREA;
DEFAULT_ROM, myCode INTO ROM_AREA;
SSTACK INTO STK_AREA;
END

In this example:

* Inside the RAM_AREA segment, the linker allocates the objects defined in the . data
section first, then the objects defined in dataSec1 section, then objects defined in
dataSec?2 section.
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* Inside the ROM_AREA segment, the linker allocates objects defined in . text
section first, then the objects defined in section myCode.

NOTE Since the linker is case sensitive, the name of the section names specified in the
PLACEMENT block must be valid predefined or user-defined section names.
For the linker, DataSec1 and dataSec1 are two different sections.

Specifying a List of Segments

When you specify several segments in a PLACEMENT statement, the segments are used in
the order they are listed. The linker performs allocation in the first segment in the list until
this segment is full. Then allocation continues on the next segment in the list, and so on,
until all objects are allocated.

Listing 3.10 Sequence Enumeration - Further Example

LINK test.abs
NAMES test.o startup.o END

SECTIONS
RAM_AREA = READ_WRITE 0x00100 TO O0x002FF;
STK_AREA = READ_WRITE 0x00300 TO O0x003FF;
NON_BANKED_AREA = READ ONLY 0x0C000 TO OxOFFFF;
BANKO_AREA = READ_ONLY 0x08000 TO OxOBFFF;
BANK1_AREA = READ_ONLY 0x18000 TO Ox1BFFF;
BANK2_AREA = READ_ONLY 0x28000 TO Ox2BFFF;
PLACEMENT
DEFAULT RAM INTO RAM AREA;
SSTACK INTO STK_AREA;
_PRESTART, STARTUP,
ROM_VAR,
NON_BANKED, COPY  INTO NON_BANKED AREA;
DEFAULT_ROM INTO BANKO AREA, BANK1 AREA,

BANK2_AREA;
MY_SECTION INTO BANKO_AREA;
END

This example allocates functions implemented in the . text section first, into segment
BANKO_AREA. When there is not enough memory available in this segment, allocation
continues in segment BANK1_AREA, then in BANK2_AREA . After . text section
allocation to BANKO_AREA segment, MY_SECTION section objects are allocated to
remainder memory of BANKO_AREA segment.
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NOTE  As the linker is case sensitive, the name of the segments specified in the

PLACEMENT block must be valid segment names defined in the SEGMENTS
block. For the linker, Ram_Area and RAM_AREA are two different segments.

Allocating User-Defined Sections (ELF)

All sections do not need to be enumerated in the placement block. Segment allocation of
sections which do not appear in the PLACEMENT Block depends on the section type.

Sections containing data are allocated next to the . data section.

Sections containing code, constant variables or string constants are allocated next to
the section . text.

Allocation in the segment where . data is placed occurs as follows:

Allocates objects from .data section

Allocates objects from section .bss (if .bss is not specified in the PLACEMENT
block).

Allocates objects from the first user-defined data section not specified in the
PLACEMENT block.

Allocates objects from the next user-defined data section not specified in the
PLACEMENT block. (This continues until all user-defined data sections are
allocated.)

If the section . stack is not specified in the PLACEMENT block and is defined with
a STACKSIZE command, the stack is allocated then.

Figure 3.1 User-Defined Sections (.stack)

.data

User Data 1

.bss

‘ User Diata n ‘ stack ‘

Allocation in the segment where . text is placed occurs as follows:

Allocates objects from . init section (if . init is unspecified in the PLACEMENT
block).

Allocates objects from . startData section (if . startData is unspecified in the
PLACEMENT block).

Allocates objects from . text section.

Allocates objects from . rodata section (if . rodata is unspecified in the
PLACEMENT block).
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* Allocates objects from . rodatal section (if . rodatal is unspecified in the
PLACEMENT block).

* Allocates objects from the first user-defined code section which is unspecified in the
PLACEMENT block.

* Allocates objects from the next user defined code section, which is unspecified in the
PLACEMENT block. (This continues until all user defined code sections are
allocated.)

¢ Allocates objects from . copy section (if . copy is unspecified in the PLACEMENT
block).

Figure 3.2 User-Defined Sections (.txt)

.nit |.startData | .text User Coded

rodata Irodatm

. ‘ User Code n

Copy ‘

Allocating User-Defined Sections (Freescale)

All sections do not need to be enumerated in the placement block. The segments where
sections, which do not appear in the PLACEMENT block, are allocated depends on the type
and attributes of the section. The Linker allocates these segments as follows:

* Sections containing code next to the DEFAULT_ROM section.

¢ Sections containing constants only next to the DEFAULT_ROM section. Change this
behavior using the ~CRam option (see -CRam: Allocate Non-specified Constant

Segments in RAM (ELF)).

* Sections containing string constants next to the DEFAULT_ROM section.

* Sections containing data next to the section DEFAULT _RAM.
Allocation in the segment where DEFAULT_RAM is placed occurs as follows:
* Allocates objects from DEFAULT_RAM section

 If the ~-CRam option is specified, allocates objects from ROM_VAR section, unless
ROM_VAR is mentioned in the PLACEMENT block.

 Allocates objects from user-defined data sections, which are not specified in the
PLACEMENT block. If ~-CRam option is specified, allocates constant sections
together with non-constant data sections.

 If the SSTACK section is not specified in the PLACEMENT block and is defined with
a STACKSIZE command, allocates the stack then.
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Figure 3.3 User Defined Sections (DEFAULT_RAM)

DEFAULT_RAM User Data 1 ‘ ‘ Usler Data n ‘ SSTACK ‘

Allocation in the segment where DEFAULT_ROM is placed occurs as follows:

Allocates objects from _ PRESTART section (if _PRESTART is not specified in the
PLACEMENT block).

Allocates objects from STARTUP section (if STARTUP is not specified in the
PLACEMENT block).

Allocates objects from ROM_VAR section (if ROM_VAR is not specified in the
PLACEMENT block). If -CRam option is specified, allocates ROM_VAR in the RAM.

Allocates objects from SSTRING (string constants) section (if SSTRING is not
specified in the PLACEMENT block).

Allocates objects from DEFAULT_ROM section

Allocates objects from all user-defined code sections and constant data sections,
which are not specified in the PLACEMENT block.

Allocates objects from COPY section (if . copy is not specified in the PLACEMENT
block).

Figure 3.4 User Defined Sections (DEFAULT_ROM)

PRESTART

STARTUP [ROM_VAR| SSTRING|DEFALLT _ROM|User Code 1 User Code n| COPY

Initializing Vector Table

Use the VECTOR command to perform vector table initialization.

VECTOR Command

This command is specially defined to initialize the vector table.
Use the syntax:
VECTOR <Number>

In this case, the linker allocates the vector depending on the target CPU. The vector
number zero is usually the reset vector, but depends on the target. The linker contains the
default start location of the vector table for each target supported.

You can also use the syntax:

VECTOR ADDRESS
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The size of the entries in the vector table depend on the target processor.

The following table describes the VECTOR command syntax.

Table 3.4 VECTOR Command Syntax and Descriptions

Command Description

VECTOR ADDRESS OxXFFFE Indicates that the value 0x1000 must be stored

0x1000 at address 0xFFFE

VECTOR ADDRESS OxXFFFE Indicates that the address of the function FName

FName must be stored at address 0xFFFE.

VECTOR ADDRESS OxXFFFE Indicates that the address of the function FName

FName OFFSET 2 incremented by 2 must be stored at address
OxXFFFE

The last syntax may be very useful when working with a common interrupt service
routine.

Smart Linking (ELF)

Because of smart linking, only the objects referenced are linked with the application. The
application entry points are:

* The application init function
e The main function
* The function specified in a VECTOR command

Smart linking automatically links all previously enumerated entry points and the objects
they referenced with the application.

You can specify additional entry points using the ENTRIES command (see ENTRIES:
List of Objects to Link with Application) in the prm file.

Mandatory Linking of an Object

You can choose to link some non-referenced objects in this application. This may be
useful for ensuring that a software version number is linked with the application and
stored in the final product EPROM.

This may also be useful for ensuring that a vector table which has been defined as a
constant table of function pointers, is linked with the application.
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Listing 3.11 Mandatory Linking of an Object Example

ENTRIES

myVarl myVar2 myProcl myProc2
END

This example specifies the variables myVarl and myVar2 as well as the function
myProcl and myProc?2 as additional entry points in the application.

NOTE  As the linker is case sensitive, the name of the objects specified in the
ENTRIES block must be objects defined somewhere in the application. For the
linker, MyVarl and myVarl are two different objects.

Mandatory Linking of all Objects Defined
in Object File

You can choose to link all objects defined in a specified object file in your application.

Listing 3.12 Mandatory Linking from All Objects Example

ENTRIES
myFilel.o:* myFile2.o0:*
END

This example specifies all the objects (functions, variables, constant variables or string

constants) defined in file myFilel.o and myFile2 .o as additional entry points in the
application.

Switching OFF Smart Linking for the
Application

You can choose to switch OFF smart linking. All objects are linked in the application.

Listing 3.13 Switching Off SmartLinking Example

ENTRIES

*

END

This example switches OFF smart linking for the whole application. That means that all
objects defined in one of the binary files building the application are linked with the
application.
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Smart Linking (Freescale + ELF)

Because of smart linking, only the objects referenced are linked with the application. The
application entry points are:

* The application init function
* The main function
* The function specified in a VECTOR command.

The SmartLinker automatically links all previously enumerated entry points and the
objects they referenced with the application.

You can specify additional entry points using the ENTRIES command (see ENTRIES:
List of Objects to Link with Application) in the prm file.

Mandatory Linking from an Object

You can choose to link some non-referenced objects in your application. This may be
useful for ensuring that a software version number is linked with the application and
stored in the final product EPROM.

This may also be useful for ensuring that a vector table, which has been defined as a
constant table of function pointers, is linked with the application.

Listing 3.14 Mandatory Linking from an Object Example
ENTRIES
myVarl myVar2 myProcl myProc2

END

The example above specifies the variables myVarl and myVar?2 as well as the function
myProcl and myProc2 as additional entry points in the application

NOTE  As the linker is case sensitive, the name of the objects specified in the
ENTRIES block must be objects defined somewhere in the application. For the
linker, MyVarl and myVarl are two different objects.

Mandatory Linking from all Objects
Defined in a File

You can choose to link all objects defined in a specified object file in your application. For
that purpose, you need only to specify a plus ( + ) sign after the name of the module in the
NAMES block.
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Listing 3.15 Mandatory Linking from All Objects Example:

NAMES

myFilel.o+ myFile2.o0+ start.o ansi.lib

END

This example specifies all the objects (functions, variables, constant variables or string
constants) defined in file myFilel.o and myFile2. o as additional entry points in the
application.

Binary Files Building an Application (ELF)

You can specify the names of the binary files building an application in the NAMES block
or in the ENTRIES block. Usually a NAMES block is sufficient.

NAMES Block

Usually you list all the binary files building the application in the NAMES block. You may
specify additional binary files using the -Add option (see -Add: Additional Object/
Library File). If you specify all binary files by the command line option —add, then you
must specify an empty NAMES block (just NAMES END).

Listing 3.16 Names Block Example

NAMES

myFilel.o myFile2.o

END

In this example, the binary filesmyFilel.o and myFile2. o build the application.

ENTRIES Block

If you specify a file name in the ENTRIES block, the linker considers the corresponding
file as part of the application, even if it does not appear in the NAMES block. The file
specified in the ENTRIES block may also be present in the NAMES block. Names from
absolute, ROM library, or library files are not allowed in the ENTRIES block.

Listing 3.17 Entries Block Example

LINK test.abs
NAMES test.o startup.o END

SEGMENTS
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DIRECT_RAM = READ_WRITE 0x00000 TO OxOOOFF;

STK_AREA = READ_WRITE 0x00200 TO O0x002FF;
RAM AREA = READ_WRITE 0x00300 TO OxO07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
END
PLACEMENT
myRegister INTO DIRECT_RAM;
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
SSTACK INTO STK_AREA;
END
ENTRIES
testl.o:* test.o:*
END

In this example, the file test .o, testl.oand startup. o build the application. All
objects defined in the module testl. o and test. o will be linked with the application.

Binary Files Building an Application
(Freescale)

You may specify the names of the binary files building an application in the NAMES block
or in the ENTRIES block. Usually a NAMES block is sufficient.

NAMES Block

Usually you list all the binary files building the application in the NAMES block. You may
specify additional binary files using the -Add option. If you specify all binary files using
the command line option -Add, then you must specify an empty NAMES block (just
NAMES END).

Listing 3.18 Names Block Example

NAMES
myFilel.o myFile2.o
END

In this example, the binary filesmyFilel.o and myFile2. o build the application.
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Alloca

Listing 3.19

ting Variables in OVERLAYS

When your application consists of two distinct parts (or execution units) which never runs
at the same time, you can use the linker to overlap the global variables of both parts. To do
this in your application source files, you must:

¢ Define the global variable from the different parts in separate data segments. Do not
use the same segment for both execution units.

 Initialize the global variables in both execution units using assignments in the
application source code. Do not define global variables with the initializer.

In the prm file, you can then define two distinct memory areas with attribute PAGED.
Memory areas with PAGED attributes are not initialized during startup. For this reason
they cannot contain any variable defined with the initializer. The linker will not perform
any overlap check on PAGED memory areas.

The example shown in Listing 3.19 illustrates this.
In your source code support you have APPL_1 and APPL_ 2, as two execution units :
* All global variables from APPL_1 are defined in segment APPL1_DATA_SEG

¢ All global variables from APPL_2 are defined in segment DEFAULT_RAM and
APPL2_DATA_SEG

The prm file looks as follows:

.prm File Example

LINK test.

NAMES tes

abs

t.o appll.o appl2.0 startup.o END

SECTIONS
MY _ROM = READ_ONLY 0x800 TO Ox9FF;
MY _RAM 1 = PAGED 0xA00 TO OxAff;
MY RAM 2 = PAGED 0xA00 TO OxAff;
MY_STK = READ_WRITE 0xB0O0 TO OxBFF;
PLACEMENT
DEFAULT_ROM INTO MY_ROM;

DEFAULT_RAM,

APPL2_

APPL1_.

SSTACK
PAGED memo
END

DATA_SEG INTO MY _RAM 2;
DATA_SEG INTO MY RAM 1;

INTO MY_STK; /* Stack cannot be allocated in a
ry area. */
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Overlapping Locals

This section is only for targets which handle allocated local variables like global variables
at fixed addresses.

Some small targets do not have a stack for local variables, so the compiler uses pseudo-
static objects for local variables. In contrast to other targets which allocate such variables
on the stack, the linker must allocate these variables. On the stack, multiple local variables
are automatically allocated at the same address at different times. The linker implements a
similar overlapping scheme to save memory for local variables.

Listing 3.20 Overlapping Locals Example

void f(void) { long fa; ....; }
void g(void) { long ga; ....; }
void main(void) { long 1lm; f£(); g(); }

In this example, the functions £ and g are never active at the same time, therefore the local
variables fa and ga can be allocated at the same address.

NOTE  When local variables are allocated at fixed addresses, the resulting code is not
reentrant. Each function must be called only once. Take special care with
interrupt functions: they must not call any function which might be active at the
interrupt time. To be on the safe side, interrupt functions usually use a different
set of functions than non-interrupt functions.

NOTE  To the linker, parameter and spill objects are the same as local variables. All
these objects are allocated together.

The linker analyzes the call graph of one root function at a time and allocates all local
variables used by all dependent functions at this time. Variables depending on different
root functions are allocated non-overlapping except in the case of an OVERLAP_GROUP
(ELF).

Algorithm
The algorithm for the overlap allocation is quite simple:
1. If current object depends on other objects, first allocate the dependents.

2. Calculate the maximum address used by any dependent object. If none exist, use the
base reserved for the current root.

3. Allocate all locals starting at the maximum.
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This algorithm is called for all roots. The base of the root is first calculated as the
maximum used so far.

Listing 3.21 Algorithm Example

void g(long g _par) { }
void h(long 1_par) {1}
void main(void) {

char ch;

void interrupt 1 inter (void) {
long inter_loc;

}

The function main is a root because it is the application main function and inter isa
root because it is called by an interrupt.

Listing 3.22 Algorithm Object File Format

SECTTONS
. ‘(.)VERLAP_RAM = NO_INIT 0x0060 TO 0x0068;
];’I.,ACEMENT

‘ _OVERLAP INTO OVERLAP_RAM;

END

NOTE In the ELF object file format the name _ OVERLAP is a synonym for the
.overlap segment.

Table 3.5 Algorithm Object File Format

0x60 0x61 0x62 0x63 0x64 0x65 0x66 0x67 0x68

g_par ch inter_loc

|_par
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main starts the algorithm. As h and g depend on main, their parameters g_par and
1_par are allocated starting at address 0x60 in the _ OVERLAP segment. Next the local
ch s allocated at 0x64 because all lower addresses are already used by dependents. After
main finishes, the base for the second root is calculated as 0x65, where inter_loc is
also allocated.

The following items are considered as root points for the overlapping allocation in the
ELF object file format:

¢ Objects specified in a DEPENDENCY ROOT block
* Objects specified in a OVERLAP_GROUP block

¢ Application main function (specified with prm file entry MAIN) and application entry
point (specified with prm file entry INIT)

* Objects specified in a ENTRIES block
¢ Absolute objects
¢ Interrupt vectors

* All objects in non-SmartLinked object files

NOTE  The main function (main) and the application entry point (_Startup) are
implicitly defined as one OVERLAP_GROUP. In the startup code delivered
with the compiler, this saves about 8 bytes because the locals of Init, Copy,
and main overlap. When _Startup itself changes, it needs locals which
must be active over the call to main. Define the _Startup function as a
single entry in an OVERLAP_GROUP: OVERLAP_GROUP _Startup END

The overlap _ OVERLAP section (in ELF, this is also named .overlap) mustbe
allocated in a NO_INIT area. The _OVERLAP section cannot be split into several areas.

Name Mangling for Overlapping Locals

When parameters are passed on the stack, the linker performs caller and callee
argument matching by their stack position. For overlapped locals (which include
parameters not passed in registers as well), the linker does the matching using the
parameter name.

Consider the following example:

Listing 3.23 Name Mangling for Overlapping Locals Example

void callee(long 1i);

void caller (void) {
callee (1) ;

}

void callee(long k) {
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The name i of the callee declaration does not match the name used in the definition.
Actually, the declaration might not specify a name at all. Since the link between the
caller and callee argument uses the name, both must use the same name. Because of
this, the compiler generates an artificial name for the callee’s parameter: _calleepO.
The compiler builds this name starting with an underscore ( _ ), appending the function
name, appending a p and finally the argument number.

NOTE InELF, there is a second name mangling needed to encode the name of the
defining function into its name (see Name Mangling in ELF Object File
Format).

Compiler users do not need to know about the name mangling at all. The compiler does it
for them automatically.

However, to write functions with overlapping locals in assembler, you must do the name
mangling yourself. This is especially important if you are calling C functions from
assembler code or assembler functions from C code.

Name Mangling in ELF Object File Format

The ELF Object File Format has no predefined way to specify the function to which an
actual parameter belongs, so the compiler does some special name mangling. This adds
the function name into the link time name.

In ELF, the name is built the following way:

« If the object is a function parameter, use a p followed by the argument number,
instead of the object name given in the source file.

¢ Add the prefix __ OVL_

¢ If the function name contains a underscore ( _ ), add the number of characters of the
function name followed by a underscore ( _ ). Add nothing if the function name does
not contain an underscore.

¢ Add the function name.
¢ Add an underscore ( _ ).

¢ If the object name contains a underscore ( _ ), add the number of characters of the
object, followed by one underscore ( _ ). Add nothing if the object name does not
contain an underscore.

* Add the object name.

The following listing shows an ELF example.
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Listing 3.24 ELF Example

void f(long p) {
char a;
char b_c;

}

This generates the following mangled names, as shown in the following listing:

Listing 3.25 Output Generated

p: "__OVL_f_pO" (HIWARE format: "_fpO")
a: " OVL_f_a" (HIWARE format: "a")
b _c: " OVL_f_3_b_c¢" (HIWARE format: "b_c")

Defining a Function with Overlapping
Parameters in Assembler

This section covers advanced topics which are important only if you plan to write
assembler functions using a C calling convention with overlapping parameters.

For example, to define the callee function:

Listing 3.26 Defining Callee Function Example

void callee(long k) {
k= 0;
}

In assembler, we must first define the parameter with its mangled name. The parameter
must be in the _OVERLAP section:

Listing 3.27 Defining Parameter Example

_OVERLAP: SECTION
callee_pl: DS 4

NOTE  The _OVERLAP section is often allocated in a short segment. If so, use
_OVERLAP: SECTION SHORT to specify this.

Next, define the function itself:
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Listing 3.28 Defining Function Example

callee_code: SECTION
callee:
CLEAR callee_pl,4
RETURN

To avoid processor-specific examples, we assume that there is an assembler macro
CLEAR which writes as many zero bytes as its second argument to the address specified
by its first argument. The second macro RETURN generates a return instruction for the
processor used. The implementation of these two macros are processor specific and not
contained in this linker manual.

Finally, export the callee and its argument:

Listing 3.29 Exporting callee Example

XDEF callee
XDEF callee_pl

The following listing shows the whole example in one block.

Listing 3.30 Defining a Function with Overlapping Parameters in Assembler Example

;Processor specific macro definition, please adapt to your target
CLEAR: MACRO

ENDM

RETURN : MACRO
ENDM

_OVERLAP: SECTION

callee_pl: DS 4

callee_code: SECTION

callee:
CLEAR callee_pl, 4
RETURN

; export function and parameter
XDEF callee
XDEF callee_pl
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Additional Points to Consider

In the ELF format, the name of the p1 parameter must be _OVL_callee_pl instead of
callee_pl.

The following listing shows an example for ELF.

Listing 3.31 ELF Example

_OVERLAP: SECTION
_OVL_callee_pl: DS 4

callee_code: SECTION
callee:
CLEAR _OVL_callee_pl,4
RETURN
; export function and parameter
XDEF callee
XDEF _OVL_callee_pl

Put every function defined in assembler in a separate section, as a linker section
containing code corresponds to a compiler function.

The following listing shows an example of two functions in one segment.

Listing 3.32 Two Functions in One Segment Example

XDEF calleeO
XDEF calleel

_OVERLAP: SECTION
locO: DS 4
locl: DS 4

code_seg: SECTION

callee0:
CLEAR locO0,4
RETURN
calleel: ; ERROR function should be in separate segment
CLEAR locl,4
RETURN

Because callee0 and calleel are in the same segment, the linker treats them as if
they were two entry points of the same function. This prevents 1oc0 and 1ocl from
overlapping and generating additional dependencies.

To correct the problem, put the two functions into separate segments, as shown in the
following listing:
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Listing 3.33 Two Functions in Seperate Segment Example

XDEF calleeO
XDEF calleel

_OVERLAP: SECTION
locO: DS 4
locl: DS 4

code_seg0: SECTION

callee0:
CLEAR loc0,4
RETURN
code_segl: SECTION
calleel:

CLEAR locl,4
RETURN

Exporting the function exports the corresponding parameter objects. Locals are usually
not exported

The following listing shows an example of an invalid non-exported parameter definition.

Listing 3.34 Invalid Non-Exported Parameter Definition Example

XDEF callee
_OVERLAP: SECTION
callee_pl: DS 4

callee_code: SECTION
callee:

CLEAR callee_pl,4
RETURN

Because callee_pl is not exported, an external caller or callee will not use the
correct parameter. (Actually, the application will not be able to link because of the
unresolved external callee_pl).

To correct this, export callee_pl as well, as shown in the following listing):

Listing 3.35 Exporting callee_p1 Example

XDEF callee

XDEF callee_pl
_OVERLAP: SECTION
callee_pl: DS 4
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callee_code: SECTION

callee:
CLEAR callee_pl,4
RETURN

Only use function parameters which are actually called. Do not use local variables of other
functions. The assembler does not prevent the usage of locals, which is not possible in C.
Such additional usages are not taken into account for the allocation and may not work as
expected. As a rule, only access objects defined in the _ OVERLAP section from one
SECTION, unless the object is a parameter. Parameters can be safely accessed from all
sections containing calls to the callee and from the section defining the callee.

The following listing shows an example of an invalid use of a local variable.

Listing 3.36 Invalid Use of a Local Variable Example

_OVERLAP: SECTION
loc: DS 4

calleeO_code: SECTION
callee0:
CLEAR loc,4 ; error:usage of local var loc from two functs
RETURN

calleel_code: SECTION
calleel:

CLEAR loc,4 ; error: usage of local var loc from two
functs

RETURN

Instead, use two different locals for two different functions, as shown in the following
listing:

Listing 3.37 Valid Use of a Local Variable Example

_OVERLAP: SECTION
locO: DS 4; local var of function calleel
locl: DS 4; local var of function calleel

calleeO_code: SECTION

callee0:
CLEAR loc0,4 ; OK, only callee 0 uses locO
RETURN

calleel code: SECTION
calleel:
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CLEAR locl,4 ; OK, only callee 0 uses locl
RETURN

In Freescale format, functions defined in assembly must access all parameters and locals
allocated in the _ OVERLAP segment. There must be no unused parameters in the
_OVERLAP segment, otherwise, the linker allocates the unused parameter in the overlap
area of one of the callers. This object can then overlap with the local variables of other
callers. In the ELF format, the binding to the defining function is done by name mangling,
so this restriction does not exist.

The following example does not work in the Freescale format because callee_pl is not
accessed:

Listing 3.38 Freescale Unsupported Format Example

OVERLAP: SECTION

callee_pl: DS 4; error: parameter MUST be accessed

callee_code: SECTION
callee:
RETURN

To correct this, use the parameter even if it is not needed, as shown in the following
listing:

Listing 3.39 Freescale Supported Format Example

_OVERLAP: SECTION
callee_pl: DS 4; OK parameter is accessed

callee_code: SECTION

callee:
CLEAR callee_pl,1
RETURN

DEPENDENCY TREE Section in Map File

The DEPENDENCY TREE section in the map file provides useful information about the
overlapped allocation.

The following listing shows an example of the DEPENDENCY TREE section in a map
file.
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Listing 3.40 DEPENDENCY TREE Example

volatile int intPending; /* interrupt being handled? */

void interrupt 1 inter (void) ({
int oldIntPending=intPending;
intPending=TRUE;
while (0 == read((void*)0x1234)) {}
intPending=0ldIntPending;

}

unsigned char read(void* adr) {
return *(volatile char*)adr;

}

This code generates the following tree, as shown in the following listing:

Listing 3.41 Output Generated

_Vector_1 : 0x808..0x80B
|
+* inter : 0x808..0x80B
| +* oldIntPending : 0x80A..0x80B
|
+* read : 0x808..0x809
+* _readp0 : 0x808..0x809

Vector_1 is for the interrupt vector 1 specified in the C source.

The parameter name adr is encoded to _readp0, because in C, parameter names may
have different names in different declarations, or even no name as in the example.

Vector_1, inter and read all depend on the adr parameter of read, which is
allocated at 0x808 to 0x809 (inclusive). This area is included for all these objects. Only
Vector_1 and inter depend on o1dIntPending, so the area 0x80A to 0x80B is
only contained in these functions.

Optimizing the Overlap Size

The area of memory used by one function is the area of this function plus the maximum of
the areas of all used functions. The branches with the maximum area are marked with an
asterisk ( * ).

When a local variable is added to a function with an asterisk, the whole overlap area grows
by the variable size. More useful, when you remove a variable of a function marked with
an asterisk, then the size of the overlap may decrease, unless there are several functions
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with an asterisk on the same level. When a marked function is using some variables of its
own, then splitting this function into several parts may also reduce the overlap area.

Recursion Checks

Assume that, for the previous example, a second interrupt function exists:

Listing 3.42 Recursion Checks Example

void interrupt 2 inter2(void) {
int oldIntPending=intPending;
intPending=TRUE;
while (0 == read((void*)0x1235)) {}
intPending=0ldIntPending;

Now, this produces two dependency trees in the map file:

Listing 3.43 Dependency Trees in Generated map File Example

_Vector_2 : 0x808..0x80B
|
+* inter2 : 0x808..0x80B

| +* oldIntPending : 0x80A..0x80B

|

+* read : 0x808..0x809

+* _readpO : 0x808..0x809

_Vector_1 : 0x80C..0x80D
|
+* inter : 0x80C..0x80D

| +* oldIntPending : 0x80C..0x80D

|

+* read : 0x808..0x809 (see above) (object allocated

in area of another root)

The subtree of the read function prints only once. The second time, (see above)
prints instead of the whole subtree. The second remark (object allocated in
area of another root) is more serious. Both interrupt functions use the same
read function. If one interrupt handler can interrupt the other handler, then the parameter
of the read functions may be overwritten and the first handler can fail. If both interrupts
are exclusive, which is common for small processors using overlapped variables, then add
this information to the prm file to allow an optimal allocation.
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Listing 3.44 Example prm file

DEPENDENCY
ROOT inter inter2 END
END

The warning disappears and the same tree contains both inter and inter2:

Listing 3.45 Example Dependency Root

DEPENDECY ROOT

+* inter2 : 0x808..0x80B
| | +* oldIntPending : 0x80A..0x80B
|
| +* read : 0x808..0x809
| +* _readp0 : 0x808..0x809
|
+* inter : 0x808..0x80B
| +* oldIntPending : 0x80A..0x80B
|
+* read : 0x808..0x809 (see above)

Because o1dIntPending of both handlers now overlap, this example saves 2 bytes.

NOTE  The linker still handles Vector_1 and Vector_2 as additional roots.
Because they are allocated using the DEPENDENCY ROOT, they have no
influence on the generated code. Although the DEPENDENCY TREE section in
the map file still lists their trees, these trees can be safely ignored.

Linker-Defined Objects

The linker supports defining special objects to get the address and size of sections at link
time. Objects to be defined by the linker must have as a special prefix one of the strings
below and must not be defined by the application at all.

NOTE  Because the linker defines C variables automatically when their size is known,
the usual variables declaration fails for this feature. For an extern int
__SEG_START_SSTACK;, the linker allocates the size of an int, and does
not define the object as address of the stack. Use the following syntax so that
the compiler/linker has no size for the object: extern int
__SEG_START_SSTACKI[];
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Usual applications of this feature are the initialization of the stack pointer and retrieving
the last address of an application to compute a code checksum at runtime.

The object name is built by using a special prefix and then the name of the symbol.
The following tree prefixes are supported:

* __ SEG_START_ : start address of the segment

e __ SEG_END_ : end address of the segment

e _ SEG_SIZE_ : size of the segment

NOTE  The __ SEG_END_ end address is the address of the first byte behind the
named segment.

The linker assumes the remaining text after the prefix to be the segment name. If the linker
does not find such a segment, it issues a warning and takes O as the address of this object.

NOTE  There is no warning issued for predefined segments like SSTACK or
OVERLAP, even if these segments are empty and not explicitly allocated. The
warning is only issued for user-defined segments.

Because identifiers in C must not contain a period in their name, the Freescale format
aliases can be used for the special ELF names. Few of them are SSTACK instead of
.stack, DEFAULT_RAM instead of . data, DEFAULT_ROM instead of . text, COPY
instead of .copy, ROM_VAR instead of . rodata, STRINGS instead of . rodatal,
STARTUP instead of . startData, PRESTART instead of . init ,_OVERLAP instead
of .overlap, _OVERLAP?2 instead of .overlap2. Also, __DOT___ can be prefixed for
objects whose names start with period character.

For example, __SEG_START DOT___common can be used to get start address of
.common section.

Listing 3.46 C Source Code

#define _ SEG_START_REF (a) _ SEG_START_ ## a
#define _ SEG_END_REF (a) _ SEG_END_ ## a
#define _ SEG_SIZE_REF (a) _ SEG_SIZE_ ## a
#define _ SEG_START_DEF (a) extern char _ SEG_START REF (a) []
#define _ SEG_END_DEF (a) extern char _ SEG_END_REF( a) []
#define _ SEG_SIZE_DEF (a) extern char _ SEG_SIZE REF( a) []

/* To use this feature, first define the symbols to be used: */
_ SEG_START DEF (SSTACK); // start of stack
___SEG_END_DEF (SSTACK) ; // end of stack
__ SEG_SIZE_DEF (SSTACK); // size of stack

/* Then use the new symbols with the _REF macros: */

int error;
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void main(void) {
char* stackBottom= (char*)__ SEG_START_REF (SSTACK) ;
char* stackTop = (char*)__SEG_END_REF (SSTACK) ;
int stackSize= (int)__ SEG_SIZE_REF (SSTACK) ;
error=0;
if (stackBottom+stackSize != stackTop) { // top is bottom + size
error=1;
}
for (;;); /* walit here */

Listing 3.47 .prm File

LINK example.abs
NAMES example.o END
SECTIONS
MY_RAM = READ_WRITE 0x0800 TO OxOFFF;
MY_ROM = READ_ONLY 0x8000 TO OxXEFFF;
MY_STACK = NO_INIT 0x400 TO O0x4ff;
END
PLACEMENT
DEFAULT_ROM INTO MY_ROM;
DEFAULT_RAM INTO MY_RAM;
SSTACK INTO MY_STACK;
END
INIT main

Listing 3.48 Linker-Defined Symbols

__ SEG_START_SSTACK 0x400
__SEG_END_SSTACK 0x500
__ SEG_SIZE_SSTACK 0x100

NOTE  To use the same source code with other linkers or old linkers, define the
symbols in a separate module for them.

NOTE In C, you must use the address as value, and not any value stored in the
variable. So in the previous example, (int)__ SEG_SIZE_REF (SSTACK)
was used to get the size of the stack segment and not a C expression like
__SEG_SIZE_REF (SSTACK) [0].
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Stack Consumption Computation

The stack consumption computation is a feature of the linker that helps compute the
theoretical maximal amount of stack space an application requires at runtime. This
estimation can be done for the whole application or for user-specified call sub-trees. The
result of the estimation is printed out in the map file along with the corresponding call tree
paths. This feature is controlled by the -StackConsumption (Listing 3.49) command
line option. However, the specific information needed for this feature is issued by the
compiler and encoded in the object file.

NOTE  Older versions of the compiler may not issue the information. Also, this feature
is currently only supported for HC(S)08 derivatives.

STACK_CONSUMPTION Block

When using -StackConsumption (Listing 3.49) the linker automatically computes
the stack consumption estimation for the application's entry point. This includes, typically
the _Startup function and the user-provided vector table entries (refer to the VECTOR
command in Listing 3.51). Since it is not possible to determine at link-time control-flow
dependencies between usual functions and interrupt handlers the linker will compute and
print the stack consumption for each vector table entry separately.

The linker also supports advanced features to increase the precision of the estimation.
These include:

* Adding edges to the call graph; the FUNCTION_PAIR directive (Refer Table 3.6).

* Specifying user-defined stack consumption for a function; the CONSUMPTION
directive (Refer Table 3.6).

* Specifying a custom call sub-tree; the ROOT directive (Refer Table 3.6).

* Specifying that a specific interrupt can be raised during the execution of a function;
the INTERRUPT_FUNCTION directive (Refer Table 3.6).

¢ Specifying the maximum recursion factor for a function; the RECURSION_FACTOR
directive (Refer Table 3.6).

Following is the syntax of the STACK_CONSUMPTION block.

Listing 3.49 STACK_CONSUMPTION Block Syntax

STACK_CONSUMPTION
ROOT <namel> : <filename>

[Optional] RECURSION_FACTOR <name>:<filename> <factor>;
[Optional] INTERRUPT_FUNCTION <name>:<filename>

<ISR_name>:<filename> <stackSize>;
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END
[Optionall
ROOT <name2> : <filename>
[Optional ]RECURSION_FACTOR (<name>) <factor>;
END
[Optional] CONSUMPTION <function_name>:<filename> <number>;
[Optional] FUNCTION_PAIR <caller>:<filename> <callee>:<filename>
<stackSize>;
END

NOTE <filename> is only required when the referred symbol has local binding.
For example, a C static function. A single function or a chain of functions that
induce a loop in the call graph.

The following table describes the STACK_CONSUMPTION block directives.

Table 3.6 STACK_CONSUMPTION Block Directives

Descriptive Description

ROOT <name1> : <filename> <name> Specifies the name of the function
for which the total stack effect is to be
computed. Object File name <filename>
in which ROOT can also be defined. This
directive is not mandatory. The application
entry point is used as root if none is explicitly
provided. Also, it is possible to specify
multiple roots.

RECURSION_FACTOR <factor> Specifies the recursive factor of
<name>:<filename> <factor>; the specified function that is the maximum
number of recursive calls a function makes
for one execution of its caller.

The functions that cause indirect recursivity
can also be specified. This should exclude
the last caller - callee pair causing
recursion (Refer Section Example 2a). The
scope of this directive is restricted to the
ROOT in which it is defined.
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Table 3.6 STACK_CONSUMPTION Block Directives (continued)

Descriptive

Description

INTERRUPT_FUNCTION
<name>:<filename>
<ISR_name>:<filename>
<stackSize>;

Specifies that the interrupt handler
ISR_name can be raised during execution of
the function name. The amount of stack
consumed by the function name up to the
point where the interrupt occurs must be
specified by the stackSize parameter (use
the stack consumption of the name function
if not sure).

CONSUMPTION
<function_name>:<filename>
<number>;

Specifies the stack size of function is an
integer value.This directive should be written
after specifying all ROOT entries. The stack
size mentioned with this directive for a
function applies to whole application and
overrides the value internally computed by
the linker.

FUNCTION_PAIR
<caller>:<filename>
<callee>:<filename>
<stackSize>;

Alters the linker-computed call graph by
adding an edge between caller and callee.
The cost of this edge will be stackSize. This
parameter should contain the amount of
stack consumed by caller up to the point
where callee is called. An use case for this
directive would be an application that
contains function pointers being passed as
arguments. The directive should be at the
end after specifying all ROOT entries. The
information given by this directive applies to
whole application.

Limitations

Functions written in assembly language are not taken into account when computing the
stack consumption. However, the stack usage information can be specified using the

CONSUMPTION PRM directive.

NOTE  The assembly language here does not refer to inline assembly code, but to code
written in assembly files, processed by the assembler tool.

104

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual




Linking Issues
Stack Consumption Computation

Example to Generate Stack Information

Compilation
Consider C source:

./Sources/main.c

Listing 3.50 Generating Stack Information Example

static int ind_max;

void cc (int c¢);

void bb(int a, int b);

void aa(int a, int b, int c);

void cc(int c¢) {
ind_max += 30;
aa (10, 20 , 30);

}

void bb(int a, int b) {
ind_max += 20;
cc(b);

}

void aa(int a, int b, int c) {
if (ind_max == 600) {
return;
}
ind_max += 10;
bb(a,b);
}

void main (void) {
aa(10,20,30);
}

The following table lists the stack usage information generated by compiler inmain. obj
file.

Table 3.7 Stack Usage Information

Caller Callee StackSize
main aa 6
Main - 4
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Table 3.7 Stack Usage Information

Caller Callee StackSize
Aa Bb 4
Aa - 2
Bb Cc 4
bb - 2
Cc Aa 6
Cc - 4

Link Process
1. Linker Option to be enabled: -StackConsumption

2. Stack Consumption directives included in PRM.

Listing 3.51 Stack Consumption directives included in PRM

STACK_CONSUMPTION

ROOT main

RECURSION_FACTOR aa:./Sources/main.obj bb:./Sources/main.obj cc:./
Sources/main.obj 10;

END

END

VECTOR 0 _Startup

3. Link the application.

Listing 3.52 Partial map file output

STACK CONSUMPTION COMPUTATION
1)
main = 148
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+-cc
2)
_Startup = 14

+—1
|
+—2
o]
[
B

The RECURSION_FACTOR directive specified in PRM is applicable only to ROOT entry
main and not the default entry _Startup that is specified in VECTOR PRM directive.

Example to Specify Stack Consumption PRM
Directives

This sections describes the examples to specify stack consumption PRM directives.

Recursive Functions — Test Case 1

The following listing shows a Recursive Functions test case.

Listing 3.53 Recursive Functions — Test Case 1

void A() { /* This is a recursive function */
A();

}

Void main() {

A();

PRM Directive to be specified:

Listing 3.54 PRM Directive

STACK_CONSUMPTION
ROOT main
RECURSION_FACTOR A 10; /* Correct */
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RECURSION_FACTOR A A 10; /* Incorrect */
END
END

Recursive Functions — Test Case 2

The following listing shows another Recursive Functions test case.

Listing 3.55 Recursive Functions — Test Case 2

void A() {

Void main() {

PRM Directive to be specified:

Listing 3.56 PRM Directive

STACK_CONSUMPTION

ROOT main

RECURSION_FACTOR A B 10; /* Correct */
RECURSION_FACTOR A B A 10; /* Incorrect */
END

END

Function Pointer Passed as Argument to Function —

Test Case

The following listing shows a test case of function pointer passed as argument to function.

Listing 3.57 Function Pointer Passed as Argument to Function

double next_Div (double d) {
return d/1.8;
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}

Bool Comp_TrueLargerl (double a, double b) {
return a+1.0 > b + 1.0;

}

void Test5_Do (double d0, double dl, Bool (*comp) (double a, double b),
double (*next) (double)) {
while (dl1 != 0) {
if (comp(d0, dil)) {

d0 = next (d0) ;
}
Void main() {

Test5_ Do (1.0, 1.1, Comp_TrueLargerl, next_Div);
}

PRM Directive specification, as shown in the following listing:

Listing 3.58 PRM Directive

STACK_CONSUMPTION

ROOT main

END

FUNCTION_PAIR Test5_Do Comp_TrueLarger 12;
FUNCTION_PAIR Test5_Do next_Div 22;

END

Usage of CONSUMPTION Directive — Test Case

shows a test case of usage of CONSUMPTION directive.

Listing 3.59 Usage of CONSUMPTION Directive

Void main() {
Asm_func(); /* Call to an assembly function defined in test.asm*/

}

Stack usage of main to Asm_func is given by compiler in object file but assembler does
not provide stack usage of Asm_ func routine. CONSUMPTION directive can be added to
specify the stack usage of Asm_func.

PRM Directive specification, as shown in the following listing:
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Listing 3.60 PRM Directive

STACK_CONSUMPTION
ROOT _Startup

END

CONSUMPTION Asm_func 100;

END

Checksum Computation

The linker invokes the computation of a checksum in two ways:

¢ prm file-controlled checksum computation:

The prm file specifies which kind of checksum to compute over which area and
where to store the resulting checksum. This method gives full flexibility, but also
requires more user-configuration effort. With this method the linker only computes
the actual checksum value; the application code must ensure that the areas specified
in the prm file match the areas computed at runtime.

¢ Automatic linker-controlled checksum computation:

With this method, the linker generates a data structure containing all information to
compute the checksum. The linker lists all ROM areas, computes the checksum and
stores it, together with area and type information, in a data structure which can then
be used at runtime to verify the code.

Table 3.8 Comparison of Checksum Computation Methods

Attribute prm File Controlled Automatic Linker
Controlled
Complexity Needs some configuration Easy to use. Call
prm file needs adaptations _Checksum_Check
Robustness Values used in prm file and | Good. Nothing (or few things) to
source code must match. configure

All areas to be checked
must be listed in prm and
source code.

Control Everything in full user Poor. Can be controlled only
control. when segment must be checked.
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Table 3.8 Comparison of Checksum Computation Methods (continued)

Attribute prm File Controlled Automatic Linker
Controlled

Target Memory Good. Only uses necessary | Needs more memory because of

Usage memory. control data structure.
Execution Time Depends on method. Depends on method. Checks only
Checks all areas as code needed areas.

size is unknown.

prm File-Controlled Checksum
Computation

Special commands in the prm file can instruct the linker to compute the checksum over
some explicitly specified areas. All necessary information for this is specified in the prm
file, as shown in the following listing.

Listing 3.61 Example prm file

CHECKSUM

END

CHECKSUM_ENTRY

END

METHOD_CRC_CCITT

READ_ONLY 0xE020 TO OxXEEFF
READ_ONLY OxEF00 TO OxXFEFF

INTO READ_ONLY 0xEO010 SIZE 2
UNDEFINED Oxff

See the CHECKSUM: Checksum Computation (ELF) linker command description for the
exact syntax to used in the prm file and also for more examples.

Automatic Linker-Controlled Checksum
Computation

The linker tracks all the memory areas used by an application, therefore this method uses
this knowledge to generate a data structure, which then can be used at runtime to validate
the complete code. The linker provides this information in the same way it provides copy
down and zero out information.

The linker automatically generates the checksum data structure if the startup data structure
has two have additional fields:
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Listing 3.62 Checksum Data Structure Example

extern struct _tagStartup {

struct _ Checksum* checkSum;
int nofCheckSums;

The header file checksum. h defines the structure _ Checksum:

Listing 3.63 Checksum Data Structure Example2

struct _ Checksum {
void* start;
unsigned int len;
#if _CHECKSUM_CRC_CCITT
_CheckSum2ByteType checkSumCRC_CCITT;
#endif
#i1if _CHECKSUM_CRC_16
_CheckSum2ByteType checkSumCRC16;
#endif
#if _CHECKSUM_CRC_32
_CheckSumdByteType checkSumCRC32;
#endif
#if _CHECKSUM_ADD_BYTE
_CheckSumlByteType checkSumByteAdd;
#endif
#i1if _CHECKSUM_XOR_BYTE
_CheckSumlByteType checkSumByteXor;
#endif
Y

The linker allocates ___checksum structure in a . checksum section, placed after all the
other code or constant sections. As the . checksum section itself must not be checked, it
must be the last section in a SECTION list.

The linker issues checksum information for all used segments in the prm file. However,
if some segments are filled with a FILL command, then this fill area is not included.

The linker derives checksum types to be computed by using the field names of the
___Checksum structure. Usually only one alternative is present, but the linker can
compute checksum in any combination of checksum methods.
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Automatic Structure Detection

The linker reads the debug information of the module containing _tagStartup to
detect which checksums to generate and how to build the structure. This ensures that the
structure used by the compiler always matches the structure the linker generates.

The linker contains the structure field names and the name __Checksum of the
checksum structure. These names cannot be changed. Adapt the structure field types to
your needs.

.checksum Section

The . checksum section must be the last section in a placement. It may be after the
. copy section. If it is not mentioned in the prm file, the linker automatically allocates
space for the . checksum section when needed.

The checksum areas do not cover . checksum itself.

Partial Fields

The __Checksum structure can also contain checkSumWordAdd,
checkSumLongAdd, checkSumWordXor and checkSumLongXor fields to
compute checksums with larger element sizes. However, as the FILL areas are not
considered, the 1en field might not be a multiple of the element size. When this happens,
assume the missing bytes are equal to zero. Because this is not handled in the provided
example code, automatic generated word, long size add, or XOR checksums are not
officially supported.

Runtime Support

The checksum. h file contains functions, prototypes, and utilities to compute the various
checksums. The corresponding source file is checksum. c. Look at checksum. ¢ to
find out how to compute the various checksums. The automatic generated checksum
feature does not need any customer code.

To verify that the checksums are valid, perform the simple call:

_Checksum_Check (_startupData.checkSum,
_startupData.nofCheckSums) ;

The following listing shows a sample function call with required variable definitions
needed in the customer code with the respective linker PRM. Use this as an example to
verify that the prm file generated the checksums.

Listing 3.64 Checksum entry in linker PRM file
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CHECKSUM
CHECKSUM_ENTRY
METHOD_CRC8
OF READ_ONLY OxFO0C TO 0OxFO02B
OF READ_ONLY OxFE8000 TO OxFE80O0F
INTO READ_ONLY OxF300 SIZE 1
UNDEFINED OxFF
END
END

Listing 3.65 Customer code

const struct _ ChecksumArea areas[] = {
{(const void * __ far) (0x7FF00C), 0x20} ,
{(const void * __ far) (0x7F8000), 0x10}
Y

#define N_MEM_AREAS 2 /* Total number of memory areas present in const
struct _ ChecksumArea areas[] */

#define DEFAULT_CRCS8_POLY 0x9B

#define DEFAULT_ CRC8_INIT O0xXFF

#define CHECKSUM_STORAGE_CRCS8 (* (unsigned char*)0x7FF300)
void main () {

if (_Checksum_CheckAreasCRC8 (areas , N_MEM AREAS, DEFAULT_CRCS8_POLY
, DEFAULT_CRC8_INIT ) == CHECKSUM_STORAGE_CRCS8) {
result = TRUE;
}

Checksum. c file has routines prefixed with _Checksum_CheckAreas as utilities to
compute a single checksum over multiple memory areas.

The following code adds the new data structure __ChecksumArea to checksum.h
with respect to the calculation of single checksum for multiple memory areas.

Listing 3.66 Code Adding _ ChecksumArea to checksum.h

struct _ ChecksumArea {
_CHECKSUM_ConstMemBytePtr start;
unsigned int len;

I
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Linking an Assembly Application

Use the prm file or the SmartLinker to link an Assembly application, when warnings can
be ignored.

prm File

When an application consists of assembly files only, you can simplify the linker prm file.
The simplified prm file requires:

* No startup structure.
* No stack initialization, because the source file directly initializes the stack.
¢ No main function.

* An entry point in the application.

Listing 3.67 prm File Example

LINK test.abs
NAMES test.o test2.o END

SECTIONS
DIRECT_RAM = READ_WRITE 0x00000 TO 0xOOOFF;
RAM_AREA = READ_WRITE 0x00300 TO O0xQ07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
PLACEMENT
myRegister INTO DIRECT_RAM;
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END
INIT Start ; Application entry point

VECTOR ADDRESS OxFFFE Start ; Initialize Reset Vector

This example:

¢ Allocates all data sections defined in the assembly input files in the RAM_AREA
segment.

¢ Allocates all code and constant sections defined in the assembly-input files in the
ROM_AREA segment.

* Defines the My Start function as the application entry point and also specifies it as
areset vector. My Start must be XDEFed in the assembly source file.

Warning Messages

An assembly application does not need any startup structure or root function.
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You can ignore the following two warnings:
WARNING: _startupData not found

WARNING: Function main not found

Smart Linking

When you link an assembly application, the linker performs smart linking on section level
instead of object level. That links whole sections containing referenced objects with the
application. An example of SmartLinking follows:

Listing 3.68 Assembly Source File

XDEF entry
dataSecl: SECTION

datal: DCB 1
dataSec2: SECTION
data2: DCB 2
codeSec: SECTION
entry:

NOP

NOP

LDX #datal

LDA #56

STA 0, X
loop: BRA loop

Listing 3.69 SmartLinker prm File

LINK test.abs
NAMES test.o END

SECTIONS
RAM_AREA = READ_WRITE 0x00300 TO OxO07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END

INIT entry
VECTOR ADDRESS OXFFE entry

This example:

* Defines the function entry as application entry point and also specifies it as a reset
vector.
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¢ Links the data section dataSec1 defined in the assembly input file with the

application because datal is referenced in entry. Allocates dataSecl in the

RAM_AREA segment at address 0x300.

¢ Links the code section codeSec defined in the assembly-input file with the

application because entry is the application entry point. Allocates codeSec in the

ROM_AREA segment at address 0x8000.

¢ Does NOT link the data section dataSec?2 defined in the assembly input file with

the application, because the data2 symbol is never referenced.

You can switch smart linking OFF for your application. In that case all of the assembly

code and all objects link with the application.

For the previous example, the following prm file switches smart linking OFF:

Listing 3.70 ELF Format prm File

LINK test.abs
NAMES test.o END

SEGMENTS
RAM_AREA = READ_WRITE 0x00300 TO O0x07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
END
PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
DEFAULT ROM INTO ROM_AREA;
END

INIT entry
VECTOR ADDRESS OxFFE entry
ENTRIES * END

Listing 3.71 Freescale Format prm File

LINK test.abs
NAMES test.o+ END

SEGMENTS
RAM_AREA = READ_WRITE 0x00300 TO OxO07FFF;
ROM_AREA = READ_ONLY 0x08000 TO OxOFFFF;
END
PLACEMENT
DEFAULT_RAM INTO RAM_AREA;
DEFAULT_ROM INTO ROM_AREA;
END

INIT entry
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VECTOR ADDRESS OxFFFE entry

These examples:
* Define the entry function as application entry point and specify it as a reset vector.

¢ Allocate the dataSec1 data section defined in the assembly input file in the
RAM_AREA segment at address 0x300.

* Allocate the dataSec?2 data section defined in the assembly input file next to the
datasSec1 section at address 0x302.

* Allocate the codeSec code section defined in the assembly-input file in the
ROM_AREA segment at address 0x8000.

LINK_INFO (ELF)

Some compilers support writing additional information into the ELF file. This information
consists of a topic name and specific content.

#pragma LINK_INFO BUILD_NUMBER “12345”
#pragma LINK_INFO BUILD_KIND “DEBUG”

The compiler then stores this information into the ELF object file. The linker checks if
different object files contain the same topic name with different content. If so, the linker
issues a warning.

Finally, the linker issues all LINK_INFOs into the generated output ELF file.

Use this feature to warn you about linking incompatible object files together. Also the
debugger can use this feature to pass information from header files used by the compiler
into the generated application.

The linker currently has no internal knowledge about specific topic names.
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The SmartLinker’s parameter file is an ASCII text file. For each application you have to
write such a file. It contains linker commands specifying how the linking is to be done.
This section describes the parameter file in detail, giving examples you may use as
templates for your own parameter files. You might also want to look at the parameter files
for the examples included in your installation.

Parameter File Syntax

The following is the EBNF syntax of the parameter file:

Listing 4.1 EBNF Syntax of the Parameter File

ParameterFile={Command}

Command= LINK NameOfABSFile [AS ROM_LIB]
NAMES ObjFile {ObjFile} END
SEGMENTS {SegmentDef} END
PLACEMENT {Placement} END
(STACKTOP | STACKSIZE) exp
MAPFILE MapSecSpecList

ENTRIES EntrySpec {EntrySpec} END
VECTOR (InitByAddr | InitByNumber)
INIT FuncName

MAIN FuncName

HAS_ BANKED_DATA

OVERLAP_GROUP {FuncName} END
DEPENDENCY {Dependency} END

| CHECKSUM {ChecksumEntry} END
where:

NameOfABSFile= FileName

ObjFile= FileName [”-"]

ObjName= Ident

QualIden = FileName “:” Ident

FuncName= ObjName | QualIdent
MapSecSpecList= MapSecSpec “,” {MapSecSpec}
EntrySpec= [FileName“:”] (* | ObjName)

MapSecSpec= ALL | NONE | TARGET | FILE | STARTUP | SEC_ALLOC |
SORTED_OBJECT_LIST | OBJ_ALLOC | OBJ_DEP | OBJ_UNUSED | COPYDOWN |
OVERLAP_TREE | STATSTIC

Dependency= ROOT {ObjName} END
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| ObjName USES {ObjName} END

| ObjName ADDUSE {ObjName} END

| ObjName DELUSE {ObjName} END

SegmentDef= SegmentName “=“ SegmentSpec “;”.
SegmentName= Ident.

SegmentSpec= StorageDevice Relocation Range [Alignment] [FILL
CharacterList] [OptimizeConstants].
ChecksumEntry= CHECKSUM_ENTRY
ChecksumMethod

[INIT Number]

[POLY Number]

OF MemoryArea

INTO MemoryArea

[UNDEFINED Number]

END
ChecksumMethod= METHOD_CRC_CCITT | METHOD_CRC8 | METHOD_CRC16 |
METHOD_CRC32 | METHOD_ADD [SIZE <Size>] | METHOD_XOR.

MemoryArea= StorageDevice Range StorageDevice= READ_ONLY | CODE |
READ_WRITE | PAGED | NO_INIT.

Range= exp (TO | SIZE) exp

Relocation= RELOCATE_TO Address

Alignment= ALIGN [exp] {“[“ObjSizeRange"“:” exp”]”}
ObjSizeRange= Number | Number TO Number | CompareOp Number
CompareOp: ( Wen | We—w | wsn | \\>:\\)

CharacterList= HexByte {HexByte}

OptimizeConstants= { (DO_NOT_OVERLAP_CONSTS | DO_OVERLAP_CONSTS) {CODE
| DATA}}

Placement= SectionList (INTO | DISTRIBUTE_INTO) SegmentList “;”

SectionList= SectionName {"“,” SectionName}
SectionName= Ident
SegmentList= Segment {“,” Segment}

Segment= SegmentName | SegmentSpec

InitByAddr= ADDRESS Address Vector

InitByNumber= VectorNumber Vector

Address= Number

VectorNumber= Number

Vector= (FuncName [OFFSET exp] | exp) [“,” expl]

Ident= <any C style identifier>

FileName= <any file name>

exp= Number

Number= DecimalNumber | HexNumber | OctalNumber

HexNumber= 0xHexDigit{HexDigit}.

DecimalNumber= DecimalDigit{DecimalDigit}

HexByte= HexDigit HexDigit

HexDigit= “07 | “17| %27 | 37 | ~av | w57 | wgn | w7n | ngw | wgr| wan
[ vBe | e | e R [ NEe | var | b | ver | har | ver | ver
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DecimalDigit: nO " | “l"| won | w3 | AV | g | ng | w7 | ngn | nwgn

Comments can appear anywhere in a parameter file, except where file names are expected.
You can use either C style comments or Modula-2 style comments.

To keep your sources portable, do not include paths in file names. Otherwise, if you copy
the sources to some other directory, the linker might not find all files needed. The linker
uses the paths in the environment variables GENPATH, OBJPATH, TEXTPATH and
ABSPATH to decide where to look for files and where to write the output files.

The order of the commands in the parameter file does not matter. However, make sure that
you specify the SEGMENTS block before the PLACEMENT block.

There are a some sections named .data, .text, .stack, .copy, .rodatal,
.rodata, .startData, and . init. Information about these sections can be found in
the chapter on predefined sections.

Mandatory SmartLinker Commands

A linker parameter file must contain at least the entries for LINK (or using option -0),
NAMES, and PLACEMENT. All other commands are optional. The following example
shows the minimal parameter file:

Listing 4.2 Minimal Parameter File Example

LINK mini.abs /* Name of resulting ABS file */

NAMES

mini.o startup.o /* Files to link */
END
STACKSIZE 0x20 /* in bytes */
PLACEMENT

DEFAULT_ROM INTO READ_ONLY OxA0O0 TO OxBFF;
DEFAULT_RAM INTO READ_WRITE 0x800 TO Ox8FF;
END

If the CodeWarrior software calls the linker, then the LINK command is not necessary.
The CodeWarrior plug-in passes the —O option with the destination file name directly to
the linker. You can see this if you enable Display generated command lines in message
window in the Linker preference panel in CodeWarrior IDE.

The first placement statement reserves the address range from 0xA00 to OxBFF for
allocation of read only objects (hence the qualifier READ_ONLY).

DEFAULT_ROM INTO READ_ONLY 0xA00 TO OxBFF;
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The . text subsumes all linked functions, all constant variables, all string constants and
all initialization parts of variables, and copies them to RAM at startup.

The second placement statement reserves the address range from 0x800 to 0x8FF for
allocation of variables.

DEFAULT_RAM INTO READ_WRITE 0x800 TO Ox8FF;

The INCLUDE Directive

A special INCLUDE directive allows you to split a prm file into several text files, if
needed, to separate a target-specific part of a prm file from a common part.

The syntax of the include directive is:
IncludeDir= “INCLUDE” FileName.

Because the INCLUDE directive may be everywhere in the prm file, it is not contained in
the main EBNF.

Listing 4.3 Include Directive Example

LINK mini.

NAMES

startup.

INCLUDE
END
STACKSIZE
PLACEMENT

DEFAULT

END

abs /* Name of resulting ABS file */

o /* startup object file */
objlist.txt

0x20 /* in bytes */

' ROM INTO READ_ONLY O0xAOO0 TO OxBFF;
DEFAULT_.

RAM INTO READ_WRITE 0x800 TO Ox8FF;

with objlist.txt:

mini0.o /* user object file(s) */
minil.o
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Using sections allows you complete control over object allocation in memory. A section is
a named group of global objects (variables or functions) associated with a certain memory
area that may be non-contiguous. The objects belonging to a section are allocated in its
associated memory range. This chapter describes the use of sections in detail.

There are many different ways to use sections, the most important being:

* Distributing two or more groups of functions and other read-only objects to different
ROM:s.

* Allocating single functions or variables to a fixed absolute address (for example, to
access processor ports using high-level language variables).

* Allocating variables into memory locations where special addressing modes may be
used.

Segments and Sections

A Section is a named group of global objects declared in the source file, that is, functions
and global variables.

A Segment is a memory range, not necessarily contiguous.

In the linker’s parameter file, each section is associated with a segment so the linker
knows where to allocate the objects belonging to a section.

Sections

A section definition always consists of two parts: the definition of the objects belonging to
it, and the memory area(s) associated with it, called segments. The object definition is
done in the application source files using pragmas or directives (see the Compiler or
Assembler manual). The segment definition is done in the parameter file using the
SEGMENTS and PLACEMENT commands.

Predefined Sections

You can group predefined sections into sections according to the runtime routines:
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Sections

* Sections for things other than variables and functions: . rodatal, . copy,
.stack.

* Sections for grouping large sets of objects: .data, . text
* A section for placing objects initialized by the linker: . startData.

* A section to allocate read-only variables: . rodata
NOTE The .data and . text sections provide default sections for object allocation.

The following paragraphs describe each of these predefined sections.

.rodata1

This predefined section contains all string literals. For example, This is a stringis
allocated in section . rodatal. If you associate this section with a segment qualified as
READ_WRITE, the strings are copied from ROM to RAM at startup.

.rodata

The . rodata section contains any constant variable (declared as const in a C module
or as DC in an assembler module) which is not allocated in a user-defined section.
Usually, the . rodata section is associated with a READ_ONLY segment.

If this section is not mentioned in the PLACEMENT block in the parameter file, these
variables are allocated next to the . text section.

.copy

Initialization data belongs to the . copy section. If a source file contains the declaration:
int all = {1, 2, 3};

the hex string 000100020003 (6 bytes), which is copied to a location in RAM at
program startup, belongs to the . copy segment.

If you allocate the . rodatal section to a READ_WRITE segment, all strings also belong
to the . copy section. Any objects in this section are copied at startup from ROM to
RAM.

.stack

The runtime stack has its own segment named . stack. Always allocate .stack to a
READ_WRITE segment.
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.data

This predefined section is the default section for all objects normally allocated to RAM. It
is used for variables not belonging to any section or to a section not assigned a segment in
the PLACEMENT block in the linker’s parameter file. If any of the .bss or . stack
sections are not associated with a segment, these sections are included in the .data
memory area in the following order:

Figure 5.1 Memory Inclusion Order for .data

Hata hss stack

text

This is the default section for all functions. If a function is not assigned to a certain section
in the source code or if its section is not associated with a segment in the parameter file, it
is automatically added to the . text section. If any of the . rodata, .rodatal,
.startData or .init sections are not associated with a segment, these sections are
included in the . text memory area.

.startData

The startup description data initialized by the linker and used by the startup routine is
allocated to segment . startData. This section must be allocated to a READ_ONLY
segment.

Init
The application entry point is stored in the . init section. This section also must be
associated with a READ_ONLY segment.

.overlap

Compilers using pseudo-static variables for locals allocate these variables in . overlap.
Variables of functions not depending on each other may be allocated at the same place.
This section must be associated with a NO_INIT segment.

NOTE The .data and . text sections must always be associated with a segment.
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Examples of Using Sections

Examples 1 and 2 illustrate the use of sections to precisely control allocation of variables
and functions.

Example 1

This example distributes code into two different ROMs:

Listing 5.1 Using Sections Example1

LINK first.ABS
NAMES first.o strings.o startup.o END
STACKSIZE 0x200
SECTIONS

ROM1 = READ_ONLY 0x4000 TO Ox4FFF;

ROM2 = READ_ONLY 0x8000 TO Ox8FFF;
PLACEMENT

DEFAULT_ROM INTO ROM1, ROM2;

DEFAULT_RAM INTO READ_WRITE 0x1000 TO Ox1FFF;
END

Example 2

This example allocates code into battery-buffered RAM:

Listing 5.2 Using Sections Example2

/* Extract from source file "bufram.c" */
#pragma DATA_SEG Buffered_ RAM
int done;
int status[100];
#pragma DATA_SEG DEFAULT
/* End of extract from "bufram.c" */

The following shows the associated SmartLinker parameter file:

Listing 5.3 SmartLinker Parameter File

LINK bufram.ABS
NAMES

bufram.o startup.o
END
STACKSIZE 0x200
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SECTIONS
BatteryRAM = NO_INIT 0x1000 TO Ox13FF;
MyRAM = READ_WRITE 0x5000 TO Ox5FFF;
PLACEMENT

DEFAULT_ROM INTO READ_ONLY 0x2000 TO 0x2800;
DEFAULT_RAM INTO MyRAM;
Buffered_RAM INTO BatteryRAM;

END
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Segments

Using segments allows you complete control over object allocation in memory. A segment
is a named group of global objects (variables or functions) associated with a certain
memory area that may be non-contiguous. The objects belonging to a segment are
allocated in its associated memory range. This chapter describes the use of segmentation
in detail.

There are many different ways to make use of the segment concept, the most important
being:
* Distributing two or more groups of functions and other read-only objects to different
ROMs.

* Allocating single functions or variables to a fixed absolute address (for example, to
access processor ports using high-level language variables).

¢ Allocating variables in memory locations where special addressing modes may be
used.

Segments and Sections

A Segment is a named group of global objects declared in the source file, i.e. functions and
global variables.

A Section is a memory range, not necessarily contiguous.

In the linker’s parameter file, each segment is associated with a section so the linker
knows where to allocate the objects belonging to a segment.

Segment

A segment definition always consists of two parts: the definition of the objects belonging
to it, and the memory area(s) associated with it, called sections. The object definition is
done in the source files of the application using pragmas or directives (see the Compiler or
Assembler manual). The section definition is done in the parameter file using the
SECTIONS and PLACEMENT commands (see Parameter File Syntax).
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Predefined Segments

Predefined segment can be grouped into segments according to the runtime routines:
¢ Segments for things other than variables and functions: STRINGS, COPY, SSTACK
» Segments for grouping large sets of objects: DEFAULT_RAM, DEFAULT_ROM
* A segment for placing objects initialized by the linker: STARTUP
* A segment to allocate read-only variables: ROM_VAR

NOTE  The segments DEFAULT_RAM and DEFAULT_ROM provide default segments
for allocating objects.

The following paragraphs describe each of these predefined segments.

STRINGS

This predefined segment contains all string literals (e.g. This is a string).
Associate this segment with a segment qualified as READ_WRITE to copy the strings
from ROM to RAM at startup.

ROM_VAR

The ROM_VAR segment contains any constant variable (declared as const in a C module
or as DC in an assembler module) which is not allocated in a user-defined segment.
Usually, the ROM_VAR segment is associated with READ_ONLY section.

If this segment is not mentioned in the PLACEMENT block in the parameter file, the linker
allocates these variables next to the DEFAULT_ROM segment.

FUNCS

The FUNCS segment contains any function code not allocated in a user-defined segment.
Usually, the FUNCS segment is associated with READ_ONLY section.

COPY

Initialization data belongs to the COPY segment. If a source file contains the declaration:
int all = {1, 2, 3};

the hex string 000100020003 (6 bytes), which is copied to a location in RAM at
program startup, belongs to segment COPY.
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If the STRINGS segment is allocated to a READ_WRITE section, all strings also belong to
the COPY segment. The linker copies any objects in this segment from ROM to RAM at
startup.

SSTACK

The runtime stack has its own segment named SSTACK. Always allocate SSTACK to a
READ_WRITE section.

DEFAULT_RAM

This is the default segment for all objects normally allocated to RAM. Use
DEFAULT_RAM for variables not belonging to any segment or for variables belonging to a
segment not assigned a section in the PLACEMENT block in the linker’s parameter file. If
you do not associate the SSTACK segment with a section, it is appended to the
DEFAULT_RAM memory area.

DEFAULT_ROM

This is the default segment for all functions. If a function is not assigned to a certain
segment in the source code or if its segment is not associated with a section in the
parameter file, it is automatically added to DEFAULT_ROM segment. If any of the
_PRESTART, STARTUP, or COPY segments is not associated with a section, the linker
includes these segments in the DEFAULT_ROM memory area in the following order:

Figure 6.1 DEFAULT_ROM Segment Memory Order

_PRESTART STARTUP DEFAULT_ROM CopY

STARTUP

The startup description data initialized by the linker and used by the startup routine is
allocated to the STARTUP segment. This segment must be allocated to a READ_ONLY
section.

_PRESTART

The application entry point is stored in the segment _ PRESTART. This segment must also
be associated with a READ_ONLY section.
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_OVERLAP

This segment contains pseudo-static local variables, which are for non-reentrant functions.

The linker analyzes the call graph (that is, it keeps track of which function calls which
other functions) and chooses distinct memory areas in the _ OVERLAP segment if it
detects a call dependency between two functions. If it doesn’t detect such a dependencys, it
may overlap the memory areas used for local variables of two separate functions.

There are cases in which the linker cannot determine whether a function calls another
function, especially in the presence of function pointers. If the linker detects a conflict
between two functions, it issues an error message.

In the ELF object file format, the name . overlap is a synonym for _OVERLAP.

NOTE  The DEFAULT_RAM and DEFAULT_ROM segments must always be associated
with a section.

VIRTUAL_TABLE_SEGMENT

The compiler generates virtual function tables if virtual functions are used. Because
classes often are declared in header files, each implementation file including such header
files with classes containing virtual member functions, may generate virtual function
tables. These tables are constant by default and may be allocated in ROM.

To simplify this, the compiler places all virtual tables into a special segment named
VIRTUAL_TABLE_SEGMENT. You can use this in the linker parameter file to allocate
the virtual tables into ROM:

DEFAULT_ROM, ROM_VAR, VIRTUAL_TABLE_SEGMENT INTO MY_ROM

Additionally, the linker uses this segment name to avoid duplicate definitions of virtual
function tables in your linked application.
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This section deals with advanced material. First-time users may skip this section; standard
startup modules taking care of common cases are delivered with the programs and
examples. It suffices to include the startup module in the files to link in the parameter file.
For more information about the names of the startup modules and the different variants see
the file readme . txt in the LIB directory subfolders.

NOTE  The code shown in this chapter is example code. To understand what the
startup modules for your environment do, be sure to look at the files in the
installation.

Prior to calling the application’s root function (main), one must:
* initialize the processor’s registers,
* zero out memory, and
¢ copy initialization data from ROM to RAM.

Depending on the processor and the application’s needs, different startup routines may be
necessary.

There are standard startup routines for every processor and memory model. They are easy
to adapt to your particular needs because all these startup routines are based on a startup
descriptor containing all information needed. Different startup routines differ only in the
way they make use of that information.

This section covers the following topics:

o Startup Descriptor (ELF)

¢ User-Defined Startup Structure (ELF)
e User-Defined Startup Routines (ELF)

o Startup Descriptor (Freescale)

¢ User-Defined Startup Routines (Freescale)

o Startup Code and Effect of Pragmas

Startup Descriptor (ELF)

The startup descriptor of the linker is declared in code similar to that shown below. Note
that depending on architecture or memory model your startup descriptor may be different.
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Listing 7.1 ELF Startup Descriptor Example

typedef struct{
unsigned char *_FAR beg;int size;
} _Range;

typedef struct _Copy {
int size; unsigned char * far dest;
} _Copy;

typedef void (*_PFunc) (void) ;

typedef struct_LibInit {
_PFunc *startup; /* address of startup desc */
} _LibInit;

typedef struct _Cpp {
_PFunc initFunc; /* address of init function */
} _Cpp;

extern struct _tagStartup {
unsigned char flags;
_PFunc main;
unsigned short stackOffset;
unsigned short nofZeroOuts;

_Range *pZeroOut;
_Copy *toCopyDownBeg;
unsigned short nofLibInits;
_LibInit *1libInits;
unsigned short nofInitBodies;
_Cpp *initBodies;
unsigned short nofFiniBodies;
_Cpp *finiBodies;

} _startupData;

The linker expects, somewhere in your application, a declaration of the variable
_startupData, that is:

struct _tagStartup _startupData;

The linker initializes the fields of this st ruct and allocates _startupData in ROM in
.startData section. If there is no declaration of this variable, the linker does not
create a startup descriptor. In this case, there is no . copy section, and the stack is not
initialized. Furthermore, global C++ constructor and ROM libraries are not initialized.

The following table shows the semantics for these fields.
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Table 7.1 ELF Startup Descriptor Field Semantics

Field Name

Description

flags

Contains some flags which can be used to detect special
conditions at startup. Currently uses two bits. Linking the
application as a ROM library sets bit 0 equal to 1. Bit 1 is set when
no stack specification is made. Startup code tests Bit 1 (with mask
2) to determine whether to initialize the stack pointer.

main

Function pointer set to application’s root function. In a C program,
this usually is function main unless a MAIN entry exists in the
parameter file, specifying some other function as root. In a ROM
library, main is zero. Standard startup code jumps to this address
once initialization is over.

stackOffset

Valid only if (flags & 2) == 0. Contains the initial value of the
stack pointer.

nofzeroOuts

Number of READ_WRITE segments to fill with zero bytes at startup.
Not required if you do not have any RAM memory area, which
requires initializing at startup. When not present in the startup
structure, pZeroOut must not be present either.

pZeroOut

Pointer to a vector with elements of type _Range. It has exactly
nofZeroOuts elements, each describing a memory area to be
cleared. Not required if you do not have any RAM memory area,
which requires initializing at startup. When not present in the
startup structure, nofZeroOuts must not be present either.

toCopyDownBe
g

Contains the address of the first item which must be copied from
ROM to RAM at runtime. All data to be copied is stored in a
contiguous piece of ROM memory and has the following format:
CopyData = {Size[t] TargetAddr {Byte)Size
Alignment} 0x0(¢;.

Alignment= 0x0[0..71].

Size is a binary number whose most significant byte is stored first.
Not required if you do not have any RAM memory area, which
requires initializing at startup. Alignment is used to align the next
size and TargetAddr field. Number of alignment bytes depends
on processor’s capability to access unaligned data. For small
processors, there is usually no alignment. Sizetof Size[t] and
0x0 [t] depends on target processor and memory model.
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Table 7.1 ELF Startup Descriptor Field Semantics (continued)

Field Name Description

nofLibInits Number of ROM libraries linked with the application that must be
initialized at startup. Not required if you do not link any ROM library
with your application. When not present in startup structure,
1ibInits must not be present.

libInits Vector of pointers to the _startupDbata records of all ROM
libraries in the application. Contains exactly nofLibInits
elements. These addresses are needed to initialize the ROM
libraries. Not required if you do not link any ROM library with your
application. When not present in the startup structure,
nofLibInits must not be present.

noflnitBodies Number of C++ global constructors which must be executed prior
to invoking application root function. Not required if application
does not contain a C++ module. When not present in startup
structure, initBodies must not be present.

initBodies Pointer to a vector of function pointers containing addresses of the
global C++ constructors in the application, sorted in calling order.
Contains exactly nof InitBodies elements. If application does
not contain any C++ modules, the vector is empty. Not required if
application does not contain any C++ module. When not present in
the startup structure, nofInitBodies must not be present
either.

nofFiniBodie | Number of C++ global destructors which must be executed after
s the invocation of application root function. Not required if
application does not contain a C++ module. When not present in
startup structure, finiBodies must not be present either. If
application root function does not return, nofFiniBodies and
finiBodies can both be omitted.

finiBodies Pointer to a vector of function pointers containing addresses of
global C++ destructors in the application, sorted in calling order.
Contains exactly nofFiniBodies elements. If an application
does not contain any C++ modules, the vector is empty. Not
required if application does not contain a C++ module. When not
present in startup structure, nofFiniBodies must not be
present either. If application root function does not return,
nofFiniBodies and finiBodies can both be omitted.
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User-Defined Startup Structure (ELF)

You can define your own startup structure. That means you can remove the fields, which
are not required for your application, or move the fields inside of the structure. If you
change the startup structure, it is your responsibility to adapt the startup function to match
the modification.

Example

If you have no RAM area to initialize at startup, no ROM libraries and no C++ modules in
the application, you can define the startup structure as follows:

Listing 7.2 ELF User-Defined Startup Structure Examplei

extern struct _tagStartup {
unsigned short flags;
__PFunc main;
unsigned short stackOffset;
} _startupData;

Adapt the startup code in the following way:

Listing 7.3 ELF User-Defined Startup Structure Example2

extern void near _Startup(void) {
/* purpose: 1) initialize the stack
2) call main;
parameters: NONE */
do { /* forever: initialize the program; call the root-procedure */
INIT_SP_FROM_STARTUP_DESC() ;
/* Here user defined code could be inserted,
the stack can be used
*/
/* call main() */
(*_startupData.main) () ;
} while(l); /* end loop forever */

NOTE Do not change the name of the fields in the startup structure. You are free to
remove fields inside of the structure, but respect the names of the different
fields or the SmartLinker may not initialize the structure correctly.
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User-Defined Startup Routines (ELF)

There are two ways to replace the standard startup routine with one of your own:

* You can provide a startup module containing a function named _Startup and link
it with the application in place of the startup module delivered.

* You can implement a function with a name other than _Startup and define it as
the entry point for your application using the command INIT:

INIT function_name

In this case, function function_name is the startup routine.

Startup Descriptor (Freescale)

The Freescale startup descriptor of the linker is declared as below.

NOTE  Descriptor declaration may vary depending on architecture or memory model.

Listing 7.4 Freescale Startup Descriptor Example

typedef struct{
unsigned char *beg; int size;
} _Range;

typedef void (*_PFunc) (void) ;

extern struct _tagStartup({

unsigned flags;

_PFunc main;
unsigned dataPage;

long stackOffset;
int nofzeroOuts;
_Range *pZeroOut;
long toCopyDownBeg;
__PFunc *mInits;

struct _tagStartup *libInits;
} _startupData;

The linker expects, somewhere in your application, a declaration of the variable
_startupData, that is:

struct _tagStartup _startupData;

The linker initializes the fields of this struct and allocates the struct in ROM in
STARTUP segment. If you do not declare this variable, the linker does not create a startup
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descriptor. In this case, there is no COPY segment, and the stack is not initialized.
Furthermore, global C++ constructor and ROM libraries are not initialized.

The following table shows the semantics for these fields.

Table 7.2 Freescale Startup Descriptor Field Semantics

Field Name Description

flags Contains some flags, which may be used to detect special
conditions at startup. Currently uses two bits. Linking the
application as a ROM library sets bit 0 equal to 1. Bit 1 is set when
no stack specification is made.

Startup code tests £lags to determine whether to initialize the
stack pointer.

main Function pointer set to the application’s root function. Ina C
program, usually function main unless a MAIN entry exists in the
parameter file specifying some other function as being root. In a
ROM library, main is zeroed out. Standard startup code jumps to
this address once initialization completes.

dataPage Used only for processors having paged memory and memory
models supporting only one page. In this case, dataPage gives
the page.

stackOffset Valid only if f1lags == 0. Contains initial stack pointer value.

nofZeroOuts Number of READ_WRITE segments to fill with zero bytes at
startup.

pZeroOut Pointer to a vector with elements of type _Range. It has exactly
nofZeroOuts elements, each describing a memory area to be
cleared.

toCopyDownBeg Contains the address of the first item which must be copied from
ROM to RAM at runtime. All data to be copied is stored in a
contiguous piece of ROM memory and has the following format:

CopyData = {Size[,; TargetAddr {Byte}St?ey 0x0 (5

Size is a binary number whose most significant byte is stored first.
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Table 7.2 Freescale Startup Descriptor Field Semantics (continued)

Field Name Description

libInits Pointer to array of pointers to _startupData records of all ROM
libraries in the application. These addresses are needed to
initialize the ROM libraries. To specify end of the array, the last
array element contains the value 0x0000£££f.

mInits Pointer to array of function pointers containing addresses of the
global C++ constructors in the application, sorted in calling order.
Array is terminated by a single zero entry.

User-Defined Startup Routines (Freescale)

There are two ways to replace the standard startup routine with one of your own:

* You can provide a startup module containing a function named _Startup and link
it with the application in place of the startup module delivered.

* You can implement a function with a name other than _Startup and define it as
the entry point for your application using the command INIT:

INIT function_name

In this case, function function_name is the startup routine.

Example of Startup Code in ANSI-C

Normally the startup code delivered with the compiler is provided in HLI for code
efficiency reasons. But there is also an ANSI-C version available in the library directory
(startup.cand startup.h). You can use this code for your own modifications or to
get familiar with the startup concept.

The code shown here is an example and may be different depending on the actual
implementation. See the files in your installation directory.

Listing 7.5 Header File startup.h Example

/***************************************************

FILE : startup.h

PURPOSE : data structures for startup

LANGUAGE: ANSI-C
****************************************************/
#ifndef STARTUP_H
#define STARTUP_H
#ifdef __ _cplusplus
extern "C" {
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#endif

#include <stdtypes.h>

#include <hidef.h>

/*
the following data structures contain the data needed to
initialize the processor and memory

*/

typedef struct{

unsigned char *beg;

int size; /* [beg..beg+size] */
} _Range;

typedef struct _Copy{
int size;
unsigned char * dest;
} _Copy;

typedef struct _Cpp {
_PFunc initFunc; /* address of init function */

} _Cpp;

typedef void (*_PFunc) (void) ;
typedef struct _LibInit{
struct _tagStartup *startup; /* address of startup desc */
} _LibInit;
#define STARTUP_FLAGS_NONE 0
#define STARTUP_FLAGS_ROM_LIB (1<<0) /* ROM library */
#define STARTUP_FLAGS_NOT_INIT SP (1<<1l) /* init stack */
#ifdef _ ELF_OBJECT FILE_FORMAT_
/* ELF/DWARF object file format */
/* attention: the linker scans for these structs */
/* to obtain the available fields and their sizes. */
/* So do not change the names in this file. */

extern struct _tagStartup {

unsigned char flags; /* STARTUP_FLAGS_ XXX */
_PFunc main; /* first user fct */
unsigned short stackOffset; /* initial stack pointer */
unsigned short nofZeroOuts; /* number of zero outs */
_Range *pZeroOut; /* vector of zero outs */
_Copy *toCopyDownBeg; /* copy down start */
unsigned short nofLibInits; /* number of ROM Libs */
_LibInit *libInits; /* vector of ROM Libs */
unsigned short nofInitBodies; /* number of C++ inits */
_Cpp *initBodies; /* C+ init funcs */
unsigned short nofFiniBodies; /* number of C++ dtors */
_Cpp *finiBodies; /* C+ dtors funcs */
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} _startupData;
#else /* HIWARE format */

extern struct _tagStartup {

unsigned flags; /* STARTUP_FLAGS_XXxX */

_PFunc main; /* starting point of user code */
unsigned dataPage; /* page where data begins */

long stackOffset; /* initial stack pointer */

int nofzeroOuts; /* number of zero out ranges */
_Range *pZeroOut; /* ptr to zero out descriptor */
long toCopyDownBeg; /* address of copydown descr */
_PFunc *mInits; /* ptr to C++ init fcts */
_LibInit *1ibInits; /* ptr to ROM Lib descriptors */

} _startupData;
#endif
extern void _Startup (void) ; /* execution begins here */
#ifdef __ _cplusplus
}

#endif
#endif /* STARTUP_H */

Listing 7.6 Implementation File startup.c Example

/***************************************************

FILE : startup.c
PURPOSE : standard startup code
LANGUAGE : ANSI-C / HLI

***************************************************/

#include <hidef.h>
#include <startup.h>
/***************************************************/

struct _tagStartup _startupData; /* startup info */

static void ZeroOut (struct _tagStartup *_startupData) {
/* purpose: zero out RAM-areas where data is allocated.*/
int i, 3J;
unsigned char *dst;
_Range *r;
r = _startupData->pZeroOut;
for (i=0; i<_startupData->nofZeroOuts; i++) {
dst = r->beg;
j = r->size;
do {
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*dst = '\0'; /* zero out */
dst++;
j--;

} while(j>0);

r++;

static void CopyDown (struct _tagStartup *_startupData) ({
/* purpose: zero out RAM-areas where data is allocated.
this initializes global variables with their values,

e.g. 'int i = 5;' then 'i' is here initialized with '5' */

int 1i;
unsigned char *dst;
int *p;
/* _startupData.toCopyDownBeg ---> */
/* {nof(l6) dstAddr(l6) {bytes(8)}"nof} Zero(1l6) */
p = (int*)_startupData->toCopyDownBeg;
while (*p !'= 0) {
i = *p; /* nof */
pt++;
dst = (unsigned char*)*p; /* dstAddr */
pt+;
do {

/* p points now into 'bytes' */
*dst = *((unsigned char*)p); /* copy byte-wise */
dst++;
((char*)p) ++;
i--;
} while (i>0);

static void CallConstructors(struct _tagStartup *_startupData)
/* purpose: C++ requires that the global constructors have
to be called before main.
This function is only called for C++ */
#ifdef _ ELF_OBJECT_FILE_FORMAT
short 1i;
_Cpp *fktPtr;

fktPtr = _startupData->initBodies;
for (i=_startupData->nofInitBodies; i>0; i--) {
fktPtr->initFunc(); /* call constructors */
fktPtr++;
}
#else

_PFunc *fktPtr;

{
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fktPtr = _startupData->mInits;
if (fktPtr != NULL) {
while (*fktPtr != NULL) {
(**fktPtr) (); /* call constructors */
fktPtr++;
}
}
#endif

static void InitRomLibraries(struct _tagStartup *_sData) {
/* purpose: ROM libraries have their own startup functions
which have to be called. This is only necessary if ROM
Libraries are used! */

#ifdef _ ELF_OBJECT FILE_FORMAT_
short 1i;
_LibInit *p;

p = _sData->1ibInits;
for (i=_sData->nofLibInits; i>0; i--) {
ProcessStartupDesc (p->startup) ;
pt+;
}
#else
_LibInit *p;
p = _sData->libInits;
if (p != NULL) {
do {
ProcessStartupDesc (p->startup) ;
} while ((long)p->startup != 0x0000FFFF) ;

static void ProcessStartupDesc (struct _tagStartup *_sData) {
ZeroOut (_sData) ;
CopyDown (_sData) ;
#ifdef _ cplusplus
CallConstructors (_sData) ;
#endif
if (_sData->flags&STARTUP_FLAGS_ROM_LIB) {
InitRomLibraries (_sData) ;
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#pragma NO_EXIT
#ifdef _ cplusplus
extern "C"

#endif
void _Startup (void) {
for (;;) {
asm {

/* put your target specific initialization */
/* (e.g. CHIP SELECTS) here */
}

if (! (_startupData.flags&STARTUP_FLAGS_NOT_ INIT_SP)) {
/* initialize the stack pointer */
INIT SP_FROM_STARTUP_DESC(); /* defined in hidef.h */

}

ProcessStartupDesc (&_startupData) ;

(*_startupbData.main) (); /* call main function */
} /* end loop forever */

Startup Code and Effect of Pragmas

The _Startup is not affected by the pragmas placed on it in ‘C’ source. The compiler
places _Startup in . text section by default or other section if it is overriden by
pragma. Linker places _Startupin .init (alias PRESTART) section and also _all_
other functions of startup source that go to . text section (or other section) in startup
source are placed in .init section. If . init section is not allocated to any segment in
PLACEMENT block of linker command file then linker automatically places . init
section in segments assigned to DEFAULT_ROM (or . text) section. Consider the
following example:

Listing 7.7 Example — Startup Code and Effect of Pragmas

'C' startup source:

#pragma CODE_SEG NON_BANKED
Void _Startup() {..}

Void Init() {..}

Void loadByt() {..}

Linker parameter file:
PLACEMENT

NON_BANKED INTO ROM; /*ROM is non-banked memory*/ DEFAULT _ROM INTO
PAGEO, PAGEl; /* PAGEO, PAGEl are banked areas */
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END

In above case, _Startup, Init and loadByte functions are put in NON_BANKED
section by the compiler. Linker forcefully places _Startup function in . init (alias
PRESTART) section and also all functions that go to NON_BANKED section in startup
source are placed in . init section. Since . init is not allocated to any segment in
PLACEMENT block of PRM, linker places . init section in segments (PAGEO OR
PAGEL) assigned for DEFAULT_ROM (or . text).
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When linking completes successfully, the linker writes a protocol of the link process to a
list file called a map file. The name of the map file is the same as that of the . ABS file, but
with extension .map. The linker writes the map file to the directory given by the
TEXTPATH environment variable (see TEXTPATH: Text Path).

Map File Contents

The following table describes the sections contained in the map file.

Table 8.1 Map File Contents

Section Name | Description

TARGET Names the target processor and memory model.

FILE Lists names of all files from which objects were used or referenced
during link process. In most cases, these are the same names listed
in linker parameter file between keywords NAMES and END. If a file
refers to ROM library or program, lists all object files used by ROM
library or program with indentation.

STARTUP Lists prestart code and values used to initialize startup descriptor
_startupData. Startup descriptor is listed member by member
with the initialization data at the right side of the member name.

SEGMENT Lists segments in which at least one object was allocated. At right

ALLOCATION side of the segment name there is a pair of numbers, which give the
address range in which the objects belonging to the segment were
allocated.

OBJECT Contains names of all allocated objects and their addresses.

ALLOCATION Objects are grouped by module. ROM library addresses are
followed by an @ sign. In this case the absolute file contains no
code for the object (if it is a function), but the object’s address was
used for linking. A string object address followed by a dash “-”
indicates that the string is a suffix of some other string. For example,
if strings abc and be are present in the same program, the string be
is not allocated and its address is the address of abc +1.
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Table 8.1 Map File Contents (continued)

Section Name | Description

OBJECT Lists every function and variable that uses other global objects and
DEPENDENCY the names of these global objects.

DEPENDENCY Shows, in a tree format, all detected dependencies between
TREE functions. Also displays overlapping Locals displayed at their
defining function.

UNUSED Lists all objects found in object files that were not linked.

OBJECTS

COPYDOWN Lists all blocks that are copied from ROM to RAM at program
startup.

STATISTICS Delivers statistical information, like the number of bytes of code in

the application.

NOTE  If linking fails because there are objects which were not found in any object
file, no map file is written.
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The SmartLinker supports linking to objects to which addresses were assigned in previous
link sessions. Packages of already linked objects are called ROM libraries. Creation of a
ROM library only slightly differs from the linkage of a normal program. ROM libraries
can then be used in subsequent link sessions by including them into the list of files
between NAMES and END.

Examples for the use of ROM libraries are:
* If you use a set of related functions in different projects.

It may be convenient to burn thoroughly tested library functions into ROM. We call
such a set of objects (functions, variables and strings) at fixed addresses a ROM

library.
¢ If you have a set of modules known to be error free and unchanging.

To shorten the time needed for downloading, one can build a ROM library with
modules known to be error free and that do not change. Such a ROM library must be
downloaded only once, before beginning the tests of the other application modules.

 If the system allows you to download one program while another program is present
in the target processor.

The most prominent example is the monitor program. The linker facility described
here enables an application program to use monitor functions.

This chapter contains the following topics:
¢ Creating a ROM Library
» Using ROM Libraries

Creating a ROM Library

To create a ROM library, the keywords AS ROM_LIB must follow the LINK command in
the linker parameter file. With the ENTRIES command, the linker includes only the given
objects (functions and variables) in the ROM library. Without an ENTRIES command, the
linker writes all exported objects to the ROM library. In both cases the ROM library also

contains all global objects used by those functions and variables.

Since a program cannot consist of a ROM library alone, a ROM library must not contain a
function main or a MAIN or INIT command, and the commands STACKSIZE and
STACKTOP are ignored.
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Besides all the application modules which form a ROM library, you must also define the
variable _startupData in the ROM library. The library includes a module containing
only a definition of this variable.

ROM Libraries and Overlapping Locals

To allocate overlapping variables, all dependencies between functions must be known at
link time. For ROM libraries, the linker is unaware of the dependencies between the
objects in the ROM library. Therefore local variables of functions inside of the ROM
library cannot overlap locals of the other modules. Instead, the ROM library must use a
separate area for the . overlap/_OVERLAP segment which is not used in the main
application.

Using ROM Libraries

This section describes various activities involved when using ROM libraries.

Suppressing Initialization

To link to a ROM library, add the name of the ROM library to the list of files in the
NAMES section (see NAMES: List Files Building the Application) of the linker parameter
file. Add a dash (— ) immediately after the ROM library name (no blank between the last
character of the file name and the dash) to prevent the startup routine from initializing the
ROM library.

You can include an unlimited number of ROM libraries in the list of files to link, as long
as no two ROM libraries use the same object file. If two ROM libraries contain identical
objects (coming from the same object file) and both are linked in the same application, the
linker reports an error, because allocating the same object more than once is not allowed.

Example Application

In this example, we want to build and use a ROM library named romlib. 1ib. In this
example the ROM library contains only one object file with one function and one global
variable.

Listing 9.1 Header File Example

/* rl.h
#ifndef
#define

*/

__RL_H
__RL_H

char RL_Count (void) ;
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/* returns the actual counter and increments it */

#endif

Below is the implementation. Note that somewhere in the ROM library we must define an
object named _startupData for the linker. We will use this startup descriptor to
initialize the ROM library.

Listing 9.2 Startup Descriptor Example

/* rom library (RL_) rl.c */
#include "rl.h"
#include <startup.h>

struct _tagStartup _startupData; /* for linker */
static char RL_counter; /* initialized to zero by startup */
char RL_Count (void) {

/* returns the actual counter and increments it */

return RL_counter++;

}

After compiling rl.c we can now link it and build a ROM library using the following
linker parameter file. The main difference between a normal application linker parameter
file and a parameter file for ROM libraries is the AS ROM_LIB keyword in the LINK
command.

Listing 9.3 Linker Parameter File Example

/* rl.prm */
LINK romLib.lib AS ROM_LIB

NAMES rl.o END
SECTIONS

MY _RAM = READ WRITE 0x4000 TO 0x43FF;
MY _ROM = READ_ONLY 0x1000 TO Ox3FFF;

PLACEMENT
DEFAULT_ROM, ROM_VAR, STRINGS INTO MY_ROM;
DEFAULT_RAM INTO MY_RAM;
END

In this example, RAM starts at 0x4000 and ROM starts at 0x1000. By default the linker
generates startup descriptors for ROM libraries too. The startup descriptors are used to
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zero out global variables or to initialize global variables with initialization values.
Additionally, C++ constructors and destructors may be called. This process is called
Module Initialization.

To switch off Module Initialization for a single object file in the above linker parameter
file, add a dash ( —) at the end of each object file. For the above example this is:

NAMES rl.o- END

After building the ROM library, the linker generates a map file. The following listing
shows an extract of this file. The linker also generates a startup descriptor at (in this case)
address 0x1000 to initialize the ROM library.

Listing 9.4 Map File Example

R R b I b kR I R I S S kR Ik I I R Ik I kb R R R I i

STARTUP SECTION

Entry point: none
_startupData is allocated at 1000 and uses 44 Bytes

extern struct _tagStartup({

unsigned flags 3
_PFunc main 103C ()
unsigned dataPage 0
long stackOffset 4202
int nofZeroOuts 1
_Range pZeroOut -> 4000 2
long toCopyDownBeg 102C
_PFunc mInits -> NONE
void * libInits -> NONE

} _startupData;

R R S b S I I R I S S S R S I I R R I I I I R I I

SEGMENT-ALLOCATION SECTION

Segmentname Size Type From To Name

FUNCS 14 R 102E 1041 MY_ROM
COPY 2 R 102C 102D MY_ROM
STARTUP 2C R 1000 102B MY_ROM
DEFAULT_RAM 2 R/W 4000 4001 MY_RAM

R R I I S I S S R I S I R S S I S R I I I I S R S
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OBJECT-ALLOCATION SECTION

Type: Name : Address: Size:
MODULE : --rl.o —--
- PROCEDURES:
RL_Count 102E 14
- VARIABLES:
_startupData 1000 2C
RL_counter 4000 2

Now we want to use the ROM library from our application, as in the following listing.

Listing 9.5 Simple Application Example

/* main application using ROM library: main.c */
#include "rl.h"

int cnt;

void main (void) {
int 1i;

for (i1=0; 1<100; i++) {
cnt = RL_Count () ;

After compiling main.c we can link it with our ROM library, as in Listing 9.6.

Listing 9.6 Linking Example

LINK main.abs

NAMES main.o romlib.lib startup.o ansi.lib END

SECTIONS
MY _RAM = READ_WRITE 0x5000 TO 0x53FF;
MY_ROM = READ ONLY 0x6000 TO Ox6FFF;
PLACEMENT
DEFAULT ROM, ROM_VAR, STRINGS INTO MY_ROM;
DEFAULT_RAM INTO MY_RAM;
END
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STACKSIZE 0x200

Depending on your CPU configuration and memory model you may need to use a startup
object file other than startup. o and a library other than ansi . 1ib. Additionally you
must choose the right startup object file. For efficiency reasons most of the startup files
implemented in HLI are optimized for a specific target. To save ROM usage, they do not
support ROM libraries in the startup code. As long as no Module Initialization is needed,
this is not a problem. To use the Module Initialization feature (as in our example), we use
the ANSI-C implementation in the library directory (startup. c). Because this startup
file may not be delivered in every target configuration, you must compile the
startup.c startup file as well.

After linking to main. abs, you get a map file. The following listing shows an extract of
this file.

Listing 9.7 Map File after Linking Example

EEE R I R I I S I S R R R I S S I I R R I I R I R I R I S R I

STARTUP SECTION

Entry point: 0x6000

Linker generated code (at 0x6000) before calling _ Startup:
MOVE #0x2700, SR

JMP 0x61A0

startupData is allocated at 600A and uses 48 Bytes

extern struct _tagStartupf{

unsigned flags 0
_PFunc main 603C (_main)
unsigned dataPage 0
long stackOffset 5202
int nofZeroOuts 1
_Range pZeroOut -> 5000 2
long toCopyDownBeg 603A
_PFunc mInits -> NONE
void * libInits -> 1000

} _startupData;

ER R I S b S I S I S O I O R O O O

SEGMENT-ALLOCATION SECTION

Segmentname Size Type From To Name

FUNCS 184 R 603C 61BF MY_ROM
COPY 2 R 603A 603B MY_ROM
STARTUP 30 R 600A 6039 MY_ROM
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_PRESTART A R 6000 6009 MY_ROM
SSTACK 200 R/W 5002 5201 MY_RAM
DEFAULT_RAM 2 R/W 5000 5001 MY_RAM
R R R R R R R R R I S I I I
OBJECT-ALLOCATION SECTION
Type: Name : Address: Size:
VECTOR
value: 0 0 4
&_Startup 4 4
MODULE : -- main.o --
- PROCEDURES:
main 603C 26
- VARIABLES:
cnt 5000 2
MODULE : -- X:\FREESCALE\DEMO\M68KC\rl.o --
- PROCEDURES:
RL_Count 102E 14 @
- VARIABLES:
__startupData 1000 2C @
RL_counter 4000 2 @
MODULE : -- startup.o --
- PROCEDURES:
ZeroOut 6062 50
CopyDown 60B2 54
ProcessStartupDesc 6142 3E
HandleRomLibraries 6106 3C
Start 6180 20
_Startup 61A0 20
- VARIABLES:
_startupDbata 600A 30

The linker marks objects linked from the ROM library (RL_Count, RL_counter) with
an @ in the OBJECT-ALLOCATION-SECTION. The linker in this case generates a
startup descriptor at address 0x600A which points, with field 1ibInits, to the startup
descriptor in our ROM library at address 0x1000.
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NOTE Themain.abs file does NOT include the code/data of the ROM library, thus
they are NOT downloaded during downloading of main.abs, and must be
downloaded separately (e.g., with an EEPROM).
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Initializing the Vector Table

You can initialize the vector table in the assembly source file or in the linker parameter
(prm) file. We recommend initializing it in the prm file. This chapter covers the following
topics:

¢ Using SmartLinker prm File

¢ Using a Relocatable Section in the Assembly Source File

¢ Using an Absolute Section in the Assembly Source File

Using SmartLinker prm File

Initializing the vector table from the prm file allows you to initialize single entries in the
table. You can decide if you want to initialize all the entries in the vector table or not.

You must implement the labels or functions to insert into the vector table in the assembly
source file. All these labels must be published, otherwise they cannot be addressed in the
linker prm file.

Listing 10.1 Using SmartLinker prm File Example

XDEF IRQFunc, XIRQFunc, SWIFunc, OpCodeFunc, ResetFunc

DataSec: SECTION
Data: DCB 5 ; Each interrupt increments another element of the table.

CodeSec: SECTION
; Implementation of the interrupt functions.

TIRQFunc:
LDA #0
BRA int
XIRQFunc:
LDA #2
BRA int
SWIFunc:
LDA #4
BRA int

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 157



PR 4

Initializing the Vector Table

Using SmartLinker prm File
OpCodeFunc:
LDA #6
BRA int
ResetFunc:
LDA #8
BRA entry
int:
ADD #Data ; Load address of symbol Data in X
TAX ; X <- address of the appropriate element in the table
INC 0, X ; The table element is incremented
RTI
entry:

LDHX #S$SAFE
TSX
loop: BRA loop

NOTE  The functions IRQFunc, XIRQFunc, SWIFunc, OpCodeFunc,
ResetFunc are published. This is required because they are referenced in the
linker prm file.

NOTE  As the HCOS8 processor automatically pushes all registers onto the stack on
occurrence of an interrupt, the interrupt functions do not need to save and
restore the registers being used.

NOTE  You must terminate all interrupt functions with an RTI instruction.

Initialize the vector table using the VECTOR ADDRESS linker command.

Listing 10.2 Initializing Vector Table Example

LINK test.abs
NAMES

test.o
END

SECTIONS
MY_ROM
MY RAM

READ_ONLY 0x0800 TO 0xO08FF;
READ_WRITE 0x0B00 TO O0xOCFF;

PLACEMENT
DEFAULT RAM INTO MY RAM;
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DEFAULT_ROM INTO MY_ROM;

END

INIT ResetFunc

VECTOR ADDRESS 0xFFF2 IRQFunc
VECTOR ADDRESS 0xFFF4 XIRQFunc
VECTOR ADDRESS 0xFFF6 SWIFunc
VECTOR ADDRESS 0xFFF8 OpCodeFunc
VECTOR ADDRESS 0OXFFFE ResetFunc

Using

NOTE  The statement INIT ResetFunc defines the application entry point. Usually,
this entry point is initialized with the same address as the reset vector.

NOTE The statement VECTOR ADDRESS 0xFFF2 IRQFunc tells the linker to write
the address of function IRQFunc at address OxXFFF2.

a Relocatable Section in the

Assembly Source File

Initializing the vector table in the assembly source file requires initializing all the entries
in the table. Unused interrupts must be associated with a standard handler.

You must implement the labels or functions to insert into the vector table in the assembly
source file. You can define the vector table in an assembly source file in an additional
section containing constant variables.

Listing 10.3 Using a Relocatable Section in the Assembly Source File Example1
XDEF ResetFunc
DataSec: SECTION
Data: DCB 5 ; Each interrupt increments an element of the table.
CodeSec: SECTION
; Implementation of the interrupt functions.
IRQFunc:
LDA #0
BRA int
XIRQFunc:
LDA #2
BRA int
SWIFunc:
LDA #4
BRA int
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#6
int

#8

entry

#Data

0, X

LDHX #SAFE

OpCodeFunc:

LDA

BRA
ResetFunc:

LDA

BRA
DummyFunc :

RTT
int:

ADD

TAX

INC

RTT
entry:

TSX
loop: BRA

loop

VectorTable: SECTION
; Definition of the vector table.

IRQInt:
XIRQInt:
SWIInt:
OpCodeInt:
COPResetInt:
ClMonResInt:

ResetInt

DCW
DCW
DCwW
DCW
DCW
DCW

TRQFunc
XIRQFunc
SWIFunc
OpCodeFunc
DummyFunc; No function attached to COP Reset.
DummyFunc; No function attached to Clock
; MonitorReset.

DC.W ResetFunc

NOTE

Each constant in the section VectorTable is defined as a word (2-byte
constant), because the entries in the HCOS8 vector table are 16 bits wide.

NOTE

The previous example initializes the constant IRQInt with the address of the
label IRQFunc.

NOTE

All the labels specified as initialization values must be defined, published
(using XDEF) or imported (using XREF) before the vector table section. No
forward reference is allowed in DC directive.

Now place the section at the expected address, using the linker parameter file.

Listing 10.4 Using a Relocatable Section in the Assembly Source File Example2

LINK test.abs
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NAMES te

SECTIONS
MY_ROM
MY_RAM

/* Define
Vector

PLACEMENT
DEFAULT
DEFAULT

/* Place
VectorT

END

INIT Rese

st.o+ END

= READ_ONLY 0x0800 TO O0xO08FF;
= READ_WRITE 0x0A00 TO OxOBFF;
the memory range for the vector table */
= READ_ONLY OxXFFF2 TO OXFFFF;

_RAM INTO MY_RAM;

_ROM INTO MY_ROM;

the section ‘VectorTable’ at the appropriated address. */
able INTO Vector;

tFunc

Using

NOTE  The statement Vector = READ_ONLY OxFFF2 TO OxFFFF defines the
memory range for the vector table.

NOTE  The statement VectorTable INTO Vector tells the linker to load the
vector table into the read-only memory area Vector. This allocates the
constant IRQInt at address OxFFF2, the constant XTRQInt at address
0xFFF4, and so on, and allocates the constant ResetInt at address
OXFFFE.

NOTE  The statement NAMES test.o+ END switches smart linking OFF in the
module test . o. If this statement is missing in the prm file, the vector table
never links with the application, because it is never referenced. The
SmartLinker only links the referenced objects in the absolute file.

an Absolute Section in the Assembly

Source File

Initializing the vector table in the assembly source file requires initializing all the entries
in the table. Unused interrupts must be associated with a standard handler.

You must implement the labels or functions to insert into the vector table in the assembly
source file. You can define the vector table in an assembly source file in an additional
section containing constant variables.
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Listing 10.5 Using Absolute Section in Assembly Source File Example1

XDEF ResetFunc

DataSec: SECTION

Data: DCB ; Each interrupt increments an element of the table.
CodeSec: SECTION

; Implementation of the interrupt functions.

IRQFunc:
LDA #0
BRA int
XIRQFunc:
LDA #2
BRA int
SWIFunc:
LDA #4
BRA int
OpCodeFunc:
LDA #6
BRA int
ResetFunc:
LDA #8
BRA entry
DummyFunc :
RTT
int:
ADD #Data
TAX
INC 0, X
RTI
entry:
LDHX #SAFE
TSX
loop: BRA loop

ORG SFFF2
; Definition of the vector table in an absolute section
; starting at address

; SFFF2.
IRQInt: DCW IRQFunc
XIRQInt: DCW XIRQFunc
SWIInt: DCW SWIFunc
OpCodeInt: DCW OpCodeFunc
COPResetInt: DCW DummyFunc; No function attached to COP Reset.
ClMonResInt: DCW DummyFunc; No function attached to Clock
; MonitorReset.
ResetInt : DCW ResetFunc
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NOTE

Each constant in the section VectorTable is defined as a word (2-byte
constant), because the entries in the HCO8vector table are 16 bits wide.

NOTE

In the previous example initializes the constant IRQInt with the address of
the label IRQFunc.

NOTE

All the labels specified as initialization value must be defined, published (using
XDEF) or imported (using XREF') before the vector table section. No forward
reference is allowed in DC directive.

NOTE

The statement ORG SFFF2 specifies that the next section must start at address
$SFFF2.

Listing 10.6 Using Absolute Section in Assembly Source File Example2

LINK test.abs
NAMES

test.o+
END

SEGMENTS
MY_ROM

READ_ONLY 0x0800 TO Ox08FF;

MY RAM = READ_WRITE 0x0A00 TO OxOBFF;

PLACEMENT
DEFAULT_RAM
DEFAULT_ROM

END

INIT ResetFunc

INTO MY_RAM;
INTO MY _ROM;

NOTE

The statement NAMES test .o+ END switches smart linking OFF in the
module test . o. If this statement is missing in the prm file, the vector table
never links with the application, because it is never referenced. The
SmartLinker links only the referenced objects in the absolute file.
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Burner Utility

Introduction

The CodeWarrior IDE burner utility converts an .ABS file into a file that can be handled

by an EPROM burner. The Burner is available as either:

¢ An interactive burner with a graphical user interface (GUI).

¢ A batch burner that accepts commands either from a command line or in a command

file. It can then be invoked by the Make Utility.
This section consists of the following chapters:

¢ Interactive Burner GUI: Description of GUI

» Batch Burner Language: Description of Batch Burner Language (BBL)

Product Highlights

The burner utility:
* Has a powerful user interface
* Has available on-line help
* Offers flexible message management
* Has 32-bit application
* Can generate S-Record, Binary, or Intel Hex files
* Can split the application into different EEPROMS (1-, 2- or 4-byte bus width)
¢ Has an interactive (GUI) and batch language interface (Batch Burner)
¢ Uses a powerful Batch Burner Language with various commands, including:

— baudRate, busWidth, CLOSE, dataBit, destination, DO, ECHO,
ELSE, END, £i11Byte, FOR, format, header, IF, 1en, OPENCOM,
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OPENFILE, origin, parity, PAUSE, range, SENDBYTE, SENDWORD,
SLINELEN, SRECORD, swapByte, THEN, TO, and undefByte.

* Supports Freescale and ELF/DWARF Object File Format, S-Records and Intel Hex
Files as input

* Supports a serial programmer attached to a serial port with various configuration
settings

Starting the Burner Utility

You can start all of the utilities described in this book from executable files located in the
Prog folder of your IDE installation. The executable files are:

¢ linker.exe The SmartLinker Utility
* burner.exe The Burner Utility

e libmaker.exe  The Libmaker Utility

¢ decoder.exe The Decoder Utility

* maker.exe Maker: The Make Tool

With a standard full installation of the HCO8/RS08 CodeWarrior IDE, the executable files
are located at:

<CWilnstallDir>\MCU\prog

For S127Z derivatives, the executable files are located at:
<CWinstallDir>\MCU\S121lisa_Tools

where <CWInstallDir> is the directory where CodeWarrior software is installed.

To start the Burner Utility, double-click the burner . exe file.
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Interactive Burner GUI

You can use the interactive burner graphic user interface (GUI) to burn your EEPROM
instead of writing a batch burner language file. Within the GUI you can set all parameters
and receive the output needed for a batch burner language file. You can then use the
commands displayed on the Burner Dialog Box Command File tab in a make file.

This chapter covers the following topics:

* Burner Default Configuration Window
¢ Burner Dialog Box

Burner Default Configuration Window

When you start the Burner, the Burner Default Configuration window opens.

Figure 11.1 Burner Default Configuration Window

« Burner Default Configuration
File Burner View Help

DEE 28| j@»@@ﬁi

Burner Dialog [con

v
4 »
Ready 14:05:44

To open the burner dialog box, click the Burner Dialog icon in the toolbar or select the
Burner Dialog option from the Burner list menu.

You can also access the burner dialog box with the following command line option:

burner.exe -D
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Burner Dialog Box

The Burner dialog box consists of three tabs:
¢ Input/Output Tab
¢ Content Tab
* Command File Tab

The Burner uses the last burn session values as initial values for the Burner dialog box
tabs. The Burner writes the values to the project. ini file in the [BURNER] section.

Input/Output Tab

In the Input/Output tab, specify which file you want the burner to use for input and where
to write the output. Click the Execute button to start the operation.

Output from the burn process usually goes to a PROM burner connected to the serial port.
You can also redirect output to a file written in either Intel Hex format, as Freescale
S-Records or as plain binary.

Figure 11.2 Burner Dialog Box Input/Output Tab

Burner

X

InputA0utput l Eontent] Command File]

Input
Input File: J
Output
Com Settings
" Com1 Baud Rate:
& G2 Farity:
" Com3 i
Data Bits:
" Comd
Header File: J
&+ File |°/°ABS_FILE°/=.S19 J
|1 st Byte [mszh] j Execute

ak | Cancel | Help |
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Input Group

Specify the input file in the Input File text field. The browse button on the right side is
used to browse for a file. The following file types are supported:

* Absolute files produced by linker. The absolute file format may be either Freescale
or ELF/DWARF

¢ S-Record File
¢ Intel Hex File

The corresponding Batch Burner command is SENDBYTE: Transfer Bytes or
SENDWORD: Transfer Word.

To specify the input file, you can use the $ABS_FILE$% macro to pass ABS_FILE using
an environment variable. See Environment Variable Details.

For example:

-ENV” ABS_FILE=file_name”

Output Group
The burner writes output to a serial port (Com1, Com2, Com3 or Com4) or a file.
File

Select the File option button to write output to a file. In the corresponding text box, enter
the output file name or browse for an existing file.

The corresponding Batch Burner command is OPENFILE: Open Output File.

If you use the macro $ABS_FILES for the input file, you can add an extension to
automatically generate the output file.

Example:

$ABS_FILE%.s19

Com1, Com2, Com3, Com4

To write the output to a serial port, select an available port and define the communication
settings.

The corresponding Batch Burner command is OPENCOM: Open Output Communication
Port.

Com Settings Group

Writing output to a serial port (Com1, Com2, Com3 or Com4) specifies Baud Rate, Parity,
Data bits and Header File in the list boxes and text box of the Com Settings group.
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Table 11.1 Serial Port Specifications

Name Available Options Corresponding Batch
Burner Command
Baud Supported Baud Rates: 300, 600, 1200, baudRate: Baudrate for
Rate 2400, 4800, 9600, 19200 and 38400 Serial Communication
Parity Set communication parity to none, even or parity: Set Communication
odd. Parity

Data Bits Set number of data bits transferred to 7 or 8

dataBit: Number of Data

byte by byte (binary), without modification,
before anything else.

bits. Bits
Header Use to specify an initialization file for the header: Header File for
File PROM burner. File is sent to PROM burner PROM Burner

Execute Group

The Execute group selects a data width and writes data.
1. From the list menu select the byte or word to write:

* st Byte (msb)

e 2nd Byte

* 3rd Byte

e 4th Byte

* 1st Word

e 2nd Word

2. Click the Execute command button to write the data.

Depending on the data width chosen, you may have to send the result to more than one

output file.
Example: Format is S Record and data bus is 2 Bytes

This generates two output files. Data for the first Byte (msb) is sent to a file named
fibo_1.s19 and data for the second byte is sent to fibo_2.s19.

3. Select 1st Byte (msb)

If your data bus is 2 bytes wide, the code is split into two parts:

* Selecting 1st Byte (msb) and clicking Execute transfers the even part of the data

(corresponding to DS to D15).
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¢ Selecting 2nd Byte transfers the odd part, which corresponds to LSB or DO to D7.

If the data bus is 4 bytes wide:
¢ 1st Byte (msb) transfers D24 to D31
¢ 4th Byte sends the LSB (DO to D7).

If using 16-bit EPROMs, select one of the Word formats. If necessary, you can
exchange the high and low byte. Check Swap Bytes in the Content tab of the Burner

dialog box.

4. Click Execute to transfer the code bytes, if you select a data bus width of 1 byte.

The corresponding Batch Burner commands are SENDBYTE: Transfer Bytes and
SENDWORD: Transfer Word.

Content Tab

Use the Content tab in the Burner dialog box to specify the data format and range to be

written.

Figure 11.3 Burner Dialog Box Content Tab

Burner

Format:

Data Bus:

Swap Bytes:

Undef Byte (hex):

Range to Copy:
Origin;

Length:

Destination Offsst:
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™ Intel Hex SRecord Corfiguration

" Binary Type: (* Automatic
51

* 1 Byte 52

53

Bytes per Line: |32

(xffff) and writes the address of the byte O

as address 0

0

(" 2 Bytes

(" 4 Bytes

-

0 Extracts all bytes from 0 to Bffff including
10000

X

o]

Cancel

Help
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Table 11.2 Content Tab Group Details

Group Use Available Corresponding
Name Options Batch Burner
Command
Format Use to select an output S Records format: Output Format
format
Intel Hex
Files
Binary Files
SRecord Use to select type of automatic, SRECORD: S-Record
Configuration SRecord and bytes per s1 Type
line to be written
OR S2
Use to configure the S3
g SLINELEN: SRecord Line
number of bytes per Lenath
SRecord line. Useful rengin
when using tools with
restricted capacity.
Data Bus Use to select a Data 1,2 or 4 bytes | busWidth: Data Bus
Bus width Width
Swap Bytes Use to enable swapping swapByte: Swap Bytes
Checkbox bytes. Available if data
bus is 2 or 4 bytes
Undef Byte For a binary output file, undefByte: Fill Byte for
Textbox normally all undefined Binary Files
bytes in output are
written as OxFF. If
desired, another pattern
can be specified.
Range to Use to specify therange | origin (start), Range to Copy Group
Copy to copy. Text box length, offset

explains result.

Range to Copy Group

To understand range to copy group, consider the following example:

If your application is linked at address $3000 to $4000 and the EPROM is at address
$2000 (Origin) and Length is $2000, the code will start at address $1000 relative to the
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EPROM. If the EPROM is at address $3000 (Origin) and Length is $1000, it is filled
from the start.

Table 11.3 Range to Copy Group Details

Textbox Use Corresponding Batch
Burner Command

Origin Set to EEPROM start address in system. origin: EEPROM Start
Textbox Address
Length Enter range of program code to be copied. len: Length to be Copied

Destination Enter additional offset to add to resulting S destination: Destination
Offset Record or Intel Hex File. For example, if Offset

you set Originto 0x3000 and Destination
Offsetto 0x1000, then written address is
0x4000.

Command File Tab

The Command File tab of the Burner dialog box displays a summary of your settings as
Batch Burner commands. You can select and copy the commands for use in make files or
Batch Burner Language (. bb1l) files.
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Figure 11.4 Burner Dialog Box Command File Tab

Burner

(X

Input/Outpust | Content  Command Fie |

Burmer Commands:

The commands below comespond to the settings of the
previous pages. If you want to use a batch bumer command
file in the future, you can copy these commands and use them
as starting point for your command file.

OPENFILE "fibo.s15"
‘ormat=motorolg|
usWidth=1

oK | Cancel Help

If you use the selection displayed on the Command File tab in a make file, you must

either place everything on a single line or use the line continuation character (\) as
shown.

Listing 11.1 Using Line Continuation Character (\ ) Example

burn:
$ (BURN) \
OPENFILE "fibo.s19" \
format = freescale \

origin = 0xXE000 \
len = 0x2000 \
busWidth = 1
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Batch Burner Language

This chapter describes the Batch Burner Language (BBL). The topics covered here are as
follows:

¢ Batch Burner User Interface

* Syntax of Burner Command Files
¢ Batch Burner with Makefile

Batch Burner User Interface

Starting the Burner utility displays the window shown in the following figure.

Figure 12.1 Burner Default Configuration Window

+ Burner Default Configuration

File Burner View Help

DeE| 78| P o =1
Burner Dialog Icon

4 »

Ready 14:05:44

To use the Batch Burner, type in your batch burner commands on the command line,
specify a file using the -F option on the command line, or use a startup option:

-Ffibo.bbl
or

OPENFILE "fibo.s19" origin=0xE000 len=0x2000 SENDBYTE 1
"fibo.abs"

You can also specify options and burner commands with the burner program:

burner.exe -Ffibo.bbl
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You can use the Burner directly from a make file, as shown in the following listing:

Listing 12.1 Using Burner Directly from Make File

burn:
$ (BURN) \
OPENFILE "fibo.s19" \
format = freescale \

origin = 0xXEQ00 \

len = 0x2000 \
buswidth = 1
SENDBYTE 1 "fibo.abs"

Syntax of Burner Command Files

The following example shows the syntax of burner commands.

Listing 12.2 Example of Burner Command File Syntax

StatementList = Statement {Separator Statement}.
Statement = [IfSat | ForStat | Open | Send | Close | Pause
| Echo | Format | SFormat | Origin | Len

| Buswidth | Parity | SwapByte | Header

| BaudRate | DataBit | UndefByte

| Destination | AssignExpr | SLineLen].
IfStat = "IF" RelExpr "THEN" StatementList

["ELSE" StatementList] "END".

Assign = (=" | “:=7).
ForStat = "FOR" Ident Assign SimpleExpr "TO" SimpleExpr
"DO" StatementList "END".

Open = ("OPENFILE" String) | ("OPENCOM" SimpleExpr) .
Send = ("SENDBYTE" | "SENDWORD") SimpleExpr String.
Close = "CLOSE".
Pause = "PAUSE" [String].
Echo = "ECHO" [String].
Format = “format” Assign (“freescale” | “intel” | “binary”).
SFormat = “SRECORD” Assign (“Sx” | “S1” | “s2” | “S3”).
Origin = “origin” Assign SimpleExpr.
Len = “len” Assign SimpleExpr.
BusWidth = “busWidth” Assign (“1” | “27 | “4").
Parity = “parity” Assign (“none” | “even” | “odd”).
SwapByte = ‘“swapByte” Assign (“yes” | “no”).
Header = “header” Assign string.
BaudRate = “baudRate” Assign ( “300” | “600” “1200”

| “2400” | “4800” | “9600"
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| 192007 | “38400").
DataBit = “dataBit” Assign (“7” | ngmy .
UndefByte = “undefByte” Assign SimpleExpr.
Destination = “destination” Assign SimpleExpr.
SLineLen = “SLINELEN” Assign SimpleExpr.

AssignExpr = Ident Assign SimpleExpr.
RelExpr = SimpleExpr {RelOp SimpleExpr}.

RelOp = "=" | == | R | e | np=n | e
| m<=r | wsn | msan

SimpleExpr = ["+" | "-"] Term {AddOp Term}.

AddOp = ngm | n_mn

Term = Number | String | Ident.

Number =1 | 2 | 3 | 4| 5|6 | 7| 8] 9| 0| {Number}
Ident = "i".

String = '"' {char} '"'.

NOTE The identifier used in a FOR statement must be called 1.

Command File Comments

Command files accept both ANSI-C style or Modula-2 style comments.
/* This is a C like comment */
(* This is a Modula-2 like comment *)
Specify assignments using ANSI-C or Modula-2 syntax:
dataBit := 2 (* Modula-2 like *)
dataBit = 2 /* C like */
Specify constant format using either ANSI-C or Modula-2 syntax:
origin = 0x1000 /* C like */
origin := 1000H (* Modula-2 like *)

Batch Burner with Makefile

In a makefile, you can use the burner in two different ways. The first way is to specify a
command file:

BURNER.EXE -f "<CmdFile>"
The second way is to directly specify commands on the command line:

BURNER.EXE SENDBYTE 1 "InFile.abs"
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If the commands are long, you can use line continuation characters in your make file , as
shown in the following listing.

Listing 12.3 Using Line Continuation Character for Long Commands Example

burn:
$ (BURN) \
OPENFILE "fibo.s19" \
format = freescale \

origin = 0xXEQ000 \
len = 0x2000 \
buswidth = 1

If you use the second method, you can include parameter initialization in the
DEFAULT. ENV file located in the working directory. This reduces the length of the
command line parameters, which are limited to 65535 bytes. Variables that can be
specified using environment variables are listed in the following listing.

Listing 12.4 Variables that can be specified using Environment Variables

header=
format=freescale
busWidth=1
origin=0
1len=0x10000
parity=none
undefByte=0xff
baudRate=9600
dataBit=8
swapByte=no

The example above shows the default values but any legal value can be assigned (see
Batch Burner Commands). For further details, see the example in the following section.

Command File Examples

The following examples show how to write a command file. The following listing shows a
command file for conditional and repetitive statements.

If the symbol # appears in a string it is replaced by the value of i.

Listing 12.5 Sample Command File for Conditional and Repetitive Statements

ECHO
ECHO " I can count... and I can take decisions"
FOR i = 0 TO 8 DO
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END

IF i == 7 THEN

ECHO "This is the number seven"
ELSE

ECHO "#"
END
IF i == 3 THEN

ECHO "This was the number three"
END

The following listing shows a command file for redirecting the output to a file. To redirect
output, use the command OPENFILE.

Listing 12.6 Command File for Redirecting Output

ECHO
ECHO
ECHO
ECHO
PAUS
fo
bu
or

"Programming 2 EPROMs with 3 files"

"the first byte of the word goes into the first EPROM"
"the second byte of the word goes into the second EPROM"
E "Hit any key to continue"
rmat = freescale
swidth = 2
igin = 0

len = 0x3000

FOR

END

i =1TO 2 DO
PAUSE "Insert EPROM n# and press <return>"
OPENFILE "promi#.bin"

origin = 0X

SENDBYTE i "demol.abs"

origin = origin + 0x500

SENDBYTE i "demo2.abs"

origin = origin + 0x500
SENDBYTE i "demo3.abs"
CLOSE

The following listing shows a command file for redirecting the output to a serial port. Use
the OPENCOM command to redirect the output to a serial port.

Listing 12.7 Command File for Redirecting Output to Serial Port

ECHO

ECHO "I can also program 16-bit EPROMs with header"
PAUSE "Hit any key to continue"

header = "init.prm"

format = intel

buswidth = 2
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origin = 0x0

len = 0x1000

OPENCOM 1 /* here coml, com2, com3 or com4 could be used*/
SENDWORD 1 "fbinl.map"

CLOSE

The following listing shows a command file for calling the burner from a makefile. After
compiling and linking the application, the burner prepares the generated code to be burned
into two EPROMs, one containing the odd bytes (fibo_odd. s1) and the other the even
bytes (fibo_eve.sl).

Listing 12.8 Command File for Calling Burner from makefile

makeall:
$ (COMP) $ (FLAGS) fibo.c
$ (LINK) fibo.prm

burner.exe OPENFILE "fibo_odd.sl1" \
busWidth=2 SENDBYTE 1 "fibo.abs"
burner.exe OPENFILE "fibo_eve.sl" \
busWidth=2 SENDBYTE 2 "fibo.abs"

NOTE  For all parameters not specified in the parameter list, the burner uses default
values or the values specified by environment variables.
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Introduction

This section describes the Libmaker, a utility program for creating and maintaining object
file libraries. Using libraries can speed up linking since fewer files are involved, and also
helps in structuring large applications.

Libraries may be given in the linker parameter file instead of object files.

This section consists of the following chapters:

Libmaker Interface: Description of the GUL

User Interface

Libmaker provides:

Graphical User Interface (GUI)

Command-Line User Interface

Online Help

Flexible Message Management

32-bit Application

Builds libraries with Freescale or ELF/DW ARF object files
Error Feedback

Easy integration with other tools (e.g. CodeWarrior IDE, CodeWright, MS Visual
Studio, WinEdit)
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Starting the Libmaker Utility

You can start tools (compiler/linker/assembler/decoder/) using:
* Windows Explorer
¢ Icon on the desktop
¢ Icon in a program group
* Batch/command files
¢ Other tools (Editor, Visual Studio)

You can start all of the utilities described in this book from executable files located in the
Prog folder of your IDE installation. The executable files are:

e linker.exe The SmartLinker Utility
* burner.exe The Burner Utility

¢ libmaker.exe The Libmaker Utility

¢ decoder.exe The Decoder Utility

* maker.exe Maker: The Make Tool

With a standard full installation of the HCO8/RS08 CodeWarrior IDE, the executable files
are located at:

<CWinstallDir>\MCU\prog

For S127Z derivatives, the executable files are located at:
<CWinstallDir>\MCU\S121lisa_Tools

where <CWInstallDir> is the directory where CodeWarrior software is installed.

To start the Libmaker Utility, double-click on 1ibmaker . exe. The Libmaker Default
Configuration window appears.

Interactive Mode

If you start the libmaker with no input (no options or input files), then the graphical user
interface is active (interactive mode). This is usually the case if you start the tool using
Explorer or an icon.
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This chapter describes the libmaker interface, and covers the following topics:

e Startup Command Line Options

¢ Command Line Interface

* Libmaker Graphic User Interface

Startup Command Line Options

There are special options for tools which can only be specified at tool startup (while
launching the tool), e.g. they cannot be specified interactively:

Use -Prod (see -Prod: Specify Project File at Startup (PC) (No d. no m)) to specify the
current project directory or file, for example:

libmaker.exe -Prod=C:\Program Files\Freescale\CodeWarrior
for Microcontrollers V10.x\demo\myproject.pjt

There are other options used to launch the tool and open its dialog boxes. Those dialogs
are available in the compiler/assembler/burner/maker/linker/decoder/libmaker:

¢ -ShowOptionDialog: This startup option opens the tool option dialog.

¢ -ShowMessageDialog: This startup option opens the tool message dialog.

¢ -ShowConfigurationDialog: This opens the File > Configuration dialog.
* -ShowBurnerDialog: Opens burner dialog (burner only)

¢ -ShowSmartSliderDialog: Opens smart slider dialog (compiler only)

¢ -ShowAboutDialog: Opens the tool about box.

These options open dialogs in which you can specify tool settings. When you click the OK
button in the dialog, Libmaker stores the settings in the current project settings file.
Example:

C:\Program Files\Freescale\CodeWarrior for Microcontrollers
V10.x\prog\libmaker.exe -ShowOptionDialog
-Prod=c:\demos\myproject.pjt
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Command Line Interface

Libmaker provides both a command line interface and an interactive interface. If you do
not specify any arguments on the command line, a window appears.

Libmaker Commands

When you start Libmaker, it opens a window and prompts for arguments. The arguments
may be given on a command line in the format shown in the following listing.

Listing 13.1 Libmaker Argument Format

LibCommand = Creation

| AppendFiles

| RemoveFiles

| List

| "@" FileName.
Creation = FileName AddList "=" LibName.
AddList = {"+" FileName}.
AppendFile = LibName AddList "=" LibName.
RemoveFiles = LibName SubList ["=" LibName].
SubList = "-" FileName {"-" FileName}.
List = LibName "?" FileName.

Libmaker uses the environment variable OBJPATH when looking for object or library files,
or writing the library file. It uses the environment variable TEXTPATH when looking for a
command file or writing the listing file.

Managing Libraries

All the commands below are supposed to be in a libmaker command file (text file with the
commands in it, line by line). Alternatively you can pack the commands into the —-Cmd
option (see -Cmd: Libmaker Commands) and pass it to the libmaker directly (e.g. from a
make file). For example:

a.o + b.o = c.lib
This can be written as an option to the libmaker as:
libmaker.exe -Cmd(a.o + b.o = c.1lib)

As it is difficult to create a command line with the ‘+ operator in a make utility, the
libmaker supports the alternative syntax without the ‘+’ operator:

-Cmd(a.o + b.o = c¢.1lib)

This can also be written as:

184 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Libmaker Interface
Command Line Interface

-Cmd(a.o b.o = c.1lib)

Building a Library
Building a library collects all the given object files and/or libraries into one new library,
given after the equal sign:

filel.o + file2.0 + mylib.LIB = ourlib

NOTE  To create a library, there must be at least two files to the left of the equal sign.

Adding Files to a Library

Adding files to an existing library works the same as building a library:

ourlib.LIB + file3.o = ourlib

Removing a File from a Library

You can also remove one or more files from a library:
ourlib.LIB - filel.o = ourlib

This removes the object file £ilel. o from the library.

Creating a New Library

You can create a new library:
ourlib - filel.o = hislib

In this case, the original library our1ib is not overwritten.

Extracting a File from a Library

Use the following code line to extract a file from a library.
LibName * ObjName

The code line above extracts the object file named ObjName from the library. No path is
given with the argument ObjName. The libmaker writes the object file to the same
directory as the library, and does not remove the file from the library. An existing object
file with the same name as an extracted object file is overwritten without warning.

Example:
mylib.lib * myobj.obj
This writes the object file myobj . obj into the same directory asmylib.lib.
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Listing the Contents of a Library

Libmaker also generates an alphabetically sorted list of all exported objects in the library.
Enter the name of the library:

ourlib.LIB

The list file has the same name as the library, but with extension . LST. To specify a
different name, enter:

ourlib.LIB ? mylist.TXT

Command Files

Libmaker also supports command files. A command file is a text file containing
commands for the libmaker. To use a command file, enter:

@mycmds . CMD

The libmaker reads the file and interprets the commands line by line.

Batch Mode

If you start the tool with arguments (options and/or input files), then the tool starts in batch
mode. For example, you can specify the following line:

C:\Program Files\Freescale\CodeWarrior for Microcontrollers
V10.x\PROG\libmaker.exe @mycommands.txt

In batch mode, the tool does not open a window. It is displayed in the taskbar while the
input is processed and terminates afterwards.

Because it is possible to start 32-bit applications from the command line, you can simply
type the commands you want to execute:

C:\>C:\Program Files\Freescale\CodeWarrior for
Microcontrollers V10.x\PROG\libmaker.exe -cmd(a.o b.o =
c.lib)

You can redirect the message output (stdout) of a tool using the normal redirection
operators, (e.g. ‘>’ to write the message output to a file):

C:\> C:\Program Files\Freescale\CodeWarrior for
Microcontrollers V10.x\PROG\libmaker.exe -h > myoutput.txt

Notice that the command line process immediately returns after starting the tool process. It
does not wait until the process finishes. To start a process and wait for termination (e.g. for
synchronization) use the start command under Windows or the /wait option (see
Windows help: ‘help start’” for more information):
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C:\> start /wait C:\Program Files\Freescale\CodeWarrior for
Microcontrollers V10.x\PROG\libmaker.exe -cmd(a.o b.o =
c.lib)

Using start /wait you can write batch files to process your files.

To redirect the libmaker output to stderr/stdout on your DOS shell, use the piper
utility:

C:\> C:\Program Files\Freescale\CodeWarrior for
Microcontrollers V10.x\PROG\piper.exe C:\Program
Files\Freescale\CodeWarrior for Microcontrollers
V10.x\PROG\libmaker.exe -h

This directs all the messages to the DOS shell.

Libmaker Graphic User Interface

The Libmaker Default Configuration window appears when you do not specify a file name
while starting the application. This window contains a menu bar, toolbar, content area, and

status bar.

Figure 13.1 Libmaker Default Configuration Window

Libmaker Default Configuration

File Libmaker Yiew Help

DS 28| ~l& =
A~
v

< ¥

Ready 10:37:40

Libmaker Default Configuration Window

The Libmaker Default Configuration window title displays the application name and
project name. If no project is loaded, Default Configuration appears. An asterisk ( * ) after
the configuration name indicates that some values have changed.
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NOTE Not only option changes, but editor configuration and appearance changes
cause the asterisk ( * ) to appear.

Window Content Area
The content area is a text container that displays logging information about the process
session. This information consists of:
* The name of file being processed
* The name (including full path) of files processed (main C file and all files included)
* A list of error, warning and information messages generated
* The size of code generated during the process session

When you drop a file into the application window content area, the corresponding file
loads as a configuration file if the file has the extension . ini. If not, the file is processed
with the current option settings.

Text in the application window content area displays the following information:
* The file name, including a position inside of file
* A message number

File information is available for text file output. Information is available for all source and
include files and messages. If file information is available, double-clicking on the text or
message opens the file in an editor; as specified in the editor configuration. Also, you can
open a context menu with the right mouse button. The menu contains an Open entry if file
information is available. If a file cannot be opened although a context menu entry is
present, see the Configuration Window Editor Settings Tab section.

The message number is available for any message output. There are three ways to open the
corresponding entry in the help file:

¢ Select one line of the message and press F'/. If the selected line does not have a
message number, F1 displays the main help.

e Press Shift+F1 and then click on the message text. If the text clicked does not have a
message number, this displays the main help.

* Right-click on the message and select Help on. This entry is only available if a
message number is available.

Figure 13.2 Libmaker Help Menu

INFORMATION C4000: C Main Help

Help on "C4000: Condition always iz TRJE"
Open file "fibo.c"
LCopy "INFORMATION C4000: Condition always is TRUE"
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Window Toolbar

The following figure shows the Libmaker Default Configuration window toolbar.

Figure 13.3 Default Configuration Window Toolbar

D2 78 ER it
B B B 1 e T A ..................
Build library :
Command Ljne Options
Context Help Messages
Help Clear
Save :
Load
New

The three icons on the left correspond with File menu entries. The next button opens the
online help. After clicking the Context Help icon (or the shortcut Shift+F1I), the mouse
cursor changes its form and has a question mark beside the arrow. Help is called for the
next item clicked. You can click on menus, toolbar buttons and on the window area to get
specific help.

The command line history contains a list of commands executed. Once you have selected
or entered a command in history, clicking Build library executes the command. You may
use the keyboard shortcut key F2 to jump to the command line. Additionally, there is a
context menu associated with the command line (see Figure 13.4).

The next two icons opens Libmaker Option Settings, and Libmaker Message Settings
dialog box.

The last icon clears the content area.
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Figure 13.4 Command Line Context Menu

‘% Libmaker Default Configuration

File Libmaker view Help
DEHE 2T B =11-
~
Cut
Copy
Paste
Delete
-
4 L3
Ready 15:3%:29

Default Configuration Window Status Bar

Point to a menu entry or icon in the toolbar to display a brief explanation of the button or
menu entry in the message area.

Figure 13.5 Window Status Bar

IRea:Iy' 10:52:4C I
Message Area Current Time

Default Configuration Window Menu Bar

File, Libmaker, View and Help options are available in the menu bar.

Figure 13.6 Window Menu Bar
| File Libmaker view Help

The following table describes the functions available in the menu bar:
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Table 13.1 Menu Bar Functions

Menu entry Description

File Contains entries to manage application configuration files.
Libmaker Contains entries to set application options.

View Contains entries to customize the application window output.
Help A standard Windows Help menu.

Default Configuration Window File Menu

Use the File menu to save or load configuration files.

Figure 13.7 File Menu

E Libmaker View Help
Build Library
Load Configuration Ctrl+0
Save Configuration Ctrl+5
Save Configuration As...
Configuration ...

1 D:W 15project.ini

Exit

A configuration file contains the following information:

Application option settings specified in the application dialog boxes
Message settings that specify which messages to display and treat as errors
List of last command line executed and current command line

Window position

Tip of the Day settings

Configuration files are text files with an extension of . ini. The user can define as many
configuration files as required for the project, and can switch between the different
configuration files using the File > Load Configuration and File > Save Configuration
menu entry, or the corresponding toolbar buttons.
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Table 13.2 File Menu Options

Menu Entry

Description

Build Library

Opens a standard Open File dialog box. Processes selected file as
soon as Open File box is closed with OK.

New/Default
Configuration

Resets application option settings to default value. See Startup
Command Line Options.

Load
Configuration

Opens a standard Open File dialog box. Loads configuration data
stored in selected file and uses it in subsequent sessions.

Save
Configuration

Saves the current settings.

Save
Configuration as

Opens a standard Save As dialog box. Saves current settings in a
configuration file with the specified name.

Configuration

Opens Configuration dialog box to specify editor used for error
feedback and which parts to save with a configuration.

1. project.ini

Recent project list. This list can be accessed to open a recently
opened project.

Closes the application.

Default Configuration Libmaker Menu

The Libmaker menu allows you to customize the application. You can set or reset
application options or define the optimization level you want to reach.

Figure 13.8 Libmaker Default Configuration Libmaker Menu

Table 13.3 Libmaker Menu Functions

Menu Entry

Description

Options

Allows you to customize the application. You can set/reset options.
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Table 13.3 Libmaker Menu Functions (continued)

Menu Entry Description

Messages Opens a dialog box in which you can map error, warning or
information messages to different message classes (see Libmaker
Message Settings Windowy).

Stop Stops the current processing session.

Default Configuration Window View Menu

The View menu allows you to customize the application window. You can specify
whether to display or hide the status or toolbar. You can also define the font used in the
window or clear the window.

Figure 13.9 Libmaker Default Configuration View Menu

Help
v Toalbar
| w Statusbar
g

Clear Log

Table 13.4 View Menu Functions

Menu entry | Description

Toolbar Hide or show toolbar in application window.
Statusbar Hide or show status bar in application window.
Log Allows you to customize output in application window content area.

Change Font Opens a standard font selection box. options selected in font dialog box
are applied to application window content area.

Clear Log Clears application window content area.

Default Configuration Window Help Menu

The Help menu allows you to enable or disable the Tip of the Day dialog box, display the
online help, and an About Libmaker dailog box.
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Figure 13.10 Libmaker Default Configuration Help Menu

Tip of the Day

| Help Topics __|

About ..,

Table 13.5 Help Menu Functions

Menu entry Description

Tip of the Day Enable or disable Tip of the Day dailog box during startup.

Help Topics Displays online help.

About Displays an About Libmaker dialog box with version and
license information.

Configuration Window

The three tabs of the Configuration window let you specify the Editor Settings, Save the
Configuration, and specify the Environment.

Configuration Window Editor Settings Tab

In the Editor Settings tab, select the type of editor to use. Depending on the editor type
selected, the tab content changes.

Editor Settings Tab — Global Editor Option

The following figure shows the Editor Settings tab contents when you choose the Global
Editor option.
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Figure 13.11 Editor Settings Tab — Global Editor Option

Configuration §|

Editor Settings l Save Eonfiguration] Environment]

+ Global Editor [Shared by all Tools and all Projects)
" Local Editor [Shared by all Tools)

™ Editar started with Cammand Line

™ Editor Communication with DDE

" Code/arrior [with COM)

Editar Mame ||DE

Editor Executable |c:\Freesca|e\cw MCU w10.34MC J

Editor Arguments (s 5|

Usze %f for the filename, 21 for the line and %c for the
caolumn.

QK | Cancel | Help |

All tools and projects on one computer share the global editor. Editor information is stored
in the global initialization file MCUTOOLS . INT in the [Editor] section. You can
specify some Modifiers on the editor command line.

Editor Settings Tab — Local Editor Option

The following figure shows the Editor Settings tab contents when the Local Editor
option is chosen:
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Figure 13.12 Editor Settings Tab — Local Editor Option

Configuration §|

Editor Settings l Save Eonfiguration] Environment]

" Global Editor [Shared by all Tools and all Projects)
Local Editor [Shared by all Toolg]

iy

™ Editar started with Cammand Line
™ Editor Communication with DDE
~

Codew!arrior [with COM)

Editar Mame ||DE

Editor Executable |w MU +10.35MCUbinDE. exe J

Editor Arguments (s %) %c

Usze %f for the filename, 21 for the line and %c for the
caolumn.

QK | Cancel | Help |

All tools using the same project file share the local editor. You can specify some
Modifiers on the editor command line.

You can edit the Global and Local Editor configuration. However, when these entries are
stored, the behavior of other tools using the same entries also changes when you start the
tools again.

Editor Settings Tab — Editor Started with Command Line
Option

The following figure shows the Editor Settings tab contents when the Editor started
with Command Line option is selected:
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Figure 13.13 Editor Settings Tab — Editor started with Command Line

Configuration g|

Editor Settings l Save Eonfiguration] Environment]

" Global Editor [Shared by all Tools and all Projects)
Local Editor [Shared by all Toolg]

~
(+ Editar started with Cammand Line
™ Editor Communication with DDE

~

Codew!arrior [with COM)

Command Line

C:\Freescale\Cw MEU v10. 3WMCUNGinADE. exe

Usze %f for the filename, 21 for the line and %c for the
caolumn.

QK | Cancel Help |

Selecting this editor type associates a separate editor with the application to obtain error
feedback.

Enter the command to use to start the editor.

You can start the editor with modifiers. Some Modifiers can be specified on the editor
command line that refer to a file name and a line number (see Modifiers).

Examples: (also refer to notes below)
* For IDF use (with path to 1df . exe file)
C:\prog\idf.exe %$f -g%l1,%c
* For Premia CodeWright V6.0 (with path to cw32 . exe file)
C:\Premia\cw32.exe %f -g%1
* For Winedit 32-bit version use (with path to winedit . exe file)

C:\WinEdit32\WinEdit.exe %f /#:%1

Editor Settings Tab — Editor Communication with DDE
Option

The following figure shows the Editor Settings tab contents when the Editor
Communication with DDE option is selected:
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Figure 13.14 Editor Settings Tab — Editor Communication with DDE

Configuration

Editor Settings ]Sa\re Configuration | Environmert |

" Global Editor (Shared by all Tools and all Projects)
" Local Editor (Shared by all Tools)

" Editor started with Command Line

(+ Editor Communication with DDE

" CodeWarrior {with COM)

Service Name |msdev

Topic Name |system

Client Command |[0D8ﬂ['3"=ﬂ]

Use %f for the filename, % for the line and %c for the
column.

oK | Cancel | Hep |

Enter the service, topic and client name to be used for a DDE connection to the editor.
Entries for Topic and Client Command can have modifiers for file name, line number and
column number as explained below.

Examples:

¢ For Microsoft Developer Studio use the following setting:

Service Name : msdev
Topic Name : system
ClientCommand : [open(%f)]

o UltraEdit is a powerful shareware editor. It is available from www . i dmcomp . com
orwww.ultraedit.com, email 1dm@idmcomp . com. The latest version of
UltraEdit can also be found on the CD-ROM in the addons directory.

For UltraEdit use the following setting:

Service Name : UEDIT32
Topic Name : system
ClientCommand : [open("%$f/%1/%c")]

NOTE  The DDE application (Microsoft Developer Studio, UltraEdit) must be started
or else the DDE communication will fail.
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Modifiers
The configurations can contain modifiers that tell the editor which file to open and at
which line.

¢ The % £ modifier refers to the name of the file (including path) where the message
has been detected.

¢ The $1 modifier refers to the line number where the message has been detected.

* The $c modifier refers to the column number where the message has been detected.

NOTE  The %1 modifier can only be used with an editor that can be started with a line
number as a parameter. This is not the case for WinEdit version 3.1 or lower, or
Notepad. With these editors, you can start with the file name as a parameter
and then select the menu entry Go fo to jump to the line where the message has
been detected. In this case, the editor command looks like:
C:\WINAPPS\WINEDIT\Winedit.EXE %f.Check your editor manual to define the
command line used to start the editor.

Configuration Window — Save Configuration
Tab

The Save Configuration tab of the Configuration dialog box contains options for the
save operation.

Figure 13.15 Configuration Window — Save Configuration Tab

Configuration

Editor Settings Save Corfiguration lEn\ﬂmnment]

ltems to Save
Save

v Options Q
[v Editor Configuration Save As
¥ Appearance (Postion, Size, Fort)

Iv Environment Variables

Iv Save on Exit

Al marked items are saved. Any unchanged items
remain valid.

oK T | Help |
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Use the Save Configuration tab to store selected items in a project file. This tab has the
following items:

* Options: If checked, saves the current option and message settings. Clearing this
option retains the last saved contents.

* Editor Configuration: If checked, saves the current editor settings. Clearing this
option retains the last saved contents.

¢ Appearance: If checked, saves the window position, size, and font used. Also saves
the command line content and history in the project file.

NOTE

After you have saved the options you want, disable the options that you do not
want saved to the Local Configuration File (Usually project.ini) in subsequent
configuration settings. Clear the Save on Exit option to retain settings saved
during a previous configuration.

* Environment Variables: If checked, saves environment variables in the project file.

* Save on Exit: If checked, the application writes the configuration settings on exit
without confirmation. If not checked, the application does not save configuration
changes.

NOTE

NOTE

Almost all settings are stored in the Local Configuration File (Usually
project.ini). The only exceptions are: The recently used configuration list and
All settings in this tab.

Application configuration information can coexist in the same file as the
project configuration for the IDE. When you configure an editor with the shell,
the application can read this information from the project file, if present. The
project configuration file is named project. ini.

Configuration Window — Environment Tab

Use the Environment tab of the Configuration window to configure the environment.
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Figure 13.16 Configuration Window — Environment Tab

Configuration

Various Environment Variables

|${INST:\LLPATH}\Iib\${CP Ulcib

| |Delete| | Down|

$UNSTALLPATHMib\${CP Ulc\ib

S{INSTALLPATHMib S{CF Ulc\src

oK | Cancel | Hep |

The content of the dialog is read from the project file in the section [Environment
Variables]. The following variables are available:

* General Path: GENPATH

¢ Object Path: OBJPATH

¢ Text Path: TEXTPATH

* Absolute Path: ABSPATH

¢ Header File Path: LIBPATH

¢ Various Environment Variables: other variables not covered by the above list.
The following command buttons are available:

* Add: Adds a new line/entry

* Change: changes a line/entry

* Delete: deletes a line/entry

* Up: Moves a line/entry up

* Down: Moves a line/entry down

NOTE  Variables are written to the project file only if you press the Save button, select
File > Save Configuration, or press CTRL+S.
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Libmaker Option Settings Window

The Libmaker Option Settings window allows you to set/reset application options.

Figure 13.17 Libmaker Options Settings Window — Messages Tab

Libmaker, Option Settings ﬁl

Output| Host  Messages |

[w|Don't print INFORMATION messages A
[ 1Dan't print INFDHMAT!DN or WARNING meszages

[TIRGE color for fatal messages
[JRGE colar for information messages
[ IRGE color for user messages
[ JRGE color for warming

AwfmegFblvim]: Set message file format for batch mode

" Verbose format

& Microsoft format [default)

A1 wmezgFbm

ak. | Cancel | Help |

The lower display area shows available command line options. Available options are
arranged in different groups. The content of the list box depends on the selected tab, such
as Messages (not all groups may be available).

Table 13.6 Option Settings Functions

Group Description

Output Lists output file options

Host Lists host options

Messages Lists options that control generation of error messages

Checking the checkbox sets an option. To obtain more detailed information for a specific
option, select the option and press the F/ key or help button. To select an option, click the
option text. If no option is selected, press F'/ or click help button to display help for the
dialog box.
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NOTE  For options that require additional parameters, an edit box or additional
window appears. For example, the option ‘Write statistic output to file’, in the
Output tab.

Libmaker Message Settings Window

This window allows you to map messages to different message classes. A tab is available
for each message group: Disabled, Information, Warning, Error and Fatal.

Each message has a one character identifier (e.g. C for Compiler messages, A for
Assembler messages, L for Linker messages, M for Maker messages, LM for Libmaker
messages) followed by a 4- or 5-digit number. See Libmaker Message List for detailed
information about specific messages.

Figure 13.18 Libmaker Message Settings Window

Libmaker Message Settings

Disabled Information lWarning] Ermor ] Fatal ]

LM2: Message overflow, skipping <kind: messages Move to:
LM54: Option <cmd:: <description: Disabled
LME4: Line Continuation occured in <file: _—
LMES: Ervironment macro expanzsion message < descripti
LMEE: Search path <name> does not exist _—
Waming
Emor

oK | Cancel | Hep |

In this window, some command buttons may be disabled. For example, if a message
cannot be mapped as an Information message, the Move to group Information command
button is disabled when this message is highlighted.

Table 13.7 Message Classes

Message group | Description

Disabled Lists all disabled messages that will not be displayed by the
application.
Information Lists all information messages.
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Table 13.7 Message Classes

Message group

Description

Warning Lists all warning messages. Input file processing continues if a
warning occurs.

Error Lists all error messages. Input file processing continues if an error
occurs.

Fatal Lists all fatal error messages. If a fatal message occurs,

processing stops immediately. Fatal messages cannot be
changed.

Table 13.8 Command Button Functions

Command Button

Description

Move to: Disabled

Disables selected messages

Move to: Information

Selected messages become information messages.

Move to: Warning

Selected messages become warning messages.

Move to: Error

Selected messages become error messages.

Move to: Default

Selected messages revert back to their default mapping.

Reset All Resets all messages to their default.
Ok Exits and accepts changes.

Cancel Exits without accepting changes.
Help Displays online help.

Changing the Class Associated with a Message

Configure your own message mapping by using the buttons located on the right side of the
dialog box. Each button refers to a message class. To change the class associated with a
message, select the message in the list box and then click the button associated with

another class.

NOTE  The Move to buttons are only active for messages that can be moved.

For example, to change a warning message to an error message:
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1. Select the Warning tab to display the list of all warning messages.
2. Select the message you want to change.

3. Click Error to define this message as an error message.
NOTE  Messages cannot be moved to or from the fatal error class.

To validate the new error message mapping, click OK to close the Message Settings
dialog box. If you click Cancel, changes are ignored and the previous message mappings
remain valid.

Retrieving Information About an Error Message

You can access information about each message displayed in the list box. Select the
message in the list box and click the Help button or press the '/ key. An information box
appears, which contains a detailed description of the error message and an example of
code that produces the message. If several messages are selected, help for the first
message is shown. If no message is selected, pressing the F/ key or help button displays
help for this dialog box.

About Libmaker Dialog Box

Select Help > About to display the About box. The about box contains the current
directory and version information for application modules. The main version is displayed
at the top of the dialog.

The Extended Information button displays license information about all software
components in the same directory as the executable. Click OK to close this dialog.

NOTE  During processing, you cannot request other versions of the application
modules. They are only displayed when the application is not processing
information.
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Decoder Utility

Introduction

This section describes the CodeWarrior IDE ELF/Freescale Decoder utility, which
disassembles object files, absolute files and libraries in the Freescale object file format or
ELF/DWAREF format and S-Record files. Various output formats are available.

The chapters in this section are:

* Input and Output Files: Describes Decoder input and output files

¢ Decoder Controls: List menus and the Graphical User Interface (GUI)

Product Highlights

The decoder utility has:
¢ Graphical User Interface (GUI)
¢ On-line Help
¢ Message Management
* 32-bit Functionality
* Decodes Freescale object file format
¢ Decodes ELF/DWAREF 1.1 and 2.0 object file format
* Decodes S-Record files

User Interface

The decoder provides a command line interface and an interactive interface (GUI). If no
arguments are given on the command line, a window opens that prompts for arguments.
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User Interface

The Decoder accepts object or absolute files, libraries, and S-Record files as input to
generate the listing file. The name of the source files are encoded in the object or absolute
file or library. For S-Record files, the processor must be specified with the -Env option
(see -Env: Set Environment Variable).

The generated listing file has the same name as the input file but with extension .LST. It
contains source and assembly statements. The corresponding C/C++ source statements
can be displayed within the generated assembly instructions.
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Input and Output Files

This chapter describes Decoder input and output files, and covers the following topics:

¢ Input Files
* Output Files

Input Files

Input files include the following file types:
* Absolute Files

¢ Object File
* S-Record Files
¢ Intel Hex Files

Absolute Files

The decoder takes any file as input, and does not require the file name to have a special
extension. However, we suggest that all your absolute file names have extension . ABS.
The decoder searches for absolute files first in the project directory and then in the
directories listed in GENPATH. The absolute file must be a valid ELF/DWARF V1.1, ELF/
DWAREF V2.0 or Freescale absolute file.

NOTE  Freescale absolute files do not contain source information, so no source
information is decoded.

Object File

The decoder takes any file as input, and does not require the file name to have a special
extension. However, we suggest that all your relocatable file names have extension . o.
The decoder searches for object files first in the project directory and then in the
directories listed in GENPATH. The object file must be a valid ELF/DWARF V1.1, ELF/
DWAREF V2.0, or Freescale relocatable file.
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S-Record Files

For S-Record files, you must specify the processor with the -Proc option (see -Proc: Set
Processor (Decoder)). Otherwise the structure of the S-Record file prints, but the code is
not disassembled.

Intel Hex Files

For Intel Hex files you must specify the processor with the -Proc option (see -Proc: Set
Processor (Decoder)). Otherwise the structure of the Hex file prints, but the code is not
disassembled.

Output Files

After a successful decoding session, the Decoder generates a listing file containing the
disassembled instructions generated by each source statement. The Decoder writes this
file to the directory given in the environment variable TEXTPATH. If that variable
contains more than one path, the Decoder writes the listing file in the first directory given.
If this variable is not set, the Decoder writes the listing file in the directory containing the
binary input file. Listing files always get the extension . LST.

In a standard listing file, the code depends on the target. A sample listing is as follows:

Listing 14.1 Listing File Example

DISASSEMBLY OF: '.text' FROM 364 TO 448 SIZE 84 (0X54)
Opening source file Y:\Sources\fibo.c'
4: unsigned int Fibonacci (unsigned int n)

Fibonacci:
00000000 89 PSHX
00000001 8B PSHH
00000002 A7F8 AIS #-8
6: unsigned int
fibl = 0;
00000004 95 TSX
00000005 6F01 CLR 1,X
00000007 7F CLR , X
7: unsigned intfib2
00000008 AEO1 LDX #0x01
0000000A 8C CLRH
0000000B 9EFFO03 STHX 3,8P
8: unsigned intfibo
= n;
0000000E 9EFE09 LDHX 9,SP
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00000011
9:
2;
00000014
00000016
00000017
11:
0000001A
12:
fib2;
0000001C
0000001D
0000001F
00000021
00000022
00000023
00000025
00000026
00000027
00000029
0000002A
13:
0000002D
00000030
14:
00000033
00000034
00000035
00000036
15:
00000039
0000003Aa
0000003C
0000003E
11:
00000040
00000043
00000046
18:
00000048
19: }
0000004B
0000004D

9EFF07

AE(02
8C
9EFF05

2024

95
E603
EBOL
87
Fé6
E902
87
95
EEOL
8A
9EFF08

9EFE(04
9EFF02

87
8A
88
9EFF03

95

6C05
2602
6C04

9EFEO09
9EF305
24D4

9EFEO07

A70A
81

STHX

LDX
CLRH
STHX

BRA

TSX
LDA
ADD
PSHA
LDA
ADC
PSHA
TSX
LDX
PULH
STHX

LDHX
STHX

PSHA
PULH
PULX
STHX

TSX
INC
BNE
INC

LDHX
CPHX
BCC

LDHX

ATS
RTS

unsigned int i =

while (i <= n) {
;abs = 0x0040
fibo = fibl +

fibl

£ib2;

fib2 = fibo;

1+4+;

;abs = 0x0040

while (i <= n) {

;abs = 0x001C
return (fibo) ;
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Decoder Controls

This chapter describes Decoder controls; list menus and the Graphical User Interface
(GUI).

This chapter is comprised of the following sections:
* List Menus

¢ Graphical User Interface

¢ Specifying the Input File

* Message and Error Feedback

List Menus

The Decoder list menus are on the menu bar of the Decoder main window. The following
table lists and describes the main window’s top-level list menus.

Table 15.1 Decoder Main Window List Menus

Menu Name Contains

File Options for managing configuration files
Decoder Commands for setting options

View Options for customizing window output
Help Standard Windows Help menu

File Menu

With the File menu as shown in the following figure, you can save or load configuration
files. The File menu contains:

* Configuration dialog box on settings.
* Message settings that specify which messages to display and which to treat as errors.
 List of last commands executed and current command line

* Window position
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* Tip of the Day settings, including whether the Tip of the Day is enabled at startup

and current entry

Figure 15.1 File Menu

Decoder Yiew Help

Decode

Mew [ Defaulk Configuration  Cerl-+n
Load Configuration Chr+0
Save Configuration Ctr+a

Save Configuration As...
Configuration ...

Exit

The following table lists and describes the File menu selections:

Table 15.2 File Menu Selections

Menu Selection

Description

Decode Opens the Select File to Decode dialog box. Processes
selected file as soon as the Select File to Decode dialog
box is closed using OK.

New/Default Resets option settings to default value. Default options are

Configuration specified in Tool Options.

Load Configuration

Opens the Loading configuration dialog box. Loads
configuration data stored in selected file and uses it in
session.

Save Configuration

Saves the current settings.

Save Configuration as

Opens the Save Configuration as dialog box. Saves
current settings in a configuration file with the specified
name.

Configuration

Opens the Configuration dialog box to specify the editor to
use for error feedback and which parts to save with a
configuration.

1. project.ini

Recent project list. Access to reopen a recently opened
project.

Closes the Decoder.
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Decoder Menu

With the Decoder list menu, as shown in the following figure, you can customize the
Decoder, graphically set or reset options, and access message settings.

Figure 15.2 Decoder Menu

Decoder [RUE
Options
Messages

The following table lists and describes the Decoder menu selections.

Table 15.3 Decoder Menu Selections

Menu entry Description

Options Displays the Decoder Option Settings dialog box, where you can
define options for processing an input file.

Messages Opens the Decoder Message Settings dialog box, where you can
map error, warning or information messages to another message
class.

View Menu

With the View Menu (as shown in the following figure), you can customize the main
window. You can choose whether to display or hide the status bar and the toolbar, choose
the font used in the window, and clear the window.

Figure 15.3 View Menu

View Help

v Toolbar
v Statusbar

The following table lists and describes the View menu selections.

Table 15.4 View Menu Selections

Menu Entry

Description

Tool Bar

Displays toolbar in the main window.

Status Bar

Displays status bar in the main window.

Log

Lets you customize the output in the main window content area.
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Table 15.4 View Menu Selections (continued)

Menu Entry | Description

Change Font Opens a standard font-selection dialog box. Your selections appear in
the main window content area.

Clear Log Lets you clear the main window content area.

Help Menu

From the Help menu (as shown in the following figure), you can customize the Tip of the
Day dialog box and display help, Decoder version information, and license information.

Figure 15.4 Help Menu

Help
Tip of the Day

About ... !

The following table lists and describes the Help menu selections.

Table 15.5 Help Menu Selections

Menu entry Description

Tip of the Day Switches on or off the Tip of the Day dialog box display during
startup.

Help Topics Displays standard Help.

About Displays an About Decoder dialog box with version and license
information.

Graphical User Interface

This section describes important aspects of the Decoder graphical user interface (GUI).
Windows and dialogs covered here are:

¢ Decoder Main Window

* Configuration Dialog Box
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Decoder Main Window

The Decoder main window appears if you do not specify a file name on the command line.

If you start a tool using the Decoder, the Decoder main window does not appear.

Figure 15.5 Decoder Main Window

i BDecoder Default Configuration

File Decoder Wew Help

DSHE 28| ~l& =
A~
v

< ¥

Ready 11:01:02

Main Window Components

The following sections describe the Decoder main window components.

Window Title

The window title displays the tool name and project name. If no project is loaded,
Decoder Default Configuration displays in the title area. An asterisk ( * ) after the

configuration name indicates you have an unsaved change.

Toolbar

The following figure shows main window toolbar buttons.
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Figure 15.6 Decoder Main Window Toolbar Buttons

O | 7 8| |fboabs 2P A=
A T T
Command Line
Context Help Decode
Options Settings
Ontine Helo Message Settings
Save the Current Configuration Clear Log

Load a Configuration

New Configuration

The following table lists the Decoder main window toolbar buttons and describes their
functions.

Table 15.6 Main Window Toolbar Buttons

Button Name Function

New Same as the File > New / Default Configuration menu
selection.

Load Same as the File > Load Configuration menu selection.

Save Same as the File > Save Configuration menu selection.

Help Displays Decoder online help.

Context Help Changes cursor to question mark. When you have the cursor

over a Decoder screen area, right-click, the context-sensitive
help appears for the area you selected.

Command Line Displays a context menu associated with the command line.
Decode Starts execution of a desired command.
Options Displays the Decoder Option Settings dialog box.
Messages Displays the Decoder Message Settings dialog box.
Clear Clears the main window content.
Status Bar
The status bar (Figure 15.7) has two dynamic areas:
* Messages
e Time
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When you point to a button in the toolbar or a menu entry, the message area displays the
function of the button or menu entry.

The time field shows the start time of the current session (if one is active) or current
system time.

Figure 15.7 Main Window Status Bar

Ready 16:21:17
Message Area Current Time

Decoder Configuration Dialog Box

Select File > Configuration from the Decoder menu bar, to display the Configuration
dialog box. The Configuration dialog cox has three tabs:

» Editor Settings
* Save Configuration

¢ Environment

Editor Settings Tab

The following figure shows the Configuration dialog box with the Editor Settings tab
selected.
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Figure 15.8 Decoder Configuration Window - Editor Settings Tab

Configuration ﬁ|

Editar Settings l Save Eonfiguration] Environment]
+ Global Editor [Shared by all Tools and all Projects)
" Local Editor [Shared by all Tools)
™ Editar started with Cammand Line
™ Editor Communication with DDE
~

Codew!arrior [with COM)

Editar Mame ||DE

Editor Executable |c:\Freesca|e\cw MCU w10.34MC J

Editor Arguments (s 5|

Usze %f for the filename, 21 for the line and %c for the
caolumn.

QK | Cancel | Help |

The following table lists and describes the Editor Settings tab controls.

Table 15.7 Editor Settings Tab Controls

Control Function

Global Editor Shared among all tools and projects on one computer and stored
in the MCUTOOLS.INI global initialization file.

Local Editor Shared among all tools using the same project file.

Editor started with Enable command-line editor. For Winedit 32-bit version use the
Command Line winedit.exe file C:\WinEdit32\WinEdit.exe%f /#:%1

Editor started with Enter service, topic and client name to be used for a DDE
DDE connection to editor. All entries can have modifiers for file name
and line number.

CodeWarrior (with If selected, the CodeWarrior software registered in the Windows
COM) Registry launches.

Editor Name Enter a name for the desired editor in the text box.
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Table 15.7 Editor Settings Tab Controls (continued)

Control Function

Editor Executable Specify editor’s path and executable name. Use the browse
button to locate the executable.

Editor Arguments Enter the command-line arguments for the editor in the text box.
Use 3£ for filename, %1 for line number, and %c for column
number.

Save Configuration Tab

The following figure shows the Configuration dialog box with the Save Configuration
tab selected.

Figure 15.9 Decoder Configuration Dialog Box - Save Configuration Tab

Configuration

Editor Settings  Save Configuration ]Envimnment]

ltems to Save
Save

[v Options 4
[v Editor Corfiguration Save As

Iv¥ Appearance (Posttion, Size, Font)

¥ Environment Variables

[¥ Save on Exit

All marked items are saved. Any unchanged items
remain valid.

oK | Cancel | Hep |

The following table lists and describes the Save Configuration tab controls.
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Table 15.8 Save Configuration Tab Controls

Control

Function

Options

When checked, saves current option and message settings when a
configuration is written. When cleared, last saved content remains
valid.

Editor
Configuration

When checked, saves current editor settings when a configuration is
written. When cleared, the last saved content remains valid.

Appearance

When checked, window position, command line content, and history
settings are retained when a configuration is written.

Environment
Variables

When checked, writes the environment variable settings in the
Environment Tab to the configuration.

Save on Exit

When checked, Decoder writes configuration on exit. No confirmation
message appears. When cleared, Decoder does not save
configuration on exit, even if options or another part of configuration
has changed. No confirmation message appears when closing
Decoder.

NOTE  Settings are stored in the configuration file. Exceptions are recently used
configuration list and settings in this dialog. Configurations can coexist in the
same file as the shell project configuration. When the shell configures an
editor, the Decoder can read the content from the project file. The shell project
configuration filename is project.ini.

Environment Tab

The following figure shows the Configuration dialog box with the Environment tab

selected.
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Figure 15.10 Decoder Configuration Window - Environment Tab

Configuration

Absolute Path
Header File Path
Various Environment Variables

|${INSTALLF‘ATH}\Iib\${CF‘ UkeNib

| | Delete

| Down|

SINSTALLPATHMibASICP U c\ib
S{INSTALLPATHMib S{CF Ulc\src

oK | Cancel | Hep |

Use the Environment tab to configure the environment. The content of the tab is read
from the project file in the [Environment Variables] section. You can choose
from the following environment variables:

General Path: GENPATH
Object Path: OBJPATH
Text Path: TEXTPATH
Absolute Path: ABSPATH
Header File Path: LIBPATH

Various Environment Variables: other variables not covered in this list

The following table lists and describes the Environment tab controls.

Table 15.9 Environment Tab Buttons

Button Function

Add Adds a new line/entry
Change Changes a new line/entry
Delete Deletes a new line/entry
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Table 15.9 Environment Tab Buttons (continued)

Button Function
Up Moves a line/entry up
Down Moves a line/entry down

Decoder Option Settings

The Decoder Option Settings dialog box appears when you select Decoder > Options
from the Decoder menu bar. Click on the text in the list box to select an option. For help,
select an option and press F/. The command-line option in the lower part of the dialog box
corresponds with your selection in the list box.

NOTE  When options requiring additional parameters are selected, a dialog box or
window may appear.

Figure 15.11 Decoder Options Settings Window

Decoder Option Settings

Output | Input | Host ~ Messages ]

Show nobification box i case of erors HPS
Mo beep in caze of an eror

Don't print INFORMATION messages

Don't print INFORMATION or WARMING meszages

Create "em.log" Ermor File

Cut file names in Microsoft format to 8.3

RGE color for eror messages

RGE color for fatal messages

RGE color for information messages

RGE color for user messages b

oK | Cancel | Hep |

The following table describes the tabs in the Decoder Option Settings dialog box.
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Table 15.10 Option Settings Window Tabs

Tab Description

Output Command-line execution and print output settings

Input Macro settings

Host Lists options related to the host operating system

Messages Message-handler settings - format, kind, and number of printed
messages

Message Settings Window

The Decoder Message Settings dialog box (Figure 15.12) appears when you select
Decoder > Messages from the menu bar. Using this dialog box you can map messages to
different message classes.

Each message has its own ID (a character followed by a 4- or 5-digit number). This
number allows you to search for the message in the manual and online help. For more
information about specific messages, see Decoder Message List.

Figure 15.12 Message Settings Window

Decoder Message Settings

Disabled Information lWarning] Ermor ] Fatal ]

s Move to:
D54: Option <cmd:: Tiptior:: Disabled
DE64: Line Continuation occured in <file: _
DB Environment macra expansion message '<descriptior
DEE: Search path <name> does not exist _—
[01001: Because current proceszar iz unknown, no dizass Warming
Emor

oK | Cancel | Hep |

The following table describes the tabs in the Decoder Message Settings dialog box.
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Table 15.11 Message Settings Window Tabs

Message Group | Description

Disabled Lists disabled messages. Messages displayed in the list box are
not written to the output stream.

Information Lists information messages. Information messages inform you of
actions taken.

Warning Lists warning messages. When a warning message is generated,
processing of the input file continues.

Error Lists error messages. When an error message is generated,
processing of the input file stops.

Fatal Lists fatal error messages. These messages report system
consistency errors. Fatal error messages cannot be ignored or
moved.

Changing a Message Class

You can map messages to different classes using one of the buttons on the right side of the
dialog box. Each button refers to a message class. To change the class associated with a
message, select the message in the list box and then click the button corresponding with
the desired message class.

Example

To define message D51 could not open statistic log f£ile (warning message)

as an error message:

1. Select the Warning tab.

A list of warning messages appears in the list box.

2. Select the message D51 could not open statistic log f£ile in the list box.

3. Click the Error button to define the message as an error message.

NOTE  You cannot move the messages to or from the Fatal error class.

NOTE  The Move to buttons are active only when you select messages that can be
moved. When you select a message, only the valid Move to buttons becomes

active.
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To validate the changes made in the error message mapping, click OK to close the
Decoder Message Settings dialog box. If you click the Cancel button, the previous
message mapping remains valid.

Retrieving Information about an Error Message

You can access information about each message in the list box. Select the message in the
list box, then click Help. An information box opens which contains a more detailed
description of the error message as well as a small example of code that could produce the
error. If you select several messages, help for the first message displays. If you select no
message, pressing F'/ shows help for the dialog box.

About Decoder Dialog Box

The About Decoder dialog box appears when you select Help > About from the menu
bar. This dialog box shows the current directory and the versions of Decoder components,
with the version displayed at the top of the dialog box. Click OK to close the dialog box.

Specifying the Input File

The following list explains the different ways to specity the decode file to be processed.
During processing, the software sets options according to the configurations specified in
Decoder windows.

NOTE  Before starting the decoding process of a file, use your editor to specify a
working directory.

¢ Use the command line in the toolbar to Decode

You can use the command line to process files. The command line lets you enter a
new file name and additional Decoder options.

* Processing a File Already Run

You can display the previously executed command using the arrow at the right of the
command line. Select a command by clicking it, which puts it on the command line.
The software processes the file you choose after you click the Decode button in the
toolbar or press the Enter key.

¢ File > Decode

When you select File > Decode, a standard open file dialog box displays. Browse to
the file you want to process. The software processes the file you choose after you
click the Decode button in the toolbar or press the Enter key.

* Drag and Drop
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You can drag a file from other programs (such as the File Manager or Explorer) and
drop it into the Decoder main window. The software processes the dropped file after
you release the mouse button.

If the dragged file has a . ini extension, it is loaded and treated as a configuration
file, not as a file to be decoded.

Message and Error Feedback

After making, there are several ways to check for different errors or warnings. The format
of an error message is:

<msgType> <msgCode>: <Message>

The following listing shows the examples of error message format.

Listing 15.1 Error Message Format Examples

Examplel
Could not open the file 'Fibo.abs'
FATAL D50: Input file 'Fibo.abs' not found

Example2
*** command line: 'Fibo.abg' ***
Decoder: *** Error occurred while processing! ***

The second example shows that messages from called applications are also displayed, but
only if an error occurs. They are extracted from the error file if the called application
reports an error.

Using Information from the Main Window

Once a file has been processed, the Decoder window content area displays the list of
detected errors or warnings. Use the editor of your choice to open the source file and
correct the errors.

Using a User-Defined Editor

You must first configure the editor you want to use for the message or error feedback in
the Configuration dialog box. Once a file has been processed, you can double-click on an
error message. Your selected editor opens automatically and points to the line containing
the error.
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This section describes the IDE Maker Utility. Maker implements the UNIX make
command with a Graphical User Interface (GUI). In addition, you can use Maker to build
Modula-2 applications as well as maintain C/C++ projects. Maker has:

¢ Online Help
* Flexible Message Management
¢ 32-bit functionality
This section consists of the following chapters:
* Maker Controls: Describes Maker controls, menus and the Graphical User Interface.

» Using Maker: Describes using Maker to build Modula-2 applications and to maintain
C/C++ projects.

¢ Building Libraries: Describes how to use the Maker utility to adapt or build your own
libraries.

Starting the Maker Utility

All of the utilities described in this book may be started from executable files located in
the Prog folder of your IDE installation. The executable files are:

* maker.exe: Maker, The Make Tool

* burner.exe: The Burner Utility

* decoder.exe: The Decoder

e libmaker.exe: Libmaker

¢ linker.exe: The SmartLinker Utility

With a standard full installation of the HCO8/RS08 CodeWarrior IDE, the executable files
are located here:

<CWIlnstallDir>\MCU\prog
For S127Z derivatives, the executable files are located at:

<CWilnstallDir>\MCU\S121lisa_Tools
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where <CWInstallDir> is the directory where the CodeWarrior software is installed.

To start the Maker Utility, double-click on maker . exe.
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Maker Controls

This chapter describes Maker controls, such as menus and the Graphical User Interface
(GUI), and contains the following sections:

¢ Graphical User Interface
¢ Specifying the Input File

* Message and Error Feedback

Graphical User Interface

This section describes important aspects of Maker’s Graphical User Interface (GUI). This
section covers these windows and dialogs:

¢ Maker Main Window

* Maker Configuration Window

Maker Main Window

The Maker main window appears if you do not specify a file name on the command line.
If you start a tool using Maker, the Maker main window does not appear.
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Figure 16.1 Maker Main Window

i Maker Default Configuration

File Maker Wiew Help

DS 28| ~j& x| F =R
A~
v

< ¥

Ready 11:05:31

Main Window Components
The Maker main window has these components:

* Window title

e Menu bar

* Toolbar

* Content area

¢ Status bar

Window Title

The window title displays the tool name and the project name. If Maker has no loaded
project, Maker Default Configuration appears in the title area. An asterisk ( * ) after the
configuration name indicates that you have unsaved changes.

Maker Main Window Menu Bar

Maker menus are on the menu bar of the main window. The following table describes
Maker’s top-level menus.
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Table 16.1 Maker List Menus

Menu Name Contains
File Selections for managing configuration files
Maker Selections for setting options
View Selections for customizing window output
Help Standard Windows Help menu

File Menu

Use the File Menu to save or load configuration files. Configuration files contain:
* Configuration dialog option settings.
* Message settings that specify which messages to display and which to treat as errors.
* A list of the last command line executed and the current command line.
* The window position.

» Tips of the Day settings, including the startup settings and the current entry.

Figure 16.2 File Menu

File Maker View Help
Make
Mew [ Default Ccnnﬁguraﬁcn* Cirl+M
Load Configuration Ctrl+0
Save Configuration Ctrl+5
Save Configuration As...
Configuration ...

1 project.ini

Exit

The following table describes File menu selections.

Table 16.2 File Menu Selections

Menu Selection Description

Make Opens the Select file to make dialog box. Maker processes
the selected file after you click OK to close the Select file to
make dialog box.

New/Default Resets the option settings to default values. Tool Options
Configuration specifies the default activated options.
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Table 16.2 File Menu Selections (continued)

Menu Selection

Description

Load Configuration

Opens the Loading configuration dialog box. Future
sessions load and use the configuration data stored in the
selected file.

Save Configuration

Saves the current settings.

Save Configuration as

Opens the Saving Configuration as dialog box. Maker
saves the current settings in a configuration file with the
specified name.

Configuration

Opens the Configuration dialog box to specify the editor to
use for error feedback and the parts to save with a
configuration.

1. project.ini

Recent project list. Access this list to open a recently used
project again.

Closes the Maker.

Maker Menu

With the Maker menu you can customize Maker, graphically set or reset options, and

access message settings.

Figure 16.3 Maker Menu

Table 16.3 Maker Menu Selections

Maker View Help

Options

The following table describes Maker menu selections.

Menu entry

Description

Options Displays the Maker Options Settings dialog box in which you can
define options for processing an input file.
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Table 16.3 Maker Menu Selections (continued)

Menu entry Description

Messages Opens the Maker Message Settings dialog box in which you can
map error, warning, or information messages to different message
classes.

Stop Making Stops the current Make process. Maker grays out this selection when

no active Make process exists.

View Menu

With the View menu you can customize the main window. You can choose the font used
in the window, specify whether Maker displays or hides the status bar and the toolbar, and
clear the window.

Figure 16.4 View Menu

View Help
v Toolbar
v Statusbar

Log 3
Clear Log

The following table describes View menu selections.

Table 16.4 View Menu Selections

Menu entry Description

Toolbar Toggles display of the toolbar in the main window.

Statusbar Toggles display of the status bar in the main window.

Log Lets you customize the output in the main window content area.

Change Font Opens a standard font-selection dialog. Your selections appear in the
main window content area.

Clear Log Clears the main window content area.

Help Menu

From the Help menu you can customize the Tip of the Day dialog box. Use this menu to
display Windows help as well as Maker version and license information.
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Figure 16.5 Help Menu

Help
Tip of the Day

The following table describes Help menu selections.

Table 16.5 Help Menu Selections

Menu entry Description

Tip of the Day Toggles display of a Tip of the Day dialog box during
startup.

Help Topics Displays standard Help.

About Displays About Maker dialog box with version and license
information.

Maker Main Window Toolbar

The Maker Main window toolbar icons are shown in the following figure.

Figure 16.6 Maker Main Window Toolbar Icons

== W Y dl emo. mak w1 Ik K = | =
Command Line T T
Context Help Make
Help Stop .
S ave Options
Load Messages
M ewr Clear

The following table lists the Maker main window toolbar buttons and describes their
functions.

Table 16.6 Main Window Toolbar Icon

Icon Name Function

New Same as File > New Configuration menu selection.
Load Same as File > Load Configuration menu selection.
Save Same as File > Save Configuration menu selection.
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Table 16.6 Main Window Toolbar Icon (continued)

lcon Name Function
Help Displays Maker online help.
Context Help Changes the cursor to a question mark. When you hover your

cursor over a Maker screen area and left-click, the context-
sensitive help appears for the area you selected.

Command Line Displays Make files and options associated with the command
line.

Make Starts the execution of a desired command.

Stop Stops the current make process.

Options Displays the Maker Option Settings dialog box.

Messages Displays the Maker Message Settings dialog box.

Clear Clears the main window content.

Maker Main Window Status Bar

The Maker Main window status bar has two dynamic areas:
* Messages
¢ Time

When you point to an icon on the toolbar or to a menu entry, the message area displays the
function of the button or menu entry.

The time field shows the start time of the current session (if an active session exists) or the

current system time.

Figure 16.7 Main Window Status Bar

Ready 11:08:38

Mlessage Area Current Time

Maker Configuration Window

When you select File > Configuration from the Maker Main window list menus, the
Configuration dialog box appears. The Configuration dialog box has three tabs:

» Editor Settings Tab

¢ Save Configuration Tab
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¢ Environment Tab

Editor Settings Tab

The following figure shows the Configuration dialog box with the Editor Settings tab
selected.

Figure 16.8 Configuration Dialog Box — Editor Settings Tab

Configuration g|
Editor Settings l Save Eonfiguration] Environment]
+ Global Editor [Shared by all Tools and all Projects)
" Local Editor [Shared by all Tools)
™ Editar started with Cammand Line
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Editar Mame ||DE

Editor Executable |c:\Freesca|e\cw MCU w10.34MC J

Editor Arguments (s 5|

Usze %f for the filename, 21 for the line and %c for the
caolumn.

QK | Cancel | Help |

The following table describes Editor Settings tab controls.

Table 16.7 Editor Settings Tab Controls

Control Function

Global Editor Shared among all tools and projects on one computer. The
MCUTOOLS . INT global initialization file stores the global editor.

Local Editor Shared among all tools using the same project file.

Editor started with | Enable command-line editor starting. For Winedit 32-bit version use
Command Line the winedit.exe file C: \WinEdit32\WinEdit.exe%f /#:%1

Editor started with | Enter service, topic, and client name to use for DDE connection to

DDE editor. All entries can have modifiers for file name and line number.
CodeWarrior If selected, the CodeWarrior IDE version registered in the Windows
(with COM) Registry launches.
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Table 16.7 Editor Settings Tab Controls (continued)

Control Function

Editor Name Enter name of desired editor in this text box.

Editor Executable | Specify editor’s path and executable name. Use browse button to
locate executable file.

Editor Arguments Enter command-line arguments for editor in this text box. Use % £
for filename, %1 for line number, and %c for column number.

NOTE  Changing the Editor Selection option button settings in this window changes
the entries in the text entry fields at the bottom of the dialog box.

Save Configuration Tab

The following figure shows the Configuration dialog box with the Save Configuration
tab selected.

Figure 16.9 Configuration Dialog Box — Save Configuration Tab

Configuration

Editor Settings  Save Configuration ]Envimnment]

ltems to Save
Save
[v Options
[v Editor Corfiguration Save As

Iv¥ Appearance (Posttion, Size, Font)

¥ Environment Variables

[¥ Save on Exit

All marked items are saved. Any unchanged items
remain valid.

oK | Cancel | Hep |

The following table describes the Save Configuration tab controls.
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Table 16.8 Save Configuration Tab Controls

Control Function

Options When checked, Maker saves current option and message settings to
configuration file. When cleared, last saved content remains valid.

Editor When checked, Maker saves current editor setting to configuration
Configuration file. When cleared, last saved content remains valid.
Appearance When checked, Maker saves window position, command-line content,

and history settings to configuration file. When cleared, last saved
content remains valid.

Environment When checked, Maker saves environment variable settings in
Variables Environment Tab to the configuration file. When cleared, last saved
content remains valid.

Save on Exit When checked, Maker saves the configuration file on exit. No
confirmation message appears. When cleared, Maker does not save
configuration file on exit, even if you change options or another part of
the configuration file. No confirmation message appears when closing
Maker.

NOTE  Maker stores settings in the configuration file, with the exception of the
recently used configuration list and the settings in this dialog box.
Configurations can coexist in the same file as the shell project configuration.
When the shell configures an editor, Maker can read the content from the
project file. The shell project configuration filename is project. ini.

Environment Tab

Use the Configuration dialog box with the Environment tab selected to configure the
environment.
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Figure 16.10 Configuration Dialog Box — Environment Tab

Configuration

Editor Settings | Save Configuration  Environmet ]

Object Path

Text Path

Absolute Path

Header File Path

Various Environment Variables

|${INSTALLP&TH}\Iib\${CP UjeNib

| | Delete

| Dcwr1|

S{NSTALLPATHNib\S{CP Ulc\ib
SINSTALLPATHMib\S{CP Ukc'\src

oK | ol | Heb |

Maker reads the content of the dialog from the [Environment Variables] section
of the actual project file. You can choose from these environment variables:

¢ General Path: GENPATH

¢ Object Path: OBOPATH

¢ Text Path: TEXTPATH

¢ Absolute Path: ABSPATH

¢ Header File Path: LIBPATH

* Various Environment Variables: other variables not covered in this list

The following table lists and describes the Environment tab controls.

Table 16.9 Environment Tab Buttons

Button Function

Add Adds a new line/entry
Change Changes a new line/entry
Delete Deletes a new line/entry
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Table 16.9 Environment Tab Buttons (continued)

Button Function
Up Moves a line/entry up
Down Moves a line/entry down

Tip of the Day Dialog Box

When you start the tool, a Tip of the Day dialog box displays a randomly selected user tip.

The Next Tip button lets you read the next hint. If you don’t want the Tip of the Day
dialog box to open when the program starts, clear the Show Tips on StartUp checkbox.
Click Close to close the Tip of the Day dialog box.

NOTE  The local project file stores user configurations.

Maker Option Settings Dialog Box

The Option Settings dialog box appears when you select Maker > Options from the menu
bar. Click once on the text in the list box to select an option. For help, select an option and
press F1. The command-line option in the lower part of the dialog box corresponds to your
selection in the list box. For more information on Maker options, see Tool Options.

NOTE  When you select options requiring additional parameters, a dialog box or
subwindow may appear.

242

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual




Maker Controls
Graphical User Interface

Figure 16.11 Maker Option Settings

Maker Option Settings

Output | Input | Host ~ Messages ]Modula-z

Mo beep in caze of an error
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[]Cut file names in Microzoft format to 8.3
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CIRGE color for fatal messages

[IRGR raler Far infrrmnatinn mescanes

ok | Cancsl | Help

The following table describes the tabs in the Maker Option Settings dialog box.

Table 16.10 Option Settings Dialog Box Tabs

Tab Description

Output Command-line execution and print-output settings.

Input Macro settings.

Host Lists options related to the host operating system.

Messages Message-handler settings, such as format, kind, and number of printed
messages.

Modula-2 Modula-2 make-specific options (not relevant for C users).

Maker Message Settings Dialog Box

The Message Settings dialog box appears when you select Maker > Messages from the
list menus. This dialog box lets you map messages to different message classes.

Each message has its own ID (a character followed by a 4- or 5-digit number). This
number allows for message look-up both in the manual and in the online help. For
information about specific messages, see Makefile Messages.
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Figure 16.12 Message Settings Window

Maker Message Settings
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The following table describes the tabs in the Message Settings dialog box.

Table 16.11 Message Settings Dialog Box Tabs

Message Description
Group
Disabled Lists disabled messages. Maker does not write the messages displayed

in the list box to the output stream.

Information Lists information messages. Information messages inform you of
actions taken.

Warning Lists warning messages. When Maker generates a warning message, it
continues processing the input file.

Error Lists error messages. When Maker generates an error message, it
stops processing the input file.

Fatal Lists fatal error messages. These messages report system consistency
errors. You cannot ignore or move fatal error messages.

Changing a Message Class

You can map messages to different classes using one of the buttons at the right of the
dialog box. Each button refers to a message class. To change the class associated with a
message, select the message in the list box and then click the button corresponding with
the desired message class.
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Example

To define message M5116 could not delete file (a warning message) as an error
message, follow these steps:

1. Select the Warning tab
A list of warning messages appears in the list box.
2. Select the message M5116 could not delete file in the list box.

3. Click the Error button to define the message as an error message.

NOTE  You cannot move messages from or to the Fatal error class. Maker only
enables the Move to buttons when you select movable messages. If you try to
move a message to an impermissible group, Maker grays out the impermissible
move to button.

To save the modification you performed in the error message mapping, click OK to close
the Maker Message Settings dialog box. If you click Cancel to close the dialog box, the
previous message mapping remains valid.

Retrieving Information about an Error Message

You can access information about each message in the list box. Select the message in the
list box, then click Help. An information box opens, which contains a detailed description
of the error message as well as a small example of code producing it. If you select several
messages, help for the first message appears. If you select no message, pressing F'/ shows
the help for the dialog box.

About Maker Dialog Box

The About Maker dialog box appears when you select Help > About from the menu bar.
This dialog box shows the current directory and the Maker component versions. The
Maker version appears separately at the top of the dialog box. Click OK to close the
dialog box.

NOTE  During a Make process, Maker component versions do not appear. Maker must
be idle in order for versions to appear.

Specifying the Input File

You can use several different ways to tell the make file to process. During processing, the
software sets options according to the configurations that you specified in Maker dialogs.
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Before starting to process a make file, specify a working directory using your editor.
¢ Use the Toolbar Command Line to Make

Use the command line to process files. The command line lets you enter a new file
name and additional Maker options.

* Processing a File Already Run

You can display the previously executed command using the arrow at the right of the
command line. Select a command by clicking it, which puts it on the command line.
The software processes the file you choose after you click the Make button in the
toolbar or after you press the Enter key.

¢ File > Make

When you select File > Make from the menu bar, the Select file to make dialog box
appears. Navigate and select the file you want to process. The software processes the
file you choose after you click the Make button in the toolbar or press the Enter key.

¢ Drag and Drop

You can drag a file from other software (such as the File Manager or Explorer) and
drop it into the Maker main window. The software processes the dropped file after
you release the mouse button.

If the dragged file has the . ini extension, Maker loads and treats it as a
configuration file, not as a makefile. To process a makefile with an . ini extension,
use another method to run it.

Message and Error Feedback

After making, there are several ways to check where Maker detected different errors or
warnings. The format of an error message looks like this:

<msgType> <msgCode>: <Message>

Examples
ERROR M5102: input file not found

ERROR M5112: called application: “ERROR C1011: Undeclared
enumeration tag”

The second example shows that Maker also displays messages from called applications,
but only if an error occurs. Maker extracts the messages from the error file if the called
application reports an error.
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Using Information from the Main Window

After Maker processes a file, the Maker window content area displays a list of detected
errors or warnings. Use the editor of your choice to open the source file and correct the

€ITors.

Using a User-Defined Editor

You must first configure the editor you want to use for message or error feedback in the
Configuration dialog box. After Maker processes a file, you need only double-click an

error message to open your selected editor automatically and point to the line containing
the error.
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Using Maker

With Maker you can build Modula-2 applications as well as maintain C/C++ projects.
Maker syntax is a subset of the UNIX Make command.

This chapter covers the following topics:
* Making Modula—2 Applications

* Making C Applications
¢ User-Defined Macros (Static Macros)

¢ Directives and Special Targets

Making Modula-2 Applications

To make a Modula-2 application, enter the name of the main module at the input prompt
(or the command line). First, Maker collects dependencies given by the IMPORT clauses
in the source files of both implementation and definition modules. Second, Maker
recompiles files modified since the last compilation. Third, Maker tries to link the
application.

The Make utility needs three environment variables:
LINK: Linker for Modula-2 — Defines the linker program
COMP: Modula-2 Compiler — Defines the compiler

FLAGS: Options for Modula-2 Compiler — Defines the compiler options for the compiler
given in COMP

These variables are necessary only when you use the Maker to build a Modula-2
application, not for makefile processing (although you can use them as macros, as
described later in this chapter).

Making C Applications

Since in C you cannot always deduce dependencies between files by looking at the source
files, automatic make (as with Modula-2 applications) is not possible. However, if you
describe these dependencies in a file, Make can process this makefile and build, or rebuild,
a C application.
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Using Makefiles

This section gives a short introduction to writing and using makefiles. If you already know
UNIX-style make utilities, you probably already know most of what follows. If you have
been working until now with Microsoft Make, we strongly recommend that you read this
section.

Syntax of Makefiles

Makefile syntax is as follows:

MakeFile = {Entry | Directive}.

Entry = {Macro | Update | Rule}.

Macro = Name {"="|"+="|"=+"} Line NL.

Update = Name ":" [Name {[","] Name}] NL {Command}.
Command = WhiteSpace {WhiteSpace} Line NL.

Rule = "." Suffix ["." Suffix] ":" NL {Command}.
Directive = INCLUDE Name NL.

WhiteSpace = " "|["\t".

NL = "\n".

Line = {<any char except un-escaped linebreaks>}.
Name = <any valid file name>.

Suffix = Letter [Letter] [Letter].

Letter = any letter from "A" to "Z" or from "a" to "z">.

Case Sensitivity

By default, Maker is case-sensitive. However, if you set the —C option, Maker treats
uppercase and lowercase letters the same.

Line Breaks

Processing a makefile is a line-oriented job because you use a linebreak to terminate most
constructs, such as macro definitions or dependency lists. If you want Make to ignore a
linebreak, place a backslash (“\”’) immediately before the linebreak. Make then reads the
combination of backslash and linebreak as one single blank. You cannot use a line
continuation to enlarge comment lines.
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Comments

Comments in a makefile start with the number sign (#) and end with the next linebreak.

Dependencies

Makefile update entries determine dependencies between files. Such an update entry has
the form:

target file: {dependency file} {command line}

This entry tells HI-CROSS Make that the target file depends on all the dependency files.
If any of the dependency files changed since the last target-file make, or if the target file
does not exist, Make executes the command lines in order of appearance. If dependencies
do not exist, Make always executes the command lines. If command lines do not exist, the
target needs re-making, and rules are inapplicable, Make issues an error message. See the
following sections for more information on rules.

Commands

You must begin each command on a new line and prefix that command by at least one
blank or tab. Maker does not claim the tab as in UNIX make. The following list describes
additional characteristics:

* Maker strips leading and trailing blanks and tabs from the command line.

¢ If the command line terminates with an exit code not equal to zero, Maker displays
an error message and stops makefile processing, unless the line starts with a dash ().
Maker removes the dash before executing the command.

* An asterisk (*) at the start of the command line prevents Maker from capturing the
output of the called tool. Sixteen-bit applications such as command . com need the
asterisk to function properly.

Processing

Make processes updated entries recursively, which means that if a dependency file
appears as a target in some other update entry, Make processes that other update entry
first. If a dependency file does not exist and rules are inapplicable, Make issues an error
message. See the following sections for more information on rules.

Normally, makefile processing starts with the update entry for the target given on the
command line or at the input prompt. If you do not specify a target, processing starts at the
first update entry in the makefile.

If there are two update entries for the same target file, Make appends the dependencies and
commands of the second update entry to those of the first update entry.

Make issues an error message if it finds circular dependencies.
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Macros

Macros associate a name with some arbitrary text. You can substitute this name for each
occurrence of the arbitrary text in the makefile. There are two different forms of macros:
user-defined static macros and predefined dynamic macros.

User-Defined Macros (Static Macros)

This section describes the macro definition form.

Definition
A macro definition has the form:

macro_name = text up to the next un-escaped linebreak

After you define a macro, you can use a macro reference to include the text at any place in
a makefile.

Reference

A macro reference has the form:
$ (macro_name)

Make replaces the reference with the text, including the “$ (” and the ) ”. If the text itself
contains more macro references, Make expands those, as well.

Redefinition

You can redefine macros, in which case the text in the new definition overwrites the text
in the old definition. Maker issues an error message if it detects a circular macro definition
like this:

ThisMacro = $(ThatMacro)

ThatMacro = Not $(ThisMacro)

Macro Substitution

During macro expansion, use the following syntax to have Maker replace strings:
$ (macroname: find=replace)
In this example, Maker replaces every occurrence of £ind with replace.

Use this kind of macro expansion to derive filenames, as in the following example:
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SRCNAMES= a.c b.c
OBJNAMES = $ (SRCNAMES:.c=.0)
As a result of this example, OBONAMES contains a.0 b.o.

NOTE  Maker does not allow spaces in the search string, the replace string, the whole

IRl

macro definition, or before or after the “:” or the

“_

Macros and Comments

If a comment follows a macro on the same line, as in the following example, the text that
replaces any reference of these macros ends just before the # character:

MyMacro = another #And that’s a comment
OurMacro = This is \
$ (MyMacro) example #That’s a comment, too!
MyMacro = a third #Redefinition of a macro
HisMacro = This is \

S (MyMacro) example

Maker replaces the macro references as follows (without double quotes):

S (MyMacro) = "a third"
$ (OurMacro) = "This is a third example"
S (HisMacro) = "This is a third example"

You can use macro references in update entries, inference rules, macro definitions, and
macro references. See the following sections for more information on rules. The macro-
reference possibility allows constructs such as:

This = Macro
MyMacro = This is a circular macro reference!
$ (My$ (This))

This example first evaluates to *$ (MyMacro) ” and then to “This is a circular macro
reference!”.

Concatenation

Besides the macro definition operator “=", Make knows two additional operators: “+="
and “=+". The first operator appends the text on the right to the macro on the left. The
second operator assigns to the macro the value given by appending the macro's previous
value to the text given on the right:
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MyMacro = File
MyMacro += .TXT

#Now the macro has the value "File.TXT"
MyMacro =+ D:\

#Now it has the value "D:\File.TXT"
The following macro is a case handled differently by different make utilities:
MyMacro = D:\SomeDir\

In HI-CROSS Make it has the value D: \SomeDir\. Other make implementations
expand it as D: \ SomeDir and take the last backslash as part of an escaped linebreak.

Command-Line Macros

There are two kinds of user-defined macros: Command-line macros and makefile macros.
Makefile macros are the macro definitions that appear in the make file. Command-line
macros are macros on the command line with option -d. Command-line macros have a
higher priority than macros defined in the makefile or in an included file. Therefore, if you
define a macro on command line, Maker ignores further definition of a macro with the
same name in the makefile.

A special command-line macro is TARGET, which defines the name of the top target to
make. The TARGET macro provides compatibility with previous Maker versions. Specify
a top target by adding its name after the makefile name. Defining an explicit top target
with the TARGET macro works only on the command line. The TARGET macro in the
makefile does not define a new top target. Do this explicitly by specifying a new target at
the top, which has the top target to make as dependency.

Dynamic Macros

In addition to user-defined macros, which are always static, HI-CROSS Make recognizes
the following dynamic macros, which evaluate differently in different contexts:

$* Dbase name (without suffix and period) of the target file.
S@ complete target file name.

$< complete list of dependency files.

$? 1list of dependency files that are younger than the target
$$ evaluates to a single dollar sign.

Except for the first and last macro, these dynamic macros may only appear within
command lines. Maker replaces them at the very end of macro substitution, just as it
executes the command:
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MyMacro = $<
OurMacro = file.c $(MyMacro)
THAT.EXE : $*.C $(OurMacro)
S (COMP) S (MyMacro)
$(LINK) $*.PRM
The first line evaluates to:
THAT.EXE : THAT.C file.c $<

This line is circular, since Maker now replaces $< with THAT.C file.c $<andsoon.
For this reason, the dynamic macros $< and $? may only appear on a command line (after
Maker completes all macro substitution). If we define OurMacro as:

OurMacro = file.c io.c
Once Maker completes all macro substitution, we get:
THAT.EXE : THAT.C file.c io.c
Example of $<:
target.o: target.c a.c b.c
$ (COMP) $<
replaced with:
target.o: target.c a.c b.c
$ (COMP) target.c a.c b.c
Example of $7?:
target.o: target.c a.c b.c
S (COMP) S$°?
If a.c and b. c are newer than target . o, then the result is:
target.o: target.c a.c b.c

$(COMP) a.c b.c

NOTE HI-CROSS Make also defines macros for all currently set environment
variables. You can redefine these macros like any other macro.

Inference Rules

Inference rules specify default rules for certain common cases. Inference rules have the
form:

.depSuffix.targetSuffix:
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{Commands}
or:
.depSuffix:

{Commands }

These rules tell HI-CROSS Make how to make a file with suffix targetSuffixif it
cannot find an update entry for the file: look for a file with the same name as the target but
with suffix depSuffix. Assume the target depends on that file, make the usual checks,
and if Maker must remake the target, execute the commands. If commands do not exist
and the target needs remaking, Maker issues an error.

The second form of an inference rule with only one suffix works exactly as the first one.
Maker assumes an empty target suffix.

For example, object files usually depend on a source file of the same name, but with a
different suffix, and Make calls a compiler to create those object files. Assume that object
files have the extension . o and source files have the extension . c. For example:

.C.0O:
$ (COMP) $*.c

If Make now finds a dependency file with extension . o (for example, THIS. o) but no
update entry having this file as target, it applies the above rule. The result is exactly the
same as if your makefile contained the dependency:

THIS.o: THIS.c
$ (COMP) $*.c

Rules also play a different role: if there is an update entry without command lines,
HI-CROSS Make searches for a rule that might apply and executes the commands
specified in that rule. For example, with your makefile containing the above rule, the
update entry:

THAT.o: FILE.h DATA.h

This is equivalent to:

THAT.o: FILE.h DATA.h THAT.c
S (COMP) $*.c

If you define two different inference rules for the same target suffix, only the last one is
active.

If HI-CROSS Make finds a dependency file that does not appear as a target in some other
update entry, it tries to find an inference rule to apply. If Make cannot find an inference
rule, and the file exists, Make assumes that the file is up to date. If the file does not exist,
Maker needs to remake it. Since Maker lacks a rule or an update entry for the file, it issues
an error message.

Here is a more complex example:
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Listing 17.1 Example

# demo make file for assembly project

OBJECTS = a_l.0 a_2.0 a_3.0
ASM = c:\freescale\prog\assembler.exe
LINK = c:\freescale\prog\linker.exe
all: myasm.abs

echo "all done"
myasm.abs: $(OBJECTS) myasm.prm
a_l.o: a_l.inc
a_2.0: a_l.inc a_2.inc

.prm.abs:

$(LINK) S$*.prm

.asm.o :

$(ASM) $*.asm

Multiple Inference Rules

You can specify more than one inference rule for each dependency suffix. Use this
technique when you have source files written in different programming languages with
different file suffixes. For example, assume you have sources written in assembly
language, in ANSI-C and C++. The object files produced by the assembler and compiler
have all the same suffixes. They are linked together to one program or library. You can
represent this relationship by one target having all the object files as a dependency list:

makeAll: asm_objl.o asm_obj2.0 asm_obj3.o c_objl.o cobj2.o
cpp_objl.o

These rules build the object files:
.asm.o:

$ (ASSEMBLE) $*.asm $(ASMOPTIONS)
.C.0O:

$ (COMPILE) $*.c $(COPTIONS)
.Cpp.oO:

$ (COMPILE) $*.cpp $(CPPOPTIONS)

Maker selects the first applicable rule.

NOTE  The Maker resolution algorithm is logically incomplete. You can chain rules
together in some cases, but doing so may lead to conflicts with the handling of
multiple inference rules. For example, if you use template frames with the
suffix . tpl compiled by a program that produces C files from TPL files,
Maker may have problems resolving multiple rules in the further compilation
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steps. To work around these problems, construct and use a test makefile that
contains the main resolution features in order to investigate Maker’s build
behavior. If the test makefile works, the full makefile also works.

Directives and Special Targets

HI-CROSS Make lets you include one makefile into another by using an include
directive of the form:

INCLUDE filename

This directive textually replaces the include directive with the given file’s contents (from
another makefile). If Make cannot locate, open, or read the file, it issues an error message.

Make always includes the default makefile DEFAULT . MAK at the very beginning. The
environment variable GENPATH specifies the directory that contains the makefile.

NOTE  Because the DEFAULT . MAK is included automatically, you have to be careful
when using this name. An incorrectly used DEFAULT . MAK causes failures in
all other makefiles for which it is in the search path. We recommend sharing
common definitions by explicit makefile includes instead of using the
implicitly included DEFAULT . MAK.

Make issues an error message for circular includes.
HI-CROSS Make also allows definition of two special targets without dependencies:
BEFORE:
{Commands}
and
AFTER:
{Commands }

Make executes these commands just before and just after processing the top target given
on the command line.

Built-lIn Commands

You can start DOS programs from the HI-CROSS Make Utility on the command line.
You can directly execute external DOS commands; to execute built-in commands call
COMMAND . COM with option /c, like this:

*COMMAND.COM /c dir C:\freescale > C:\DIR.TXT
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NOTE  The asterisk ( * ) prevents Maker from capturing the output of
command . com. The output capture facility is inconsistent when handling 16-
bit executables like command . com. In WinNT environments, use the native
32-bit shell cmd . exe instead of command . com.

The HI-CROSS Make Utility also has a few simple built-in commands. These commands
include:

copy filel file2

This command creates a copy of £11el with the name £ile2. No wildcards are allowed.
If you need wildcards, use the DOS built-in copy command.

del filel file2... fileN

This command deletes the files passed as arguments. Again, no wildcards are allowed.
Maker follows the file path from the current directory, if you do not specify an absolute
path. Maker does not consult the environment settings to find the files to delete.

cd directory

This command changes the current directory. The scope of the cd command is the
command list of a target from which Maker called it.

NOTE  Avoid using this command unless absolutely necessary. The command may
lead to inconsistency with relative-path definitions in the environment.

echo text

This command is actually a no-op. If Maker displays the commands, it displays the text,
too. You can view the echo text command as a way of defining a comment that Maker
shows, while hiding normal comments starting with #.

puts outputfile text

This command writes text, the rest of the command line, to the file specified with
outputfile (the first identifier of the command line). The write mode is appending. If
the file does not exist, Maker creates it (mode a+).

Example
puts myOutput.txt This is a text\n
This example writes the text This is a text with a line break at the end to the file

myOutput. txt.

Listing 17.2 Example

GENMAKE= bb.mak
TARGET = b
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MAKE= c:\freescale\prog\maker.exe
COMP= c:\freescale\prog\compiler.exe

STAR=*

DEPENDENDS = $ (TARGET) .c $(TARGET) .h
create$ (GENMAKE) :

-del $(GENMAKE)

puts ¢ (GENMAKE) \nCOMP=$ (COMP)
puts ¢ (GENMAKE) \nMAKE=$ (MAKE)

puts $

GENMAKE) \n$ (TARGET) .o : $ (DEPENDENDS)

puts $(GENMAKE) \n $S(COMP) S (TARGET).c

S (MAKE

$ (GENMAKE) $ (TARGET) .o

This example generates and runs bb . mak.

Listing 17.3 Example

COMP=c: \freescale\prog\compiler.exe
MAKE=c:\freescale\prog\maker.exe

b.o

: b.c b.h

c:\freescale\prog\compiler.exe b.c

fc filel file2

This example compares two files, specified by name as £ilel and £ile2, byte by byte
and remembers the result for the next ? command. The result is TRUE if the files are
identical and FALSE if they are not identical.

fctext filel file2

This example compares two text files byte by byte, ignoring blanks for compare, and
remembers the result for the next ? command. The result is TRUE if the files are identical
and FALSE if they are not identical.

?
Syntax: ? <commandIfYes> ‘:’ <commandIfNo>

The result of the last compare operation executes either <commandIfYes>, if the
compared files were identical, or <commandI £No> if the compared files were not
identical.

fctext upxcall.c upxcall.old

? puts log.txt files are equal : puts log.txt files are not
equal

or:
fctext upxcall.c upxcall.old

? puts log.txt files are equal \
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puts log.txt files are not equal
rehash

This example reloads the HI-CROSS environment from the default. env file.
Thereafter all commands, all macro expansions, and all file searches execute in the new
environment.

ren filel file2

This example renames £ilel to £ile2. No wildcards are allowed.

Command Line
The Maker command line consists of three parts:
¢ Maker Options

Maker treats all entries starting with a dash ( - ) as options. To specify the top target,
use the target name on the command line after the makefile name.

¢ Makefile name

Maker treats the first command line argument, which does not start with a dash, as a
makefile name.

e Targets

Maker treats all remaining arguments without a leading dash as targets to build. If
you do not specify targets, the first rule is build.

When you start Maker without command-line arguments, a window opens in which you
can manually enter commands.

Implementation Restrictions

Make has only one implementation restriction: the string resulting from a macro
substitution cannot contain more than 4095 characters.

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 261



A 4
4\

Using Maker
Directives and Special Targets

262 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



18
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This chapter explains using the Maker utility to adapt or build your own libraries. Listings
in this chapter have the <target> identifier instead of a specific CPU name. <target>
stands for your own target name.

The following topics are covered in this chapter:

Maker Directory Structure

Configuring WinEdit for the Maker
Configuring default.env for the Maker
Building Libraries with Defined Memory Model Options

Building Libraries with Objects Added
Structured Makefiles for Libraries

Maker Directory Structure

The make files distributed for building the libraries expect the directory structure
recommended in the Tools installation. The following items are installed in the
C:\Program Files\Freescale\CW MCU v10.x directory.

FREESCALE program folder. Normal installation places the . EXE files for each tool
in this folder:

<CWInstallDir>\MCU\prog
For S127 derivatives: <CWInstallDir>\MCU\S12lisa_ Tools

Your working directory for building libraries, makefiles, project files, and
configuration files installed here:

<CWInstallDir>\lib\<target>

Binary tool path, defined as a relative path from your working directory in the
environment variable OBJPATH. Object files and libraries build here:

<CWInstallDir>\1lib\<target>\1lib

The 1ib directory contains the library in the preferred object-file format. For targets
supporting different object-file formats, other formats reside in these directories
(which exist only if the format supports libraries and is not the default):

FREESCALE: <CWInstallDir>\lib\<target>\1lib.hix
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ELF/DWARF 1.1: <CWInstallDir>\lib\<target>\lib.ell
ELF/DWARF 2.0: <CWInstallDir>\lib\<target>\1lib.e20

* Source paths of the Compiler or Assembler used, defined as a relative path from your

working directory in the environment variable GENPATH:

<CWInstallDir>\1lib\<target>\src

¢ Include path of the Compiler or Assembler used, defined as a relative path from your

working directory in the environment variable LIBPATH:

<CWInstallDir>\lib\<target>\include

NOTE The <CWInstallDir> is the installation directory for the CodeWarrior for

Microcontrollers v10.x.

Configuring WinEdit for the Maker

Configure WinEdit as follows:

1.

4.

Open the Dialog Project > Configure in WinEdit.
This dialog appears only when you open a source file.

Load a prepared configuration file with Open or edit the tool definition and save the
configuration file.

For the Maker configuration (and also the other tools used directly from WinEdit) you
must enter the full path to the application in the corresponding text box.

Enter the path to your make files in the working directory field.

The following figure shows a sample configuration in the Project Management dialog box.
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Figure 18.1 Project Management Dialog Box

Project Management

Project Name: ||iibrarp'F'roiec:t for <targets

Working Directory: |><:\hic:ross\E<target> WLIBY<target:

Save

Compiler: |Microsoft or compatible j

%%f = file name %n = base name, no extension %e = file extension only

Compile Command I [ Capture Output

Make Command IX:\hicross\<targeb\F’HDG\MAKEH.EXE [~ Capture Output

Rebuild Command | [~ Capture Output
Debug Command | [ Capture Output
Execute Command | | Capture Qutput
[ Save files before running tools ¥ Prompt before saving fies
| OK I | Cancel I | Help I

Configuring default.env for the Maker

This section contains a sample default . env (see ENVIRONMENT: Environment File
Specification) with Maker settings. For building libraries, you need COMP for the
compiler, MAKE for the make tool, and LIBM for the library. Additionally, you must
specify path environment variables such as OBJPATH and GENPATH. The makefiles
introduced in this section also reference these paths.

OBJPATH=.\1lib

GENPATH=.\src
LIBPATH=.\include
MAKE=..\..\prog\maker.exe
COMP=. .\..\prog\c<target>.exe
LIBM=..\..\prog\libmaker.exe
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Building Libraries with Defined Memory
Model Options

Modify memory-model options of a library to build or to extend the built libraries with a
new one as follows:

1.

Open the file mkall.mak.

This file is the main makefile for building libraries. For every library, you specify a
command line under the top target makeall. An example is:

$ (MAKE) mklib.mak -D(MM=$ (FLAGS) -Ms) \
-D(LIBDIR=S (LIBDIR))\
-D(LIBNAME=testlib) \
-D(INCLIBS=ansilib.1lib cpplib.1lib)

. With the command line macro MM, specify the options for your library (memory model

option and others).

To change the memory model from small to banked, replace -Ms in the macro
definition with -Mb.

NOTE The macro definition introduced here is in -D: Define a Macro (Maker). You

5.

can specify more than one option switch inside the braces, as in this example:

-D(MM=$ (FLAGS) -Ms -Cf)

. Specify the library directory in LIBDIR.

This step is necessary only when you use the default directory \1ib, as with
processors supporting ELF and Freescale object-file format.

. In LIBNAME, name the library to build without an extension. For example, use

testlib if the name of the library to build is test1lib.1lib.
Call Maker with mkall.mak.

The library built with this example includes the ANSI library and the C++ library.

Building Libraries with Objects Added

Add your own objects to a library or build a new one as follows:

1.

Copy the ansilib.mak makefile to a makefile with the name of the library you
want to build. For example, use my1ib.mak if the name of the library you want to
buildismylib.1lib.

. Put this makefile in the same directory as the other makefiles.
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NOTE  The name of the sublibrary of a built library must be the same as the underlying
makefile, with the . 1ib extension instead of .mak.

3. Remove all object files listed in the macro OBJECTS inmylib.mak.
If you now list the new makefile my1ib.mak, you get:
OBJECTS =
makelLib: createlLib $(OBJECTS)
echo --- Sublibrary ansilib created
createLib:
$(CC) string.c assert.c
$(LIBM) string.o + assert.o = $(OBJPATH)\S(LIBNAME).lib
del $(OBJPATH) \string.o
del $(OBJPATH) \assert.o
.c.o:
S(CC) s$*.c
$(LIBM) ¢ (OBJPATH)\$ (LIBNAME).lib+$*.0 =
$ (OBJPATH) \ ¢ (LIBNAME) .1ib
del $(OBJPATH)\S$*.o
4. List your object files with the . o extension in the OBJECTS macro.

Place your library source files in the folder specified in GENPATH (see GENPATH:
Define Paths to Search for Input Files).

5. Open the mkall.mak file.

mkall.mak is the main makefile for building libraries. For every library, you specify
a command line under the top target makeall:.

An example is:

S (MAKE) mklib.mak -D(MM=$ (FLAGS) -Ms) \
-D(LIBNAME=testlib) \
-D(STARTANSIOBJ=start<target>s) \
-D (STARTCPPOBJ=strt<target>sp) \
-D(INCLIBS=mylib.1lib)

6. In the passed INCLIBS command-line macro, specify the sublibrary names.

In the example above, Maker builds only the sublibrary mylib.1lib with
mylib.mak. In this example, we list only one sublibrary. You can add additional
sublibraries to the list, separated by spaces.

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 267



'
A

Building Libraries
Structured Makefiles for Libraries

7. In LIBNAME, specify the name of the built library without the extension.

The other macros passed specify the startup files to build. Maker does not insert the
startup files into the library but instead builds them separately.

NOTE  The name of the library to build, specified in LIBNAME, must be different from
the name of the sublibrary included, such as my1ib in the example. If not,
Maker deletes the built library just after building it. (Maker deletes the
sublibrary after adding it to the built library.)

8. Call Maker withmkall.mak

Your library builds among the others.

Structured Makefiles for Libraries

Building a library works on three makefile levels, as shown in the following figure.

Figure 18.2 Building a Library

Top Make File

mkall.mak

!

, Build Library Make File

mklib.mak

Y

Customized Library Makefile Customized Library Makefile

example: ansilib.mak example: cpplib.mak

This layering compares to the modular concept of procedural programming languages. An
upper makefile calls Maker with the makefile and the arguments passed over command-
line macros. The top layer makefile mkall .mak, for example, calls the makefile
mk1lib.mak to build one library and passes the memory model, the name of the library to
build, the name of the participant sublibraries, and the startup files build.

A sample makefile, mkall .mak, looks like this:
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Listing 18.1 Sample makefile

FLAGS = ## insert here the global options for all libraries
makeall:

-dosprmpt.pif /c del 1lib\*.*

echo --- Making all libraries:

$(MAKE) mklib.mak -D(MM=$ (FLAGS) -Ms) -D(LIBNAME=ansis) \
STARTANSIOBJ=start<target>s) \
STARTCPPOBJ=strt<target>sp) \
INCLIBS=ansilib.lib cpplib.lib)

$ (MAKE) mklib.mak -D(MM=$ (FLAGS) -Ms -Cf) \
LIBNAME=ansisf) \
STARTANSIOBJ=start<target>s) \
STARTCPPOBJ=strt<target>sp) \

-D(
-D(
-D(
(
(
(
(
(INCLIBS=ansilib.lib cpplib.lib)
(
(
(
(
(
(
(
(

$(MAKE) mklib.mak -D(MM=$ (FLAGS) -Mb) -D(LIBNAME=ansib) \

STARTANSIOBJ=start<target>b) \

STARTCPPOBJ=strt<target>bp) \

INCLIBS=ansilib.lib cpplib.lib)

$ (MAKE) mklib.mak -D(MM=$ (FLAGS) -Mb -Cf)

LIBNAME=ansibf) \

STARTANSIOBJ=start<target>b) \

STARTCPPOBJ=strt<target>bp) \
-D(INCLIBS=ansilib.1lib cpplib.1lib)

echo "--- libraries done

D
D
D
D
D
D
D
D
D
D

The first command for the top target makeall deletes all libraries and object files
previously built.

One Maker call with $ (MAKE) evaluates Maker over the environment variable MAKE in
default.env, which corresponds to building one library.

¢ The first Maker call of mk1ib.mak, for example, builds an ANSI library for the
small memory model (with option -Ms passed over the command-line macro MM).

* mklib.mak expects these command-line macros:
— MM = options for the memory model,

— LIBNAME = name of the produced library

STARTUP = name of the ANSI-C Startup file

STARTCPP = name of the C++ Startup file
— INCLIBS =in library of included sub libraries

In the example, we pass the library names cpplib.liband ansilib.1ib in the
INCLIBS command-line macro. The mk1ib.mak makefile appears below:
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NOTE Do not modify mk1lib.mak. Instead, use mkall .mak to specify the
compiler options, the sublibrary list, and your own sublibraries, such as
ansilib.mak, cpplib.mak, and the example, mylib.mak.

Listing 18.2 mklib.mak makefile

CC = $(COMP) $(MM)

makeall: startup createLib $(INCLIBS)
echo "--- all done! —---"

startup: start<target>.c
echo "--- making startup

S (CC) $(GENPATH) \start<target>.c
copy $(OBJPATH) \start<target>.o
$ (OBJPATH) \'$ (STARTANSIOBJ) .0
$(CC) -C++ S (GENPATH) \start<target>.c
copy $(OBJPATH) \start<target>.o
$ (OBJPATH) \'$ (STARTCPPORJ) .0
del $(OBJPATH) \start<target>.o

echo "--- startup done
createLib:
echo "--- creating library

¢ (LIBM) $(OBJPATH)\$ (STARTANSIOBJ) .o =
$ (OBJPATH) \$ (LIBNAME) .1ib
$ (LIBM) $(OBJPATH)\$ (LIBNAME).lib -
$ (OBJPATH) \ $ (STARTANSIOBJ) .0 =\
$ (OBJPATH) \$ (LIBNAME) .1ib
$ (LIBM) $(OBJPATH)\$ (LIBNAME).lib ?
$ (OBJPATH) \'$ (LIBNAME) . 1st

echo "--- library done

.mak.lib:

echo "--- making and add $* library
$(MAKE) $*.mak -D(CC=$(CC)) -D(LIBNAME=S*)

$ (LIBM) $(OBJPATH)\$ (LIBNAME).lib + $(OBJPATH)\S$*.lib =\
$ (OBJPATH) \'$ (LIBNAME) .1ib

del $(OBJPATH)\S$*.1lib

del ¢ (OBJPATH)\S$*.lst

The makefile uses build rules. For each library built, the makefile my1ib.mak must
reside in the working directory. The makefile collects a group of object files. Maker calls
the makefile, passing these command-line arguments as parameters:

* CC = compiler with option list
* LIBNAME = name of the produced library

These settings depend on settings already passed from mkall .mak. The sublibraries
built with the delivered makefiles are ansilib.mak and cpplib.mak.
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Appendices

This section contains topics common to all of the build tools, and contains the following
chapters:

¢ Environment Variables
¢ Tool Options

* Messages
¢ Tool Commands

 EBNF Notation

Items and topics specific to individual tools are marked within the text.
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This chapter describes the environment variables used by the tools described in this
manual. Differences between tools are noted in the text. Other tools, such as the
Assembler and the Compiler, use some of the same environment variables. Refer to the
respective tool manuals for more information.

You can set parameters in the environment using environment variables. The syntax is
always the same:

VARIABLENAME=Definition
NOTE  No blanks are allowed in the definition of an environment variable.

Example:
GENPATH=C:\INSTALL\LIB;D: \PROJECTS\TESTS; /usr/local/lib;/
home/me/my_project
These parameters may be defined in several ways:
* Using system environment variables supported by your operating system.

¢ Putting the definitions in a file called DEFAULT . ENV (.hidefaults for UNIX)
in the project directory.

NOTE  The maximum length of environment variable entries in the DEFAULT . ENV or
.hidefaults is 65535 characters (1024 characters for the Decoder and
Maker).

¢ Putting the definitions in a file given by the value of the system environment variable
ENVIRONMENT: Environment File Specification.

NOTE  The project directory shown above can be set using the DEFAULT system
environment variable DEFAULTDIR: Default Current Directory.

When looking for an environment variable, all programs first search the system
environment, then the DEFAULT . ENV (.hidefaults for UNIX) file, and finally the
global environment file given by ENVIRONMENT: Environment File Specification. If no
definition can be found, the tool assumes a default value.
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NOTE  You can also change the environment using the -Env option. Do not leave
spaces at the end of environment variables.

Current Directory

The most important environment variable for all tools is the current directory. The current
directory is the base search directory where the tool starts to search for files (for example,
for the DEFAULT.ENV /.hidefaults).

Normally, the operating system or a program that launches another program (for example,
WinEdit) determines the current directory of a tool. For the UNIX operating system, the
directory in which an executable is started is also the current directory from which the
binary file starts. For Microsoft® Windows®-based operating systems, the current
directory definition is more complicated:

¢ If you launch the tool using a File Manager/Explorer, the current directory is the
location of the executable launched.

 If you launch the tool using a desktop icon, the current directory is the working
directory specified and associated with the icon.

 If you launch the tool by dragging a file onto the desktop icon, the desktop is the
current directory.

¢ If you launch the tool from another tool with its own working directory specification
(e.g., an editor as WinEdit), the current directory is the one specified by the
launching tool (e.g., working directory definition in WinEdit).

* Changing the current project file also changes the current directory if the new project
file is in a different directory. Browsing for a prm file does not change the current
directory.

To overwrite this behavior, you can use the environment variable DEFAULTDIR: Default
Current Directory.

To view the current directory, as well as other information, use the —v option or the About
box.

Tool-Specific Search Information

This section details environment information unique to each tool. For further information
about the Compiler, Assembler, and Debugger refer to the appropriate manual.
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Compiler

¢ Symbol Files

— The compiler looks for symbol files in the current directory, then in the
directories given by the environment variable SYMPATH and finally in directories
given in GENPATH.

— New symbol files are written in the directory containing the source, unless the
environment variable SYMPATH is set. If set, the compiler puts the symbol file in
the first directory in the path list.

« Object Files

— The compiler normally puts object files in the first directory specified in the
environment variable OBJPATH. If that variable is not set, the compiler writes the
object file into the directory containing the source file.

¢ Compiler Variables: COMPOPTIONS

— If you set this variable, the compiler appends its contents to the command line
each time a file is compiled. You can use this variable to globally specify certain
options, so you don’t have to specify them at each compilation.

Debugger
* Object Files

— The debugger looks for object files in the current directory, then in directories
specified in the environment variable OBJPATH and finally in GENPATH.

¢ Absolute Files

— The debugger looks for absolute files in the current directory, then in directories
specified in ABSPATH and finally in GENPATH.

Libmaker

¢ Source Files, Linker Parameter File
— The Libmaker searches for Source Files and the Linker Parameter File
first in the current directory, then in the other directories defined by the
environment variable GENPATH.
* Header Files
— If you include a header file in double quotes, the Libmaker searches the current
directory first, then the directories given in GENPATH and finally those given in
LIBPATH.
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— If you include a header file using angle brackets, Libmaker does not search the

directories in GENPATH, but searches only the current directory and those
specified in LIBPATH.

Maker

* Maker Utility Variables

The maker utility can access any environment variable with the following syntax:
$ (Name) (e.g. $(COMP)). For makefiles given in your installation, the following
environment variables are used.

COMP: contains name of Compiler
LINK: contains name of Linker

FLAGS: contains command line options for the compiler specified by COMP.

¢ Makefiles and Include files

Maker searches for makefiles and include files first in the current directory and
then in the GENPATH: Define Paths to Search for Input Files directory.

Maker calls the tools that produce the output files of a make run (except error
reports). Refer to the corresponding manuals for the tools you use.

SmartLinker

« Object Files

The linker looks for object files in the current directory, then in directories
specified in the environment variable OBJPATH and finally in GENPATH.

* Map Files

If linking succeeds, the linker writes a protocol of the link process to a list file
called map file. The name of the map file is the same as that of the ABS file, but
with extension MAP. The linker writes the map file to the directory specified by
the environment variable TEXTPATH.

¢ Absolute Files

The linker creates absolute files in the first directory specified in ABSPATH. If
that variable is not set, the linker generates the absolute file in the directory
containing the parameter file.
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Global Initialization File (MCUTOOLS.INI)
(PC only)

All tools may store some global data into the MCUTOOLS . INT file. The tool first searches
for this file in the directory of the tool itself (path of the executable). If there is no
MCUTOOLS . INT file in this directory, the tool looks for an MCUTOOLS . INT file located
in the Microsoft Windows installation directory (for example, C : \WINDOWS).

Example:
C: \WINDOWS\MCUTOOLS . INI
D:\INSTALL\PROG\MCUTOOLS.INI

If you start the tool in the D: \INSTALL\ PROG directory, the tool uses the current file
located in the same directory as the tool (D: \INSTALL\ PROG\MCUTOOLS . INT).

However, if you start the tool outside the D: \ INSTALL\ PROG directory, the tool uses
the current file in the Windows directory (C: \WINDOWS\MCUTOOLS.INTI).

[Installation] Section

This section lists the following variables.
e Path
¢ Group

Path

Arguments

Last installation path

Description
When you install a tool, the installation script stores the installation destination directory
in this variable.
Example
Path=c:\install
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Group

Arguments

Last installation program group.

Description

When you install a tool, the installation script stores the created program group in this
variable.

Example
Group=ANSI-C Compiler

[Options] Section

This section lists the DefaultDir variable.

DefaultDir

Arguments

Default Directory to use.

Description

Specifies the current directory for all tools on a global level (see also environment variable
DEFAULTDIR: Default Current Directory).

Example

DefaultDir=c:\install\project

[Tool] Section

Variables listed in this section in the global configuration file appear in separate sections
by tool name, i.e., [LINKER] Section, [BURNER] Section.

This section lists the following variables:

¢ SaveOnExit

¢ SaveAppearance
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e SaveEditor

* SaveOptions

* RecentProject0. RecentProjectl. etc.
» TipFilePos

¢ ShowTipOfDay

¢ TipTimeStamp

SaveOnExit

Arguments
1/0

Description
1: Stores the configuration when the tool closes
0: Discards the configuration

The tool does not ask to store a configuration in either case.

SaveAppearance

Arguments
1/0

Description
1: Stores the visible topics when writing a project file
0: Discards visible topics

The command line, its history, the windows position and other topics belong to this entry.

SaveEditor

Arguments
1/0
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Description
1: Stores the visible topics when writing a project file
0: Discards the visible topics

The editor settings contain all information of the editor configuration dialog.

SaveOptions

Arguments
1/0

Description
1: Saves the options when writing a project file
0: Discards the options

The options also contain the message settings.

RecentProject0, RecentProjecti, etc.

Arguments:

Names of the last and prior project files

Description
Loading or saving a project updates this list. The file menu shows its current
content.
Example
SaveOnExit=1
SaveAppearance=1
SaveEditor=1
SaveOptions=1
RecentProject0=C: \myprj\project.ini
RecentProjectl=C:\otherprj\project.ini
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TipFilePos
Arguments
Any integer

Description
Index number of the tip of the day shown; used to display different tip every time.

ShowTipOfDay

Arguments
0/1

Description

Specifies whether to show the Tip of the Day dialog at startup.
1: Shows Tip of the Day at startup

0: Shows Tip of the Day only when opened from the help menu.

TipTimeStamp

Arguments

Date

Description
Used to record the time that new tips became available. When the date specified here does
not match the date of the tips, the first tip is displayed.
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Example
[LINKER]
TipFilePos=357
TipTimeStamp=Jan 25 2000 12:37:41
ShowTipOfDay=0
SaveOnExit=1
SaveAppearance=1
SaveEditor=1
SaveOptions=0
RecentProject0=C: \myprj\project.ini

RecentProjectl=C:\otherprj\project.ini

[Editor] Section

This section lists the following variables:
¢ Editor Name

* Editor Exe
» Editor_Opts

Editor_Name
Arguments
The name of the global editor

Description

Specifies the name displayed in the global editor. This entry has a descriptive effect only.
Its content does not apply to starting the editor.

NOTE  Maker cannot modify this entry.

282 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Environment Variables
Global Initialization File (MCUTOOLS.INI) (PC only)

Editor Exe

Arguments

The name of the executable file of the global editor

Description

Specifies the file name (including its path) which is called for showing a text file when the
global editor setting is active. In the editor configuration dialog, the global editor selection
is active only when this entry is present and not empty.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration tab.

NOTE  Maker cannot modify this entry.

Editor_Opts

Arguments

The options to use the global editor

Description

Specifies options for the global editor. If this entry is missing or empty, $£ is used. The
command line to launch the editor is built by taking the Edi tor_Exe content, appending
a space, then appending this entry.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration tab.
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Example
[Editor]
editor_name=WinEdit
editor_exe=C:\Winedit\WinEdit.exe

editor_opts=%f
NOTE  Maker cannot modify this entry.

MCUTOOLS.INI Example
The following listing shows a typical layout of the MCUTOOLS . INT file.

Listing A.1 Sample MCUTOOLS.INI file

[Installation]
Path=c:\Freescale
Group=ANSI-C Compiler

[Editor]

editor_name=WinEdit
editor_exe=C:\Winedit\WinEdit.exe
editor_opts=%f

[Options]
DefaultDir=c:\myprj

[Linker]

SaveOnExit=1

SaveAppearance=1

SaveEditor=1

SaveOptions=1

RecentProjectO=c: \myprj\project.ini
RecentProjectl=c:\otherprj\project.ini

Local Configuration File (Usually project.ini)

The tools read DEFAULT . ENV and do not change its content in any way. The
configuration file stores all the configuration properties. Different applications use the
same configuration file. The configuration file format is the same format as Windows®
*.ini files.

The tools can use any file name for the project configuration file, and store their own
entries with the same section name as in the global mcutools. ini file. The application
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backend is encoded into the section name so that different application backends can use
the same file without overlapping. Different versions of the same tools use the same
entries. This is important mainly when options available in only one version are stored in
the configuration file. In such situations, you must maintain two files for the different tool
versions. If no incompatible options are enabled when the file is last saved, you can use
the same file for both versions.

The current directory is always the directory where the configuration file is located. If you
load a configuration file in a different directory, then the current directory also changes.
Changing the current directory reloads the DEFAULT . ENV file.

The shell uses the configuration file with the name project.ini in the current
directory only, therefore it is recommended that you use this name with the tools as well.
The tools can use the editor configuration written and maintained by the shell only when
the shell uses the same file. Apart from this distinction, the tools can use any file name for
the project file.

Loading or storing a configuration file reloads the options in the environment variables
LINKOPTIONS (see LINKOPTIONS: Default SmartLinker Options) and
COMPOPTIONS, and adds the options to the project options. This behavior is important
to note when different DEFAULT . ENV files exist in different directories and contain
incompatible LINKOPTIONS options. When you load a project using the first
DEFAULT . ENV, you add its LINKOPTIONS and COMPOPTIONS to the configuration
file. If you store this configuration in a different directory which contains a

DEFAULT . ENV file with incompatible options, the tools add the options and reports the
inconsistency. A message appears to report that the DEFAULT . ENV options were not
added. If this occurs, you can either remove the option from the configuration file using
the advanced option dialog, or you can remove the option from the DEFAULT . ENV with
the shell or a text editor, depending upon which options you want to use in the future.

At startup there are two ways to load a configuration:
* Use the -Prod command line option
* Use the project. ini file in the current directory

If you use the -Prod option, then the directory containing the project file is the current
directory. If you specify a directory using the -Prod option, you load the
project.ini file from the specified directory.

[Editor] Section

This section lists the following variables:
* Editor Name
» Editor_Exe

« Editor_Opts
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Editor Name

Arguments

The name of the local editor

Description

Specifies the name displayed in the local editor. This entry has a descriptive effect only.
Its content does not apply to starting the editor.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab. This entry has the same format as the global editor
configuration in the mcutools.ini file.

NOTE  Maker cannot modify this entry.

Editor_Exe

Arguments

The name of the executable file of the local editor

Description

Specifies the file name which is called for showing a text file when the local editor setting
is active. In the editor configuration dialog, the local editor selection is active only when
this entry is present and not empty.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab. This entry has the same format as the global editor
configuration in the mcutools. ini file.

NOTE  Maker cannot modify this entry.
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Editor_Opts

Arguments

The options to use the local editor

Description

Specifies the options to use for the local editor. If this entry is absent or empty, the tools
use $£. The tools construct the command line to launch the editor by taking the
Editor_Exe content, appending a space, then adding the Editor_Opts entry.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab. This entry has the same format as the global editor
configuration in the mcutools.ini file.

NOTE  Maker cannot modify this entry.

Example
[Editor]
editor_name=WinEdit
editor_exe=C:\Winedit\WinEdit.exe

editor_opts=%f

[Tool] Section

The local configuration file stores the following variables in separate sections for each tool
and labeled accordingly, i.e., [LINKER], [BURNER].

This section lists the following variables:
* RecentCommandLineX. X=Integer
¢ CurrentCommandLine
* StatusbarEnabled
* ToolbarEnabled
¢ WindowPos
* WindowFont

* TipFilePos
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¢ ShowTipOfDay

* Options

* EditorType

¢ EditorCommandLine
¢ EditorDDEClientName
* EditorDDETopicName
* EditorDDEServiceName
¢ BurnerUndefByte

¢ BurnerSwapByte

¢ BurnerOrigin

¢ BurnerDestination

¢ BurnerLength

¢ BurnerFormat

¢ BurnerDataBus

¢ BurnerOutputType

¢ BurnerDataBits

¢ BurnerParity

¢ BurnerByteCommands

¢ BurnerBaudRate

¢ BurnerOutputFile
¢ BurnerHeaderFile

* BurnerlnputFile

RecentCommandLineX, X=Integer

Arguments

String with a command line history entry. For example: fibo.prm, fibo.bbl

Description

This list of entries contains the content of command line history.

Saved

Only with Appearance set in the File > Configuration > Save Configuration Tab.
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CurrentCommandLine

Arguments

String with the command line. For example: f£ibo.prm -wl, fibo.bbl -wl

Description

The currently visible command line content.

Saved

Only with Appearance set in the File > Configuration > Save Configuration Tab.

StatusbarEnabled

Arguments
1/0

Description

This entry is considered only at startup. Later load operations do not use it.
1: Enables the status bar
0: Hides the status bar

Saved

Only with Appearance set in the File > Configuration > Save Configuration Tab.

ToolbarEnabled

Arguments
1/0

Description
The tool considers this entry only at startup. Later load operations do not use it.

1: Enables the toolbar
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0: Hides the toolbar

Saved

Only with Appearance set in the File > Configuration > Save Configuration Tab.

WindowPos

Arguments
10 integers, e.g.,0,1,-1,-1,-1,-1,390,107,1103, 643

Description

The tool considers this entry only at startup. Later load operations do not use it.
NOTE  Changes of this entry do not show the * in the title.

These numbers contain the position and the state of the window (maximized, minimized)
and other flags.

Saved

Only with Appearance set in the File > Configuration > Save Configuration Tab.

WindowFont

Arguments

Size: == 0 -> generic size, < 0 -> font character height, > 0 font cell height,
Weight : 400 = normal, 700 = bold (valid values are 0—1000),
Italic: 0==no, 1 ==yes,

Font name: max 32 characters.

Description

Font attributes.

Saved

Only with Appearance set in the File > Configuration > Save Configuration Tab.
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Example
WindowFont=-16,500,0,Courier

TipFilePos
Arguments
Any integer, e.g. 236

Description
Actual position of tip of the day file.

Saved

Always when saving a configuration file.

ShowTipOfDay

Arguments
071

Description

Display Tip of the Day dialog at startup.

1: Shows the Tip of the Day dialog

0: Hides the Tip of the Day dialog (can be displayed from the help menu)

Saved

Always when saving a configuration file.

Options

Arguments
w2

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual 291



A 4
4\

Environment Variables
Local Configuration File (Usually project.ini)

Description

The currently active option string. Because this entry contains the messages, the entry can
be very long.

Saved

Only with Options set in the File > Configuration > Save Configuration Tab.

EditorType

Arguments
0/1/2/3

Description
This entry specifies the active editor configuration.
0: Global editor configuration (in the file mcutools.ini)
1: Local editor configuration (the one in this file)
2: Command line editor configuration: entry EditorCommandLine

3: DDE editor configuration: entries beginning with EditorDDE.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab.

EditorCommandLine

Arguments
Command line. For WinEdit: C:\Winapps\WinEdit.exe %f /#:%1

Description

Command line content to open a file.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab.
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EditorDDECIlientName

Arguments

Client command. For example, [open (%$f) ]

Description

Name of the client for DDE editor configuration.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab.

EditorDDETopicName

Arguments

Topic name. For example, system

Description

Name of the topic for DDE editor configuration.

Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab.

EditorDDEServiceName

Arguments

Service name. For example, system

Description

Name of the service for DDE editor configuration.
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Saved

Only with Editor Configuration set in the File > Configuration > Save
Configuration Tab.

Burner Dialog Entries in [BURNER]

The following entries are specific to the Burner, and appear only in the [BURNER]
section of the project. ini file.

BurnerUndefByte

Arguments

Integral value of undefined bytes. Default is Oxff.
Description
Value of the Undef Byte entry on the Content page in the Burner dialog.
Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerSwapByte

Arguments
0: Do not swap
1: Swap
Description
Value of the Swap Bytes check box on the Content page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.
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BurnerOrigin

Arguments
Integral value (0,1,2)

Description
Value of the Origin field on the Content page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerDestination

Arguments
Integral value (0,1,2)

Description
Value of the Destination Offset field on the Content page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerLength
Arguments
Integral value (0,1,2)

Description
Value of the Length field on the Content page in the Burner dialog.
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Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerFormat

Arguments
0: Freescale S record format
1: Intel Hex file format
2: Binary file format
Description
Format type specified on the Content page in the Burner dialog.
Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerDataBus

Arguments
0: “1 Byte”
1: “2 Bytes”
2: “4 Bytes”

Not the size in bytes.
Description
Setting in the Data Bus field on the Content page in the Burner dialog.
Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.
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BurnerOutputType

Arguments
0: Coml
1: Com2
2: Com3
3: Com4
4: File

Description

Setting in the Output field on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerDataBits

Arguments
0: 7 Bits
1: 8 Bits

Description
Setting in the Data Bits field on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.
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BurnerParity

Arguments
0: None
1: Odd
2: Even

Description
Setting in the Parity field on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerByteCommands

Arguments
0: 1st Byte (msb)
1: 2nd Byte
2: 3rd Byte
3: 4th Byte
4: 1st Word
5: 2nd Word

Description

Setting in the command box on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.
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BurnerBaudRate

Arguments
300, 600, 1200, 2400, 4800, 9600, 19200, 38400

Description
Setting in the Baud Rate box on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerOutputFile

Arguments
File Name, e.g., file.s19

Description
Content of the Name box on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerHeaderFile
Arguments
File Name, e.g., headerfile

Description
Content of the Header File box on the Input/Output page in the Burner dialog.
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Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

BurnerinputFile

Arguments

File Name, e.g., file.abs

Description
Content of the Input File box on the Input/Output page in the Burner dialog.

Saved

Only with Appearance set in the File > Configuration > Save Configuration
dialog.

Configuration File Example

The following listing shows a typical layout of the configuration file (usually
project.ini).

Listing A.2 Example Configuration File

[Editor]

Editor_ Name=WinEdit
Editor_Exe=C:\WinEdit\WinEdit.exe %f /#:%1
Editor_Opts=%f

[Linker]

StatusbarEnabled=1
ToolbarEnabled=1
WindowPos=0,1,-1,-1,-1,-1,390,107,1103,643
WindowFont=-16,500,0,Courier
Options=-wl

EditorType=3
RecentCommandLineO=fibo.prm -w2
RecentCommandLinel=fibo.prm
CurrentCommandLine=calc.prm -w2
EditorDDEClientName=[open (%f) ]
EditorDDETopicName=system
EditorDDEServiceName=msdev
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EditorCommandLine=C:\WinEdit\WinEdit.exe %f /#:%1

[Burner]

StatusbarEnabled=1
ToolbarEnabled=1
WindowPos=0,1,-1,-1,-1,-1,390,107,1103,643
WindowFont=-16,500,0,Courier
TipFilePos=0

ShowTipOfDay=1

Options=-wl

EditorType=3
RecentCommandLineO=-ffibo.bbl -wl
CurrentCommandLine=-ffibo.bbl -w2
EditorDDEClientName=[open (%f) ]
EditorDDETopicName=system
EditorDDEServiceName=msdev
EditorCommandLine=C:\WinEdit\WinEdit.exe %f /#:%1
BurnerUndefByte=255
BurnerSwapByte=0

BurnerOrigin=0
BurnerDestination=0
BurnerLength=65536

BurnerFormat=0

BurnerDataBus=0
BurnerOutputType=4
BurnerDataBits=1

BurnerParity=0
BurnerByteCommands=0
BurnerBaudRate=9600
BurnerOutputFile=outputfile.sl19
BurnerHeaderFile=headerfile
BurnerInputFile=InputFile.abs

[Maker]

StatusbarEnabled=1

ToolbarEnabled=1
WindowPos=0,1,-1,-1,-1,-1,390,107,1103,643
WindowFont=-16,500,0,Courier

TipFilePos=0

ShowTipOfDay=1

EditorType=3

RecentCommandLineO=mkall .mak
RecentCommandLinel=cpplib.mak -D(LIBNAME=cpplib)
CurrentCommandLine=mkall .mak
EditorDDEClientName=[open (%f) ]
EditorDDETopicName=system
EditorDDEServiceName=msdev
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EditorCommandLine=C:\WinEdit\WinEdit.exe %f /#:%1

Paths

Most environment variables contain path lists telling where to look for files. A path list is
a list of directory names, separated by semicolons, following the syntax below:

PathList = DirSpec {“;” DirSpec}.
DirSpec = [“*”] DirectoryName.
Example:

GENPATH=C: \INSTALL\LIB;D:\PROJECT\TESTS; \usr\local\freescale
\lib; /home/me/my_project

If a directory name is preceded by an asterisk ( * ), the programs recursively search that
whole directory tree for a file, not just the given directory itself. The directories are
searched in the order they appear in the path list.

Example:

LIBPATH=*C:\INSTALL\LIB

NOTE Some DOS/UNIX environment variables (like GENPATH, LIBPATH, etc.) are
used. For further details refer to Environment Variable Details.

We recommend working with WinEdit and setting the environment by means of a
DEFAULT.ENV (.hidefaults for UNIX) file in your project directory. You can set
this project directory in WinEdit's Project Configure menu command. This way, you can
have different projects in different directories, each with its own environment.

NOTE  When using WinEdit, do not set the system environment variable
DEFAULTDIR: Default Current Directory. If you use this variable and it does
not contain the project directory given in WinEdit’s project configuration, files
might not be put where you expect them.

Line Continuation

It is possible to specify an environment variable in an environment file (default.env/
.hidefaults) over different lines, using the line continuation character ‘\’:

Example:

COMPOPTIONS=\
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-w2 \

-Wpd

This is the same as:

COMPOPTIONS=-W2 -Wpd

Use caution when pairing this continuation character with paths. The following code:
GENPATH=.\

TEXTFILE=.\txt

Results in:

GENPATH=.TEXTFILE=.\txt

To avoid such problems, use a semicolon ( ; ) at the end of a path if the path contains a \’
at the end:

GENPATH=. \ ;
TEXTFILE=.\txt

Environment Variable Details

The remainder of this section describes each of the environment variables available for the
tools. The following table shows the types of information provided in the variable
descriptions.

Table A.1 Environment Variable Description

Topic Description
Tools Lists tools which use this variable.
Synonym Synonyms exist for some environment variables. Those synonyms

may be used for older releases of the SmartLinker and will be removed
in the future. A synonym has lower precedence than the environment

variable.
Syntax Specifies the syntax of the option in EBNF format.
Arguments Describes and lists optional and required arguments for the variable.
Default Shows the default setting for the variable, or none.
Description Provides a detailed description of the option and how to use it.
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Table A.1 Environment Variable Description (continued)

Topic Description

Example Gives a usage example, and illustrates the effects of the variable when
possible. Shows an entry in the default.env for PC or in the
.hidefaults for UNIX.

See also Names related sections.

ABSPATH: Absolute Path

Tools
SmartLinker, Debugger
Synonym

None

Syntax
ABSPATH= {<path>}

Arguments

<path>: Paths separated by semicolons, without spaces.

Description

When you define this environment variable, the SmartLinker stores the absolute files it
produces in the first directory specified there. If ABSPATH is not set, the SmartLinker
stores the generated absolute files in the directory in which the parameter file was found.

Example

ABSPATH=\sources\bin;..\..\headers; \usr\local\bin

See also

None
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COMP: Modula-2 Compiler

Tools
Maker

Synonym
None

Syntax

COMP = <compiler>.

Arguments

<compiler>: Used Modula-2 compiler.

Default

None.

Description

Use this environment variable to specify the Modula-2 compiler.

Example
COMP=C: \INSTALL\PROG\TPM. EXE

COPYRIGHT: Copyright Entry in Absolute File

Tools

Compiler, Assembler, SmartLinker, Libmaker

Synonym

None

Syntax
COPYRIGHT= <copyright>
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Arguments

<copyright>: copyright entry.

Default

None

Description
Each absolute file contains an entry for a copyright string. Use the decoder to retrieve this
information from the absolute files.
Example
COPYRIGHT=Copyright by PowerUser

See also

Environment variables USERNAME: User Name in Object File and
INCLUDETIME: Creation Time in Object File.

DEFAULTDIR: Default Current Directory

Tools

Compiler, Assembler, SmartLinker, Decoder, Debugger, Libmaker, Maker, Burner
Synonym

None

Syntax

DEFAULTDIR= <directory>.

Arguments

<directory>: Directory to be the default current directory.

Default

None
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Description

Use this environment variable to specify the default directory for all tools. When you use
this environment variable, all the tools indicated above take the specified directory as their
current directory instead of the one defined by the operating system or launching tool.

Example
DEFAULTDIR=C:\INSTALL\PROJECT

See also

Current Directory and Global Initialization File (MCUTOOLS.INI) (PC only).

NOTE  This is a the system level (global) environment variable. It cannot be specified
in a default environment file (DEFAULT.ENV/ .hidefaults).

ENVIRONMENT: Environment File Specification

Tools
Compiler, SmartLinker, Decoder, Debugger, Libmaker, Maker, Burner

Synonym
HIENVIRONMENT

Syntax
ENVIRONMENT= <file>

Arguments

<file>: file name with path specification, without spaces

Default

None

Description

You must specify this variable at the system level. Normally the application looks in the
current directory for the default.env/.hidefaults environment file. Using
ENVIRONMENT (e.g. set in the autoexec.bat (DOS) or . cshrc (UNIX) file), a
different file name may be specified.
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Example
ENVIRONMENT=\Freescale\prog\global.env

See also

None

NOTE  This is a system level (global) environment variable. It cannot be specified in a
default environment file (DEFAULT.ENV/.hidefaults).

ERROREFILE: Error File Name Specification

Tools

Compiler, SmartLinker, Assembler, Burner, Libmaker, Maker (restricted)

Synonym

None

Syntax

ERRORFILE= <filename>

Arguments

<filename>: File name with possible format specifiers.

Description

The environment variable ERRORFILE specifies the name for the error file. Possible
format specifiers are:

%n: Substitute with the file name, without the path.
%p: Substitute with the path of the source file.
% £: Substitute with full file name, i.e. with path and name (the same as $p%n).

Using an invalid error file name causes a notification box to appear.

NOTE  Maker does not recognize error files of other tools containing % substitutions.
Maker reads the string assigned to the environment variable ERRORFILE as
filename string without substitutions, so tools that use % substitutions for their
error output report their error to Maker as the unspecified error message
M5108 called application detected an error.
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NOTE  Maker cannot report error-position information with the same precision as a
compiler because most of the errors have a long history. Maker can only report
the general position, not the position where the error occurred. Most of
Maker’s messages lack position information (pos = 0).

Example

ERRORFILE=MyErrors.err lists all errors into the file MyErrors.err in
the project directory.

ERRORFILE=\tmp\errors lists all errors into the file called errors in the
\ tmp directory.

ERRORFILE=%f.err lists all errors into a file with the same name as the source
file, but with extension . err, into the same directory as the source file. For
example, linking a file called \ sources\test .prm generates an error list file
called \sources\test.err.

Specifying ERRORFILE=\dirl\%n.err and linking a source file called
test.prm generates an error list file called \dirl\test.err.

Specifying ERRORFILE=%p\errors. txt and linking a source file called
\dirl\dir2\test.prm generates an error list file called
\dirl\dir2\errors. txt.

If the environment variable ERRORFILE is not set, the errors are written to the file
EDOUT in the project directory, or to the default error file. The default error file
name depends on the way the application is started:

» Ifafile name is provided on the application command line, the errors are written
to the file EDOUT in the project directory.

* If no file name is provided on the application command line, the errors are
written to the file ERR. TXT in the project directory.
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Example

This example shows usage of this variable to support correct error feedback with
the WinEdit Editor, which looks for an error file called EDOUT:

Installation directory: E:\INSTALL\PROG
Project sources: D:\MEPHISTO

Common Sources for projects: E:\CLIB

Entry in default.env (D:\MEPHISTO\DEFAULT.ENV) :
ERRORFILE=E: \INSTALL\PROG\EDOUT

Entry in WINEDIT.INI (in Windows directory) :
OUTPUT=E: \INSTALL\PROG\EDOUT

NOTE Be sure to set this variable if the WinEdit Editor is use, otherwise the editor
cannot find the EDOUT file.

Maker-Specific Error Listing Information

If Maker detects any errors, it creates an error listing file ERR . TXT. Maker generates this
file in the working directory.

If you start Maker from WinEdit (with % £ on the command line) or Codewright (with
%$b%e on the command line), it does not produce this error file. Instead, Maker writes the
error messages in a special format in a file called EDOUT using the default Microsoft
format. Use WinEdit’s Next Error or Codewright’s Find Next Error command
to see both the error positions and the error messages.

Interactive Mode (Main Window Opened)

If you set ERRORFILE: Error File Name Specification, Maker creates a message file with
the name specified in this environment variable.

If you do not set ERRORFILE, Maker generates a default file named ERR . TXT in the
current directory.

Batch Mode (Main Window Closed)

If you set ERRORFILE: Error File Name Specification, Maker creates a message file with
the name specified in this environment variable.

If you do not set ERRORFILE, Maker generates a default file named EDOUT in the
current directory.
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FLAGS: Options for Modula-2 Compiler

Tools
Maker for Modula-2

Syntax
FLAGS = {<optionlist>}.

Arguments

<optionlist>: List of options.

Default

None

Description

Maker, fed with a Modula-2 main module, starts the compiler with the options specified
with FLAGS. The environment variable COMP specifies the Modula-2 compiler.

GENPATH: Define Paths to Search for Input Files

Tools
Compiler, Assembler, SmartLinker, Decoder, Debugger, Libmaker, Burner, Maker

Synonym
HIPATH

Syntax
GENPATH= {<path>}

Arguments

<path>: Paths separated by semicolons, without spaces.

Description

The application looks for the prm first in the project directory, then in the directories
listed in the environment variable GENPATH. The object and library files specified in the
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linker prm file are searched in the project directory, then in the directories listed in the
environment variable OBJPATH and finally in those specified in GENPATH.

Example

GENPATH=\o0bj;..\..\lib;

GENPATH=\sources\include;..\..\headers;\usr\localllib

NOTE  If a directory specification in this environment variables starts with an asterisk
(*), the application searches the whole directory tree recursively, depth first,
i.e., all subdirectories and their subdirectories and so on are searched, too.
Within one level in the tree, search order of the subdirectories is indeterminate.

INCLUDETIME: Creation Time in Object File

Tools

Compiler, Assembler, SmartLinker, Libmaker

Synonym

None

Syntax
INCLUDETIME= ( ON | OFF )

Arguments
ON : Include time information into object file.

OFF : Do not include time information into object file.

Default
ON

Description

Normally each absolute file created contains a time stamp indicating the creation time and
data as strings. When one of the tools creates a new file, the new file gets a new time
stamp entry.

This behavior may be undesirable if a binary file compare must be performed. Even if the
information in two absolute files is the same, the files do not match exactly because the
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time stamps are different. To avoid such problems this variable may be set to OFF. In this
case the time stamp strings in the absolute file for date and time are none in the object file.

Use the decoder to retrieve the time stamp from the object files.

Example
INCLUDETIME=0OFF

LINK: Linker for Modula-2

Tools
Maker for Modula-2

Syntax

LINK = {<linker>}.

Arguments

<linker>: Linker for Modula-2.

Default

none

Description

Maker, fed with a Modula-2 main module, starts the linker specified in this environment
variable.

LINKOPTIONS: Default SmartLinker Options

Tools

SmartLinker

Synonym

None

Syntax
LINKOPTIONS= {<option>}
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Arguments

<option>: SmartLinker command line option.

Description

Setting this environment variable appends the option contents to the SmartLinker
command line each time a file is linked. Use this option to specify certain required
options, so that you do not have to specify them each time a file is linked.

Example
LINKOPTIONS=-W2

See also
Option Details

OBJPATH: Object File Path

Tools

Compiler, Assembler, SmartLinker, Decoder, Debugger

Synonym

None

Syntax
OBJPATH= {<path>}

Arguments

<path>: Paths separated by semicolons, without spaces.

Description

Defining this environment variable causes the linker to search for the object and library
files specified in the linker prm file in the project directory, then in the directories listed in
the environment variable OBJPATH, and finally in those specified in GENPATH.
Example

OBJPATH=\sources\bin;..\..\headers;\usr\local\bin
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RESETVECTOR: Reset Vector Location

Tools

Compiler, Assembler, SmartLinker
Synonym

None

Syntax
RESETVECTOR= <Address>

Arguments

<Address>: Address of reset vector

Default
OxFFFE

Description
For the VECTOR directive, the linker must know where to place VECTOR 0.

Example
RESETVECTOR=0xFFFE

SRECORD: S Record File Format

Tools

Assembler, SmartLinker, Burner

Synonym

None

Syntax
SRECORD= <RecordType>
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Arguments

<Record Type>: Force the type for the S Record which must be generated. This
parameter may take the value S1, S2 or S3.

Description

This environment variable is relevant only when absolute files, rather than object files, are
directly generated by the macro assembler. When you define this environment variable,
the Assembler generates a Freescale S-record file containing records of the specified type
(S1 records when S1 is specified, S2 records when S2 is specified and S3 records when
S3 is specified).

If you do not set this variable, the assembler generates S records based on the address size.
If the address can be coded on two bytes, the assembler generates an S1 record. If the
address is coded on three bytes, the assembler generates an S2 record. Otherwise the
assembler generates an S3 record.

Example
SRECORD=S2

NOTE  If you set the SRECORD environment variable, it is your responsibility to
specify the appropriate S-record type. Specifying S1 when your code is loaded
at an address greater than OXFFFF results in an incorrect S file, in which all
addresses are truncated to 2-byte values.

TEXTFAMILY: Text Font Family

Tools

Compiler, Assembler, Linker, Decoder, Libmaker, Maker

Synonym

HITEXTFAMILY

Syntax

TEXTFAMILY = <FontName>.

Arguments

<FontName>: Font family name to use.
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Default

Terminal

Description

Defines the font family to use. The default font family is “Terminal.”

Example

TEXTFAMILY=Times

TEXTKIND: Text Font Character Set

Tools

Compiler, Assembler, Linker, Decoder, Libmaker, Maker
Synonym
HITEXTKIND

Syntax
TEXTKIND = ( OEM | ANSI ).

Arguments
OEM: Use OEM font character set.
ANSTI: Use ANSI font character set.

Default

OEM

Description

Gives the character set, OEM or ANSI. OEM is the default value.

Example
TEXTKIND=ANSTI
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TEXTPATH: Text Path

Tools
Compiler, Assembler, SmartLinker, Decoder, Libmaker
Synonym

None

Syntax
TEXTPATH= {<path>}

Arguments

<path>: Paths separated by semicolons, without spaces.

Description

When you set this environment variable, the application stores the map file it produces in
the first directory specified in the path. If TEXTPATH is not set, the application stores
generated map file in the directory where the prm file was found.

Example

TEXTPATH=\sources. .\..\headers;\usr\local\txt

TEXTSIZE: Text Font Size

Tools
Compiler, Assembler, Linker, Decoder, Libmaker, Decoder, Maker

Synonym

HITEXTSIZE

Syntax

TEXTSIZE = <number>

Arguments

<number>: Font size to use.
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Default
14

Description

Defines the size of the font. The default size is 14 point.

Example
TEXTSIZE=12

TEXTSTYLE: Text Font Style

Tools

Compiler, Assembler, Linker, Decoder, Libmaker, Maker
Synonym
HITEXTSTYLE

Syntax
TEXTSTYLE = ( NORMAL | BOLD )

Arguments
NORMAL: Use normal font style (not bold or italic).
BOLD: Use bold font style.

Default
NORMAL

Description
Defines the font style to use, NORMAL or BOLD. The default value is NORMAL.

Example
TEXTSTYLE=BOLD
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TMP: Temporary Directory

Tools
Compiler, Assembler, SmartLinker, Debugger, Libmaker, Burner
Synonym

None

Syntax

TMP= <directory>

Arguments

<directory>: Directory to be used for temporary files.

Description

This environment variable works in conjunction with the ANSI function tmpnam ()
when the tools must create a temporary file. The tmpnam () library function stores the
temporary files in the directory specified by the TMP environment variable. If the variable
is empty or does not exist, the tool stores the temporary files in the current directory.
Check this variable if you get an error message Cannot create temporary file.
Example

TMP=C: \TEMP

See also
Current Directory

NOTE  This is a system level (global) environment variable. It cannot be specified in a
default environment file (DEFAULT .ENV/.hidefaults).

USERNAME: User Name in Object File

Tools

Compiler, Assembler, SmartLinker, Libmaker
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Synonym

None

Syntax

USERNAME= <user>

Arguments

<user>: Name of user.

Description

Each absolute file contains an entry identifying the user who created the file. Use the
decoder to retrieve this information from the absolute files.

Example

USERNAME=PowerUser

See also

COPYRIGHT: Copyright Entry in Absolute File and INCLUDETIME: Creation
Time in Object File
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Each tool offers a number of options that you can use to control operation. Options are
composed of a dash ( - ) followed by one or more letters or numerals. Options not starting
with a dash are interpreted as the name of a parameter file to be linked.

Command line options are not case-sensitive. For example, -W1 is the same as —w1 .

* SmartLinker Specific: Anything not starting with a dash is the name of a parameter
file to be linked. Specify SmartLinker options on the command line or in the
LINKOPTIONS variable (see LINKOPTIONS: Default Smartlinker Options).
Typically, each linker option is specified only once per linking session.

Setting the LINKOPTIONS environment variable appends the option contents to the
SmartLinker command line each time a file is linked. Use this option to specify
certain required options, so that you do not have to specify them each time a file is
linked.

* Burner specific: The burner command line can contain the name of a file to be built
with the -F: Execute Command File, or a list of commands.

Options before the first command on the command line are recognized. Then, all
remaining text is taken as arguments to the command, including options. For
example:

OPENFILE "fibo.out" format=freescale 1len=0x1000 SENDBYTE
1 "fibo.abs.abs" CLOSE

Command is executed.
-f=fibo.bbl executes the fibo.bbl command file.

-f fibo.bbl is an alternate form of the recommended -f=fibo.bbl. This
form is allowed for compatibility only.

fibo.bbl -f isnotallowed, because the burner interprets fibo.bbl as a
command with argument - £. This generates an error, since no such command exists.

* Options for the Freescale object file format may differ from the options for decoding
ELF/DWAREF binaries.

* You can specify maker options on the command line or interactively in the Advanced
Option Settings dialog box.

NOTE  Not all tools options have been defined for this release. All descriptions will be
available in an upcoming release.
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Option Details

The remainder of this section describes each of the options available for the tools. The
following table lists the details available for each of the options.

Table B.1 Option Details

Topic Description
Group Specifies the groups influenced by the option.
Syntax Specifies the option syntax.

Arguments | Describes and lists optional and required arguments for the option.

Default (Where used): Shows the default setting for the option.

(Where not used): No default setting for the option.

Description | Provides a detailed description of the option and how to use it.

Example Gives an example of usage, and effects of the option where possible.
Shows settings, source code and/or prm files where applicable.

See also (Where used): Names related topics.

Table B.2 Option Groupings

Group Tools Description
HOST All Host-related options
INPUT All Specification of command-line handling, such as

macro definitions and unknown-macro expansions.

MESSAGES All Message handling, such as specification of format,
kind, and number of Maker printed messages

MODULA-2 M Modula-2 make-specific options. (No effect for C
users.)

NONE SL These options cannot be specified interactively.

OPTIMIZATIONS | SL

OUTPUT SL, LM, Specification of command execution and output print
D, M
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Table B.2 Option Groupings (continued)

Group Tools Description
STARTUP SL These options cannot be specified interactively.
VARIOUS SL,B, M Does not appear in the dialog box

Special Modifiers

You can use special modifiers with some options, although some modifiers may not make
sense for all options. The following table lists and describes these modifiers.

Table B.3 Supported Modifiers

Modifier Description

%op Path including file separator

%N File name in strict 8.3 format

%N File name without extension

%E Extension in strict 8.3 format

%L Extension

Yof Path + file name without extension

%" A double quote (“) if the file name, path or extension contains a space
%’ A single quote (‘) if the file name, path or extension contains a space
%(ENV) Replaces it with contents of an environment variable

%% Generates a single ‘%’
Examples

For these examples we assume that our actual file name (base file name for the modifiers)
is:

c:\Freescale\my demo\TheWholeThing.myExt
%p gives the path only with a file separator:
c:\Freescale\my demo\

%N results in the file name in 8.3 format, that is the name with only eight characters:
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TheWhole

%n returns just the file name without extension:

TheWholeThing

%E gives the extension in 8.3 format, that is, the extension with only three characters:
myE

%e is used for the whole extension:

myExt

% £ gives the path plus the file name:

c:\Freescale\my demo\TheWholeThing

Because the path contains a space, using $” or %' is recommended: Thus $”%£%" gives:
c:\Freescale\my demo\TheWholeThing

where $' $£%’ gives:

‘c:\Freescale\my demo\TheWholeThing’

When using % (envVariable) an environment variable may be used too. A file
separator after $ (envVariable) isignored if the environment variable is empty or
does not exist. For example, $ (TEXTPATH) \myfile. txt is replaced with:

c:\Freescale\txt\myfile.txt

if TEXTPATH is set to:

TEXTPATH=c: \Freescale\txt

But is set to:

myfile.txt

if TEXTPATH does not exist or is empty.

%% may be used to print a percent sign. $e%% gives:

myExt%

-A: Print Full Listing (Decoder)

Group
OUTPUT

Syntax

-A

326

Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Tool Options
Option Details

Arguments

None

File Format
Only Freescale. ELF Object files are not affected by this option.

Description

Prints a listing with the header information of the object file.
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Example

Listing with command line fibo.o -A:

*** Header information ***

Program Version 2700

Format Version 2

File Id 129

flags 0

processor family 11
processor type 1

Unitname fibo.abs
Username PFR
Program time string Feb 25 1998
Creation time string Wed Feb 25 11:43:22 1998
CopyRight

*** Directory information for Absfile***

Is romlib? 0

Init start:end 32774:32774

Code beg:end 32768:32939
Data beg:end 384:4096
Total number of objects 7

At address: 8000 code size: 40
00008000 1410 ORCC #16
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-A: Warning for Missing .DEF File (Maker)

Group
MODULA-2

Syntax
-A

Arguments

None

Description
Invokes a warning for a missing . DEF file and affects only the processing of Modula-2

makefiles.

Example

maker test.mod -M -A

-Add: Additional Object/Library File

Group
INPUT

Syntax
-Add <FileList>

Arguments

<FileList>: Names of an additional object files or libraries.

Description

Use this option to add additional files to a project without modifying the link parameter
file.

If you intend to specify all binary files using the ~Add command line option, then you
must include an empty NAMES block (just NAMES END) in the link parameter file.
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SmartLinker links object files added with this option before linking the object files
specified in the NAMES block.
Example
To specify more than one file either use several -Add options:
linker.exe demo.prm -addFileA.o -addFileB.o
Or use braces to bind the list to the ~-Add option:
linker.exe demo.prm -add(FileA.o FileB.o)

Use braces together with double quotes to add a file in which the name contains
spaces:

linker.exe demo.prm -add(“File A.o” “File B.o")
linker.exe fibo.prm -addfibol.o -addfibo2.o
This example links the additional object files £ibol .o and £ibo2 . o with the
fibo application.

See also
NAMES: List Files Building the Application.

NOTE  To turn off smart linking for the additional object file, use a + sign immediately
behind the filename.

-Alloc: Allocation Over Segment Boundaries (ELF)

Group
OPTIMIZATION

Syntax

-Alloc ( First | Next | Change )

Arguments
First : Use first free location
Next : Always use next segment

Change : Check when segment changes only
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Default

-AllocNext

Description

The linker supports allocating objects from one ELF section into different segments. This
option controls where space for the next object is allocated as soon as the first segment is
full.

When you use -AllocNext, the linker always takes the next segment as soon as the
current segment is full. Gaps resulting from this process are not used later. With the Next
argument, the allocation order corresponds to the definition order in the object files.
Objects defined first in a source file are allocated before objects defined later.

When you use ~-AllocFirst, the linker checks space requirements for every object. If
the object fits into a previously used, partially filled segment, the linker uses that space.

-AllocFirst does not maintain the definition order.

When you use ~-AllocChange, the linker checks space requirements only when the
object does not fit into the current segment. If the object fits into a previously used,
partially filled segment, the linker uses that space. -A1l1locChange does not maintain the
definition order, but uses fewer different ranges than ~-AllocFirst.

NOTE  This option has no effect in the Freescale format. In the Freescale format, the
linker always uses the -Al1locNext strategy. The linker does not maintain
allocation order for small variables.

NOTE  This option has no effect if sections are not split into segments. Then all
strategies behave identically.

NOTE  Some compilers perform code optimization in the assumption that the
definition order is maintained in the memory. Such code is not split into
multiple segments so no problems result from using this option.

Example
Objects: AAAA BB CCC D EEE FFFFF
Segments: W N e ”
AllocNext: “---" “AAAABB-" “CCCDEEEFFFFF”

AllocChange: “CCC” “AAAABBD” “EEEFFFFF----"
AllocFirst: “BBD” “AAAACCC” “EEEFFFFF----"
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In this example, objects A (size 4 bytes), B (size 2 bytes), and F (size 5 bytes) must
be allocated into three segments of size 3, 7 and 12 bytes. Because object A does
not fit into the first segment, ~-A11ocNext does not use this space at all. The two
other strategies fill this space later. Only -A11ocNext maintains object order.

-ArgFile: Specify a file from which additional command line op-
tions will be read

Group
HOST

Syntax

-ArgFile<filename>

Arguments

<filename>: Specify filename that has options to be passed to command line.

Description

The options present in file are appended to existing command line options.

Example
option.txt
-M
Linker.exe -ArgFileoption.txt test.prm

This is equivalent to linker.exe -M test.prm and linker generates output file test.map

-AsROMLib: Link as ROM Library
Group
OUTPUT

Syntax
-AsROMLib

332 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Tool Options
Option Details

Arguments

<FileList>: Names of an additional object files or libraries.

Description

Set ~AsROML1iDb to link the application as a ROM library. This option has the same effect
as specifying AS ROM_LIB in the linker parameter file.

Example

linker.exe myROMlib.prm -AsROMLib

-B: Generate S-Record file (SmartLinker)

Group
OUTPUT

Syntax

-B

Arguments

None

Default
Disabled

Description

Setting this option tells the linker to generate an S-record file in addition to an absolute
file. The name of the S-record file is the same as the name of the . abs file, except that the
extension . SX is used. The default. env variable SRECORD may specify an
alternative extension.

Example
LINKOPTIONS=-B
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-C: Write Disassembly Listing with Source Code (Decoder)

Group
OUTPUT

Syntax
-C

Arguments

None

Default

None

File Format
Only Freescale. (ELF Object files are not affected by this option.)

Description

This option setting is default for the Freescale object files as input. When this option is
specified, the Decoder decoding Freescale object files writes the source code within the
disassembly listing.
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Example

unsigned int Fibonacci (unsigned int n)

Fibonacci:
00000000 89
00000001 8B
00000002 A7F8

6: unsigned
00000004 95
00000005 6F01
00000007 7F

7: unsigned
00000008 AEO1L
0000000A 8C
0000000B 9EFF03

8: unsigned
0000000E 9EFE09
00000011 9EFFO7

9: unsigned

CLR , X

intfib2 = 1;

LDX #0x01

CLRH

STHX 3,S5P
intfibo = n;

LDHX 9,8P

STHX 7,SP
int 1 = 2;

-C: Ignore Case (Maker)

Group
INPUT

Syntax
-C

Arguments

None

Description

The make utility has default case sensitivity. Use this option to disable case sensitivity and
treat lowercase characters the same as uppercase characters.
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Example
maker test.mak -o
In the file test .mak:
OBJECTFILES = startup.o fibo.o
makeAll: $(ObjectFiles)
This line with -c is equivalent to:

makeAll: $(OBJECTFILES)

CAllocUnusedOverlap: Allocate Not Referenced Overlap Variables
(Freescale)

Group
OPTIMIZATION

Syntax

-CAllocUnusedOverlap

Arguments

None

Description

When Smart Linking is switched off, defined but unreferenced overlapped variables are
not allocated by default. Such variables do not belong to a specific function, therefore they
cannot be allocated overlapped with other variables.

This option only changes the behavior of variables in the special _OVERLAP segment.
This segment is used only to allocate parameters and local variables for processors which
do not have a stack. Not allocating an unreferenced overlap variable is similar to not
allocating a variable on the stack for other processors. If you use this stack analogy, then
allocating such variables this way corresponds to allocating unreferenced stack variables
in global memory.

This option allows allocation of all defined objects. Using this option is not recommended.

Example
LINKOPTIONS=-CAllocUnusedOverlap
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-Ci: Link Case Insensitive

Group
INPUT

Syntax
-Ci

Arguments

None

Description
With this option, the linker ignores object name capitalization.

This option supports case-insensitive linking of assembly modules. Since all identifiers
are linked case insensitive, this also affects C or C++ modules.

NOTE  This option can cause severe problems when combined with the name
mangling of C++. Do not use this option with C++.

This option only affects the comparison of names of linked objects. Section names or the
parsing of the link parameter file are unaffected. They remain case sensitive.

Example
void Tim(void) ;
void main (void) {
tim(); /* with -ci this call is resolved to Tim */
}

The linker matches the t im and Tim identifiers at link time. However, for the
compiler these are still two separate objects and therefore the code above issues an
“implicit parameter declaration” warning.

-CheckAcrossAddrSp... ELF/DWARF: Check if objects overlap in
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the absolute file (even if different address spaces)

Group
OUTPUT

Syntax
-CheckAcrossAddrSp

Arguments

None

Description

This option when enabled throws error for objects allocated to multiple segments and all
these segments span the same physical memory.

For example:

PRM of mc9s08gel28:

PPAGE_5 = READ_ONLY 0x058000 TO OxO5BFFF;

MY_PPAGE_b5 READ_ONLY 0x014000'F TO
0x014FFF'F; /* This page is already in segment PPAGE_5 */

PLACEMENT

Cl INTO PPAGE_5;
C2 INTO MY_PPAGE_5;
END

Assume C1 and C2 sections have cnst1 and cnst2 constants defined in 'C' source. For
this test case, when option enabled, linker throws error:

Link Error : L1924: Objects cnstl and cnst2 overlap

-Cmd: Libmaker Commands

Group
OUTPUT
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Syntax

w_Cmd” "“" <commands> "“").

Arguments

<commands>: libmaker commands, separated by semicolon.

Default

None.

Description

You can either run a libmaker command file (preceded by ‘@’), or use the -Cmd command
on the command line to run libmaker commands. Alternatively, you can use the command
without the ‘+’ operator as well:

-Cmd”a.o b.o c.o = d.1lib”
Instead of “..” to wrap around the command string, you can use as well:
-Cmd(a.o b.o c.o = d.1lib)
-Cmd[a.o b.o c.o = d.1ib]
-Cmd{a.o b.o c.o = d.1lib}
-Cmd’a.o b.o c.o = d.1lib’

If your file names have spaces or operator characters in the file name, you need to use
double quotes for the file name:

-Cmd(a.o “my b.o” “c-c.o” = d.1lib)

You still can use double quotes for the -~Cmd option, but in such a case you need to
double-double quote files names in double quotes:

-Cmd”a.o “‘my b.o”” “‘“c-c.o"” = d.lib”

Example

-Cmd”a.o + b.o = c.1lib”

See also
-Mar: Freescale Archive Commands (Libmaker)
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-Cocc: Optimize Common Code (ELF)

Group
OPTIMIZATION

Syntax
-Cocc [ = [ D] [ C ]I

Arguments
D : optimize Data (constants and strings).
C : optimize Code

Description

This option defines the default when optimizing constants and cod. The commands
DO_OVERLAP_CONSTS and DO_NOT_OVERLAP_CONSTS take precedence over the

option.
Example
printf (“Hello World\n”); printf(“\n”);

-Cocc allocates the string “\n” inside of the string *“Hello World\n-”.

-ConstDist: ELF/DWARF: Enable automatic content placement
Group
OPTIMIZATION

Syntax

-ConstDist

Arguments

None
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Description

With this option the linker constant optimizer is enabled. Instead of performing usual
linking actions, the linker generates a data distribution file which contains optimized
distribution for constant objects.

-ConstDistSeqg: ELF/DWARF: Specify constant distribution seg-
ment name

Group
OPTIMIZATION

Syntax

-ConstDistSeg <segment name>

Arguments

<segment name>: Name of the constant distribution segment.

Default
CONST_ DISTRIBUTE

Description

When this option is enabled, it's possible to specify the name of the constant distribution
segment.

Example

LINKOPTIONS=-ConstDistSegMyDistributionSegment

NOTE  If the project has to distribute only constant objects then ~-ConstDist, -
ConstDistSeg, -DataDistInfo and -DataDistFile options are
to be used. -DataDistInfo and -DataDistFile options are used in
common for optimization of data and constant objects.
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-CRam: Allocate Non-specified Constant Segments in RAM (ELF)

Group
OPTIMIZATION

Syntax

-CRam

Arguments

None

Description

This option allocates constant data segments not explicitly allocated in a READ_ONLY
segment in the default READ_WRITE segment.

This was the default for old versions of the linker, so this option provides a compatible
behavior with old linker versions.

Example

When C source files are compiled with —CC, the constants are put into the
ROM_VAR segment. If the ROM_VAR segment is not mentioned in the prm file,
then without this option, these constants are allocated in DEFAULT_ROM. With
this option they are allocated in DEFAULT_RAM.

-D: Display Dialog Box (Burner)
Group
VARIOUS

Syntax

w_D”

Arguments

None

342 Microcontrollers v10.x HC(S)08/RS08 Build Tools Utilities Manual



Tool Options
Option Details

Default

None

Description

This option displays the Burner dialog box. This interface, with its three tabs, allows you
to launch the burner from a make file and await user input.

Figure B.1 Burner Dialog Window Input/Output Tab

Example

burner.exe -D

-D: Decode DWARF Sections (Decoder)

Group
OUTPUT

Syntax
-D

Arguments

None

Default
Disabled

File Format
Only ELF. Freescale object files are not affected by this option.

Description

When you specify this option, DWARF section information is also written to the listing
file. Decoding from the DWAREF section inserts this information in the listing file. See the
following listings for more information.

Listing B.1 Source/code reference information

.debug_line
0x4 Version 2
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0x6 PrologLen 1221

Oxa MinInstrLen 1lc

Oxb DefIsStmt Oc

0xc LineBase Oc

0xd LineRange 4c

Oxe DW2L_OpcodeBase 9c

0xf Opcodelengths : Oc 1lc 1lc 1lc 1lc Oc Oc Oc 1lc

Includedir :
0x19 File 1: Y:\DEMO\WAVEl2C\fibo.c, 0, 0, O
0x33 File 2: y:\LIB\ELFl12C\hidef.h, 0, 0, O
Ox4c File 3: y:\LIB\ELFl2C\default.sgm, 0, 0, O
0x69 File 4: y:\LIB\ELFl1l2C\stddef.h, 0, 0, O
0x84 Set Addr 867(2151): ADDR FILE LINE COL STMT BASIC
0x8b set column : 867 1 1 14 0 0
0x8d advance line : 867 1 8 14 0 0
0x8f negate stmt : 867 1 8 14 1 0
0x90 negate stmt : 867 1 8 14 0 0

Listing B.2 Argument location for local variables information

.debug_1loc
0 Start 867, End 869 (2)DW_OP_bregl5 0(0)
Oxc Start 869, End 86a (2)DW_OP_bregl5 8(8)
0x18 Start 86a, End 895 (2)DW_OP_bregl5 10(a)
0x24 Start 895, End 896 (2)DW_OP_bregl5 0(0)

0x30 0, 0 : end of location-list

Listing B.3 Symbol Debug information

DWARF: .debug_info (1053) [0x734]
Compi.Unit Header: size 304, version 2, abbrev 0, addrsize 4
0xb Abbrevation 128 ,compile_unit

0xd name string fibo.c

0x14 producer string FREESCALE

Ox1b comp_dir string Y : \DEMO\WAVE12C
0x2b language udata DW_LANG_C89
0x2c stmt_list data4d 0(0)

Listing B.4 Frame Debug Information

.debug_frame
0 CIE Information 0x8 Version 1
0x9 Augmentor Freescale CFA 1.0
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0x18 CodeAlign: 1, DataAlign: 1, ReturnAddr-Column: 18

0x1lb instruction PC FP(Reg) R[ 0] R[ 1] R[ 2] R[ 3]

R[ 4] R[ 5]

R[ 6] R[ 7] R[ 8] R[ 9] R[10] R[11] R[12] R[13] R[14] R[15] R[16] R[17]

R[18] R[19] R[20]

R[30] R[31]

Oxlbstart-values 84d: 0(15)
Oxlb Def CFA Register reg: 15,
0x1d Def CFA Offset ofs: O
0x1f Offset: reg 18, Ofs: 0
0x21 Undefined reg: 0

0x23 Undefined reg: 1

R[21] R[22] R[23] R[24] R[25] R[26] R[27] R[28] R[29]

NOTE  Specify the -E option when the -D option is activated.

-D: Define a Macro (Maker)

Group
INPUT

Syntax

-D <macroname> = <value>

Arguments

The macro definition string “<macroname> = <value>".

Description

This option defines command-line macros. Command-line macros define macros and
arguments for the make file. A macro defined this way has a higher priority than a macro
defined in the makefile. Because you separate the arguments in the command line with

spaces, you cannot place spaces in a command-line macro.

Examples
-dCOMP=chc08.exe
-dCOMP=chc08.exe -Li -Wi
-d[MAKE=Maker.exe -s -d(COMP=$ (COMP)) ]
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-DataDist: ELF/DWARF: Enable automatic data placement

Group
OPTIMIZATION

Syntax

-DataDist

Arguments

None

Description

With this option the linker data optimizer is enabled. Instead of performing usual linking
actions, the linker generates a data distribution file which contains optimized distribution.

-DataDistFile: ELF/DWARF: Specify data distibution file name

Group
OPTIMIZATION

Syntax

-DataDistFile <file name>

Arguments

<file name>: Name of the data distribution file.

Default

data.inc

Description

When this option is enabled, it's possible to specify the name of the data distribution file.
There, all distributed data and how the compiler has to reallocate them are listed.

Example

LINKOPTIONS=-DataDistFileMyFile
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-DataDistIinfo: ELF/DWARF: Generate data optimizer information
file

Group
OPTIMIZATION

Syntax

-DataDistInfo <file name>

Arguments

<file name>: Name of the data information file.

Default

data.txt

Description

When this option is enabled, the data optimizer generates a data distribution information
file giving information on object to segment mapping.

Example

LINKOPTIONS=-DataDistInfoMyFile

-DataDistSeqg: ELF/DWAREF: Specify data distribution segment
name

Group
OPTIMIZATION

Syntax

-DataDistSeg <segment name>

Arguments

<segment name>: Name of the data distribution segment.
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Default
DATA_DISTRIBUTE

Description

When this option is enabled, it's possible to specify the name of the data distribution
segment.

Example

LINKOPTIONS=-DataDistSegMyDistributionSegment

-Dconf[={a}]" Configure which parts of DWARF information to de-
code

Group
OUTPUT

Syntax

-Dconf=<argument>

Arguments
[={a}]

Description
It decodes DWARF?2 abbreviation tables in the output list file.

-DefaultEpage: ELF/DWARF: Define the default value of the PPAGE
register

Group
OUTPUT

Syntax

-DefaultEpage<hexvValue>
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Arguments
<hexValue>: the reset value for the EPAGE register, in hex format (e.g. 0xFE)

Default

0 for <hexValue>

Description

This option defines the reset value for the EEPROM Page Index Register
(EPAGE). The value is specific to the actual S12(X) derivative.

-DefaultPpage: ELF/DWARF: Define the default value of the PPAGE
register

Group
OUTPUT

Syntax
-DefaultPpage <hexValue>

Arguments
<hexValue>: the reset value for the PPAGE register, in hex format (e.g. OxFE)

Default

0 for <hexValue>

Description

This option defines the reset value for the Program Page Index Register (PPAGE). The
value is specific to the actual S12(X) derivative.

-DefaultRpage: ELF/DWARF: Define the default value of the RPAGE
register

Group
OUTPUT
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Syntax

-DefaultRpage <hexValue>

Arguments
<hexValue>: the reset value for the RPAGE register, in hex format (e.g. 0xFD)

Default

0 for <hexValue>

Description

This option defines the reset value for the RAM Page Index Register (RPAGE). The value
is specific to the actual S12(X) derivative.

-Disp: Display Mode (Maker)

Group
OUTPUT

Syntax
-Disp
Arguments

None

Description

Maker echoes executing commands without calling them. Use this mode to check the
dependency graph without affecting any files.

Example

maker test.mak -disp

-Dist: Enable Distribution Optimization (ELF) (SmartLinker)

Group
OPTIMIZATIONS
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Syntax
-Dist
Arguments

None

Description

This option enables the linker optimizer. Instead of a link, the linker generates a
distribution file which contains an optimized distribution.

-DistFile: Specify Distribution File Name (ELF) (SmartLinker)

Group
OPTIMIZATIONS

Syntax

-DistFile <file name>

Arguments

<file name>: Name of the distribution file.

Default

distr.inc

Description
Enable this option to specify the name of the distribution file. The distribution file lists all
distributed functions and specifies how the compiler reallocates them.
Example
LINKOPTIONS=-DistFileMyFile

-DistInfo: Generate Distribution Information File (ELF) (SmartLink-
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er)

Group
OPTIMIZATIONS

Syntax

-DistInfo <file name>

Arguments

<file name>: Name of the information file.

Default
distr.txt

Description
Using this option, the optimizer generates a distribution information file containing a list
of all sections and their functions. Available function information includes the old size,
optimized size, and new calling convention.
Example

LINKOPTIONS=-DistInfoMyInfoFile

-DistOpti: Choose Optimizing Method (ELF) (SmartLinker)

Group
OPTIMIZATIONS

Syntax
-DistOpti ( FillBanks | CodeSize )

Arguments
FillBanks : Priority is to fill the banks.

CodeSize : Priority is to minimize the code size.

Default

-DistOptiFillBanks
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Description

Enable this option to choose the optimizing method. With the Fi11Banks argument the
linker minimizes the free space in every bank. Fil1lBanks is most effective for functions
using the near calling convention. Use the CodeSize argument to minimize code when
free space within the banks is no concern.

Example
LINKOPTIONS=-DistOptiFillBanks

-DistSeg:

Specify Distribution Segment Name (ELF) (SmartLinker)

OPTIMIZATIONS

Syntax

-DistSeg <segment name>

Arguments

<segment name>: Name of the distribution segment.

Default
DISTRIBUTE

Description

Use this option to specify the name of the distribution segment.

Example
LINKOPTIONS=-DistSegMyDistributionSegment

-E: Specify the Name of the Startup Function

Group
INPUT

Syntax

-E= <FunctionName>
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Arguments

<FunctionName> : Name of the function considered to be the entry point in the
application.

Description
This option specifies the name of the application entry point.

The symbol specified must be externally visible (not defined as static in an ANSI-C source
file or XREFed in an assembly source file).

Example
LINKOPTIONS=-E=entry
This is the same as using the command:
INIT entry

in the prm file.

-E: Decode ELF sections (Decoder)

Group
OUTPUT

Syntax
-E
Arguments

None

File Format
Only ELF. Freescale Object files are not affected by this option.

Description

When you specify this option, ELF section information is also written to the listing file.
Decoding from the ELF section inserts the following information in the listing file:

Listing B.5 ELF Header Information

File: Y:\DEMO\WAVEl2C\fibo.abs
Ident: ELF with 32-bit objects, MSB encoding, Version 1
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Type: Executable file, Machine: Freescale HCO08, Vers: 1
Entry point: 83D

E1f flags: O

E1fHSiz: 34

ProgHOff: 34, ProgHSi: 20, ProgHNu: 6
SectHOff: E3A, SectHS1: 28, SectHNu: 19,
SectHSTI: 18

Usually the ELF Program header Table is available only for absolute files.

Listing B.6 ELF Program header Table Information

PROGRAM HEADER TABLE - 6 Items

Starts at: 34, Size of an entry: 20, Ends at: F4
NO TYPE OFFSET SIZE VIRTADDR PHYADDR MEMSIZE FLAGS ALIGNMNT
0 - PT_PHDR 34 Cco
1 - PT_LOAD F4 0 0 800 4 6 0
2 - PT_LOAD F4 AE 0 810 AE 1 0

Listing B.7 ELF Section Header Table Information

SECTION HEADER TABLE - 19 Items

Starts at: E3A, Size of an entry: 28, Ends at: 1132
String table is in section: 12
NO NAME TYPE FLAGS OFFSET SIZE ADDR ALI RECS LINK INFO
0- NULL 0 0 0 0 0 0 0
1-.common NOBITS WA F4 4 800 0 0 0 0
2-.init PROGBITS AX F4 3D 810 0 0 0 0
3-.startData PROGBITS AX 131 1A 84D 0 0 0 0
4-.text PROGBITS AX 14B 55 867 0 0 0 0
5-.copy PROGBITS AX 1A0 2 8BC 0 0 0 0
6-.stack NOBITS WA 1A2 100 BOO 0 0 0 0
7-.vectSeg0_vect PROGBITS AX 1A2 2 FFFE 0 0 0 0

Listing B.8 Symbol Table Information

SYMBOL TABLE: .symtab - 13 Items

Starts at: 1A4, Size of an entry: 10, Ends at: 274
String table is in section: 9

First global symbol is in entry no.: 8

NO NAME VALUE SIZE BIND TYPE SECT
0- 0 0 LOCAL NOTYPE
1- 0 0 LOCAL SECTION 1
2- 0 0 LOCAL SECTION 2
3-Init 810 2D LOCAL FUNC 2
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4- 0 0 LOCAL SECTION 3
5- 0 0 LOCAL SECTION 4

Listing B.9 Relocation Section Information

RELOCATION TABLE RELA: .rela.init - 1 Items
Starts at: 2AA, Size of an entry: C, Ends at: 2B6
Symbol table is in section: 8
Binary code/data is in section: 2
NO OFFSET SYMNDX TYP ADDEND SYMNAME
0 - 2163 873 3 3 4107 Init

Listing B.10 Hexadecimal dump from all sections defined in the binary file

HEXDUMP OF: .init FROM 244 TO 305 SIZE 61 (0X3D)

OFFSET +0 +1 +2 +3 +4 +5 +6 +7 : +8 +9 +A +B +C +D +E +F ASCII DATA
000000 FE 08 55 FD 08 53 27 10 : 35 ED 31 EC 31 69 70 83 ...U
S'.5.1.1ip.

000010 00 01 26 F9 31 03 26 FO : FE 08 57 EC 31 27 0D ED .&.1.&...
w.1l'..

000020 31 18 0A 30 70 83 00 01 : 26 F7 20 EF 3D FC 08 4D 1..0p. .&.
.=..M

000030 26 03 FF 08 51 07 C9 15 : FB 00 04 20 FO &...Q. ...

-E: Unknown Macros as Empty Strings (Maker)

Group
INPUT

Syntax
-E
Arguments

None

Description

This macro discards errors for unknown macros referenced in the makefile. Maker
substitutes an unknown macro with an empty string.
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Example

maker -m test.mod -e

-Ed: Dump ELF Sections in LST File (Decoder)

Group
OUTPUT

Syntax
-Ed

Arguments

None

Default

None

File Format
Only ELF. Freescale object files are not affected by this option.

Description
This option generates a HEX dump of all ELF sections.

NOTE  The related option -E shows the information contained in ELF sections in a
more readable form.

-Env: Set Environment Variable

Group
HOST

Syntax

-Env <Environment Variable> = <Variable Setting>
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Arguments
<Environment Variable> :Environment variable to be set.

<Variable Setting> : Setting of the environment variable.

Description

This option sets an environment variable. The environment variable may be used in the
maker or to overwrite system environment variables.

Example
-EnvOBJPATH=\sources\obj
This is the same as:
OBJPATH=\sources\obj
indefault.env

To use an environment variable with file names that contain spaces, use the
following syntax:

-Env”OBJPATH=program files”

-F: Execute Command File

Group
INPUT

Syntax

“-F=" <fileName>.

Arguments

<fileName>: Batch Burner command file to be executed.

Default

None

Description

This option causes the Burner to execute a Batch Burner command file (usual extension is
.bbl).
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Example
-F=fibo.bbl

-F: Object File Format

Group
INPUT

Syntax
-F (A | E|] I |H]| S)

Arguments

None

Default

-FA

Description

The decoder is able to decode different object file formats. This option defines which
object file format should be decoded:

-FA : the decoder determines the object file format automatically.
-FE : this can be overridden and only ELF files are correctly decoded.
—-FH : only Freescale files are decoded.

-FS : only S-Record files can be decoded.

-FI: Intel Hex files can be decoded.

NOTE  This option defines the Object File Format, which also defines the format of
absolute files and libraries. It does not only affect object files. Many other
options only effect a specific object file format. See the corresponding option
for details.

NOTE To decode an S-Record or Intel Hex file, use the option